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Walk-Through Examples
The AFT Arrow Walk-Through Examples are designed to get new users trained to use AFT Arrow cor-
rectly in the shortest amount of time. If you are using AFT Arrow for the first time, start with the Beginner - 
Air Heating System example because it offers an in-depth explanation of how to use AFT Arrow. Other-
wise, choose an example from the table below that you wish to learn more about. For examples using the 
AFT Arrow Add-on Modules, see the AFT Arrow Modules Overview.

Completed versions of the example model files are included with the default installation: C:\AFT Product-
s\AFT Arrow 10\Examples

Example Complexity Fluid Pipes Compressors/Fans Description

Beginner - Air 
Heating Sys-

tem
Beginner Air 5 1

A new AFT Arrow 
user should start 
here. Get in-depth 
instructions of 
model building by 
solving an air heat-
ing system prob-
lem. Learn how to 
define a fluid in Ana-
lysis Setup, place 
pipes and junctions 
on the Workspace, 
define pipes and 
junctions, use the 
Model Data win-
dow, run a model, 
use the Output win-
dow, generate 
graphs in the Graph 
Results window, 
and view results in 
the Workspace 
using Workspace 
Layers.

Orifice CdA 
and Sonic 
Choking

Beginner Steam 2 -

Learn about the 
CdA value for sonic 
choking in the Ori-
fice Properties win-
dow. See how the 
effective flow area 
affects the flow 
rates and pressures 
in the system.

Control Valve Beginner Steam 2 - Learn how to define 
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Example Complexity Fluid Pipes Compressors/Fans Description

the Convective 
Heat Transfer 
model on the Heat 
Transfer tab of the 
Pipe Properties win-
dow. See how to 
use a control valve 
junction to determ-
ine pipe size. Learn 
how to use the Out-
put Control window 
to display relevant 
heat transfer output 
parameters.

Natural Gas 
Burner Beginner Methane 16 -

Learn how to use 
the Specified Heat 
Rate In Constant 
thermal model in a 
Heat Exchanger 
junction to obtain a 
desired outlet tem-
perature in a sys-
tem. See how to 
specify a resistance 
curve as the loss 
model in a Heat 
Exchanger junction.

Compressed 
Air System Beginner Air 9 1

Learn how to input 
a compressor curve 
into a Com-
pressor/Fan junc-
tion. See how to 
use the Scenario 
Manager to create 
different system 
configurations. 
Explore how to use 
the isometric pipe 
drawing mode in 
the Workspace win-
dow.

Process Steam 
System Intermediate Steam 17 -

Learn about the 
Solution Method 
panel in Analysis 
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Example Complexity Fluid Pipes Compressors/Fans Description

Setup to see how 
the Length March 
Increment impacts 
results.

Hydrocarbon 
Process Relief 

System
Intermediate Methane                             

Hydrogen                         4 -

Learn how to create 
a mixture using the 
NIST REFPROP 
fluid library. See 
how and where mul-
tiple choking points 
occur in the system. 
Learn about Sound 
Power Level and its 
significance.

Refinery Relief 
System Beginner

Methane                             
Ethane                             Pro-

pane                         
6 -

Learn how to use 
the NIST 
REFPROP fluid lib-
rary to specify mul-
tiple pure fluids in a 
single system 
where dynamic mix-
ing occurs. See 
how to use Global 
Junction Edit to 
make rapid 
changes to junc-
tions. 

Air Blower Siz-
ing Intermediate Air 13 1

Learn how blower 
efficiency affects 
pressure rise and 
discharge tem-
perature. See how 
using heat transfer 
further impacts the 
pressure and tem-
perature results.

Compressed 
Air System - 

Cost
Beginner Air 9 1

Learn the basics of 
cost calculations 
such as specifying 
material, install-
ation, and energy 
costs, connecting 
engineering and 
cost libraries, and 
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Example Complexity Fluid Pipes Compressors/Fans Description

interpreting the 
Cost Report in the 
Output window.

Process Steam 
System - Cost Intermediate Steam 17 -

Learn how to create 
cost libraries for 
pipe materials and 
junctions. See how 
to use Scale Tables 
to allow costs to 
scale as pipe dia-
meters change. 
Learn how to spe-
cify Material costs 
versus Installation 
costs.

Beginner - Air Heating System 

Summary

This example is designed to demonstrate the big picture of AFT Arrow’s layout and structure. Some of 
the more basic concepts will be used to build a simple air heating system driven by a compressor.

Topics Covered

 l Completing Analysis Setup
 l Drawing the system with Pipes and Junctions
 l Entering Pipe and Junction properties

Required Knowledge

This example assumes the user has not used AFT Arrow previously. It begins with the most basic ele-
ments of laying out the pipes and junctions and solving hydraulic methodology.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:
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 l Metric - Beginner - Air Heating System.aro

 Step 1. Start AFT Arrow

ØTo start AFT Arrow, click Start on the Windows taskbar, choose the AFT Arrow 10 folder from the all 
apps list, then click AFT Arrow 10 to launch the application. (This refers to the standard menu items cre-
ated by setup. You may have chosen to specify a different menu item during installation.)

After AFT Arrow opens, the Start-Up screen, as shown in Figure 1, appears and provides you with sev-
eral options before you start building a model. Some of the actions available are:

 l Open a recent model, browse to a model, or browse to an Example
 l Activate an Add-on Module
 l Select AFT Standard Air or a recently used fluid to be the Working Fluid
 l Review or modify Modeling Preferences

 l Select a Unit System
 l Filter units to include Common Only or Common Plus Selected Industries
 l Choose a Grid Style
 l Select a default Pipe Material

 l Access other Resources, such as Quick Start Guides, Help Files, and Video Tutorials

Note: If you are working through the Metric Units version of the Examples, be sure to specify either 
Metric Only or Both with Metric Defaults as the unit sets and check the box to Set as my Default.
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Figure 1: AFT Arrow Start-Up window

Click Start Building Model on the Start-Up window, the Workspace window is always the active (large) 
window, as seen in Figure 2.The  tabs in the AFT Arrow window represent the Primary Windows. Each 
Primary Window contains its own Toolbar that is displayed directly beneath the Primary Window tabs.

AFT Arrow supports dual monitor usage. You can click and drag any of the Primary Window tabs off of 
the main AFT Arrow window. Once you drag one of the Primary Windows off of the AFT Arrow window, 
you can move it anywhere you like on your screen, including onto a second monitor in a dual monitor con-
figuration. To add the Primary Window back to the main AFT Arrow primary tab window bar, simply click 
the X button in the upper right of the Primary Window.

To ensure that your results are the same as those presented in this documentation, this example should 
be ran using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

The Workspace Window

The Workspace window is the primary vehicle for building your model. This window has three main 
areas: the Toolbox, the Quick Access Panel, and the Workspace itself. The Toolbox is the bundle of tools 
on the far left. 

The Quick Access Panel is on the far right. It will be used later in this example to create Workspace Lay-
ers. It is possible to minimize the Quick Access Panel by clicking on the thumbtack pin in the upper right 
corner of the Quick Access Panel in order to allow for greater Workspace area.

The Workspace takes up the rest of the window. 

You will build your pipe flow model on the Workspace using the Toolbox tools. At the top of the Toolbox is 
the Pipe Drawing Tool and the Annotation tool. The Pipe Drawing tool, on the upper left corner of the 

Quick-Access-Panel.html
Workspace-Layers.html
Workspace-Layers.html
Annotations.html
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Toolbox, is used to draw new pipes on the Workspace. The Annotation tool allows you to create annota-
tions and auxiliary graphics.

Below the two drawing tools are twenty icons that represent the different types of junctions available in 
AFT Arrow. Junctions are components that connect pipes and also influence the pressure or flow beha-
vior of the pipe system. The twenty junction icons can be dragged from the Toolbox and dropped onto the 
Workspace.

When you hold your mouse pointer over any of the Toolbox tools, a tooltip identifies the tool's function.

Figure 2: The Workspace window is where the model is built

 Step 2. Complete the Analysis Setup

ØNext, click Analysis Setup on the Toolbar that runs across the top of the AFT Arrow window. This 
opens Analysis Setup (see Figure 3). Analysis Setup contains seven groups (additional groups will be dis-
played if the GSC, XTS, or ANS modules are active). Each group needs to be completed before AFT 
Arrow allows you to run the Solver.

Analysis Setup can also be accessed by clicking on the Status Light on the Quick Access Panel.  Once 
Analysis Setup is complete, the Model Status Light then turns from red to green.

Quick-Access-Panel.html
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Figure 3: The Analysis Setup tracks the model’s status and allows users to specify required parameters

A. Define the Modules Group

Although Analysis Setup initially opens to the Fluid panel of the Fluid Properties group, the first group, 
Modules, always has a green check when you start AFT Arrow because there are no modules activated 
by default. No further input is required here.

B. Define the Fluid Properties Group

Next is the Fluid Properties group. This group allows you to choose a fluid, select an Equation of State, 
and select an Enthalpy Model. Start by clicking on Fluid to open the Fluid panel (see Figure 4).

You can select a fluid from the standard AFT Arrow fluid library (AFT Standard), select custom user-
defined fluids from User Library Fluid, select ASME Steam Tables, or select multiple fluids and/or create 
mixtures using the Chempak library or NIST REFPROP library.  Custom fluids are created by opening the 
Library Manager from the AFT Arrow Library menu or by clicking the Edit Fluid List button at the bottom of 
the Fluid panel and clicking Add New Fluid...

ØSelect AFT Standard, select Air, then click Add to Model (see Figure 4). Leave the Equation of 
State model as Redlich-Kwong and the Enthalpy Model as Generalized.
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Figure 4: The Fluid panel lets you select gases for the model and create mixtures

C. Define the Pipes and Junctions Group

In order to fully define this group, there needs to be pipes and junctions on the Workspace. To lay out the 
recirculating model, you will place five junctions on the Workspace. Then you will connect the junctions 
with pipes.

I. Place the tank

ØTo start, drag a tank junction from the Toolbox and drop it on the Workspace. Figure 5 shows the 
Workspace with one tank.

Objects and ID numbers

Items placed on the Workspace are called objects. All objects are derived directly or indirectly from the 
Toolbox. AFT Arrow uses three types of objects: pipes, junctions and annotations. 

All pipe and junction objects on the Workspace have an associated ID number. For junctions, this num-
ber is, by default, placed directly above the junction and prefixed with the letter J. Pipe ID numbers are 
prefixed with the letter P. You can optionally choose to display either or both the ID number and the name 
of a pipe or junction.  You also can drag the ID number/name text to a different location to improve vis-
ibility.

The tank you have created on the Workspace will take on the default ID number of 1. You can change 
this to any desired number greater than zero and up to 99,999.
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Editing on the Workspace

Once on the Workspace, junction objects can be moved to new locations and edited with the features on 
the Edit menu. Duplicating, cutting, copying, and pasting are all supported.

Figure 5: Adding a tank junction to the model

II. Place the other junctions

If the new junction type you want to add already exists on the Workspace, you have the option of duplic-
ating that junction.  You do this by selecting the object on the Workspace and then either choosing Duplic-
ate from the Edit menu or pressing Control+D on the keyboard.

Drag a compressor/fan junction from the Toolbox and drop it somewhere to the right of the tank (see Fig-
ure 6).  Next drag a branch junction and locate it above the compressor, then drag a heat exchanger junc-
tion and locate it above the tank. Finally, drag another tank junction and place it above the first tank 
junction.

Note: The relative location of objects in AFT Arrow is not important. Distances and heights are defined 
through Pipe and Junction Property windows. The relative locations on the Workspace establish 
the connectivity of the objects, but have no bearing on the actual length or elevation rela-
tionships.

If the icons do not line up exactly, no problems will result.  However, your model may have a nicer appear-
ance if the icons line up.  You can align the icons by using the align features or snap to grid option selec-
ted from the Arrange menu. 

Your model should now appear similar to that shown in Figure 6.
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Figure 6: Adding additional junctions to the model

ØBefore continuing, save the work you have done so far. Choose Save As... from the File menu and 
enter the file name Air Heating System and AFT Arrow will append the *.aro extension to the file name.

III. Draw a pipe between J1 and J2

Now that you have five junctions, you need to connect them with pipes.

ØTo create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The pointer will change to a cross 
hair when you move it over the Workspace. Draw a pipe below the junctions, similar to that shown in Fig-
ure 7.

The pipe object on the Workspace has an ID number (P1) shown near the center of the pipe.
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Figure 7: Create a Pipe

ØTo place the pipe between J1 and J2, use the mouse to grab the pipe in the center, drag it so that its 
left endpoint falls within the J1 Tank junction, then drop it there (see Figure 8).  Next, grab the right end-
point of the pipe and stretch the pipe, dragging it until the endpoint terminates within the J2 Com-
pressor/Fan junction (see Figure 9).

Figure 8: Connecting pipe P1 to the tank J1
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Reference positive flow direction 

On each pipe is an arrow that indicates the reference positive flow direction for the pipe. AFT Arrow 
assigns a flow direction corresponding to the direction in which the pipe is drawn.

You can reverse the reference positive flow direction by choosing Reverse Direction from the Arrange 
menu or selecting the Reverse Pipe Direction button on the Workspace Toolbar.

The reference positive flow direction is used for reference purposes only and need not be the actual flow 
direction.

If the reference positive direction is the opposite of that obtained by the Solver, the output will show the 
flow rate as a negative number. 

Figure 9: Connecting pipe P1 between two junctions

IV. Draw the remaining pipes

A faster way to add a pipe is to draw it directly between the desired junctions.

ØActivate the pipe drawing tool again, position the mouse pointer on the J2 compressor/fan, then 
press and hold the left mouse button. Stretch the pipe up to the J3 Branch then release the mouse but-
ton. Now draw a third pipe from the J3 Branch to the J4 Heat Exchanger, draw a fourth pipe from the J4 
Heat Exchanger to the J5 Tank, and draw a fifth pipe from the J3 Branch to the J5 Tank. Your model 
should now look similar to Figure 10.

Tip: Double-click the Pipe Drawing Tool in order to draw multiple pipes at a time, then deactivate the 
Pipe Drawing Tool either by pressing the Esc key or single-clicking the Pipe Drawing Tool 
again.
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Figure 10: Workspace view after drawing remaining pipes

At this point all the objects in the model are graphically connected.  Save the model by selecting Save in 
the File menu or by clicking on the diskette button on the Toolbar.

Note: Some users find it desirable to lock objects to the Workspace once they have been placed. This 
prevents accidental movement and disruption of the connections. You can lock all the objects 
by choosing Select All from the Edit menu, then selecting Lock Object from the Arrange menu. 
The lock button on the Workspace Toolbar will appear depressed indicating it is in an enabled 
state, and will remain so as long as any selected object is locked. Alternatively, you can use the 
grid feature enabled in the User Options window from the Tools menu and specify that the pipes 
and junctions snap to grid.

V. Define the pipes and junctions

To fully define the Pipes and Junctions group in Analysis Setup, all pipes and junctions must be con-
nected and have the proper input data.

Object status

Every pipe and junction has an object status.  The object status tells you whether the object is defined 
according to AFT Arrow's requirements.  To see the status of the objects in your model, click the flood 
light (Show Object Status) icon on the far right of the Workspace Toolbar (alternatively, you could choose 
Show Object Status from the View menu).  Each time you click the light, Show Object Status is toggled 
on or off.

When Show Object Status is on, the ID numbers for all undefined pipes and junctions are displayed in 
red on the Workspace.  Objects that are completely defined have their ID numbers displayed in black.  
(These colors are configurable through the User Options window from the Tools menu.)
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Because you have not yet defined the pipes and junctions in this example, all the objects' ID numbers will 
change to red when you turn on Show Object Status.

Undefined Objects window

The Undefined Objects window lists all undefined pipes and junctions and further displays the items that 
are not yet defined.

VI. Define Tank J1

To define the first tank, open the J1 Tank Properties window by double-clicking on the J1 icon. The 
table on the Loss Coefficients should show you that Pipe 1 is connected to this tank. 

Note: You can also open an object's Properties window by selecting the object (clicking on it) and then 
either pressing the Enter key or clicking the Open Pipe/Jct Window icon on the Workspace Tool-
bar.

ØEnter the Pressure as 0 barG (0 kPa (g)). You can assign any unit of pressure found in the adjacent 
drop-down list box of units.  Enter the Temperature as 40 deg. C and the Elevation as 0 meters.

Note: You can choose default units for many parameters (such as meters for length) in the User 
Options window.

You can give the component a name, if desired, by entering it in the Name field at the top of the window.  
By default, the junction’s name indicates the junction type.  The name can be displayed on the Work-
space or in the Output.

Most junction types can be entered into a custom library allowing the junction to be used multiple times or 
shared between users.  To select a junction from the custom library, choose the desired junction from the 
Library Jct list.  The current junction will get the input properties from the library.

The Copy Data From Junction… list will show all the junctions of the same type in the model.  This will 
copy selected parameters from an existing junction in the model to the current junction.

Using the tabs in the Properties windows

The information in the Properties windows is grouped into several categories and are placed on separate 
tabs. Click a tab to bring its information forward.  Figure 11 is an example of a Properties window with the 
Tank Model tab selected.

Click the Loss Coefficients tab to show the pipe table.  The pipe table allows you to specify entrance and 
exit loss factors for each pipe connected to the tank (in this case there is only one).  The default selection 
is the loss factors specified as zero.  To later change the loss factors, click within the pipe table and enter 
the loss.

The Optional tab allows you to enter different types of optional data.  You can select a junction icon from 
the included options or import your own to customize how a junction is displayed on the Workspace.  
Some junction types also allow you to specify an initial pressure and temperature, design factors, and 
other junction-specific data.
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Each junction has a  tab for notes, allowing you to enter text describing the junction or documenting any 
assumptions.

The Highlight feature displays all the required information in the Properties window in blue.  The highlight 
is on by default.  You can toggle the highlight off and on by pressing the F2 key. The highlight feature can 
also be turned on or off by selecting it on the User Options window.  For the remainder of the examples, 
we will keep the highlight feature turned off.

ØClick OK.  If Show Object Status is turned on, you should see the J1 ID number turn black again, telling 
you that J1 is now completely defined.

Figure 11: Properties window for Tank J1 

The Inspection Feature

You can check the input parameters for J1 quickly, in read-only fashion, by using the Inspection feature. 
Position the mouse pointer on the J1 tank icon and hold down the right mouse button. An information box 
appears, as shown in Figure 12.

Inspecting is a faster way of examining the input in an object rather than opening the Properties window.
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Figure 12: Inspecting from the Workspace with right mouse button

VII. Define The Other Junctions

ØNext, open the properties window for Compressor/Fan J2 (see Figure 13). Several compressor/fan 
models are provided. You can enter a compressor curve, a compressor map, or set up the compressor in 
sizing mode with a fixed parameter such as a fixed mass flow rate or volumetric flow rate. A fixed flow 
rate will force the specified flow through the system and the resulting pressure rise will be calculated. A 
fixed pressure or head rise will apply the specified pressure or head at the compressor/fan and the res-
ulting flow rate will then be calculated. A compressor/fan curve or a compressor map will model the 
actual performance of the compressor/fan. The pressure rise from a compressor/fan curve can be selec-
ted as either static or stagnation. The compression process models how the heat of compression affects 
the gas temperature, which is important in compressor applications.

For this example, use Centrifugal Compressor and select  Compressor Curve as the Compressor Model. 
Click Enter Curve Data and enter the following data into the Compressor Configuration window:

Mass Pressure

kg/sec bar

0 0.6

0.45 0.7

0.90 0.5

Click Generate Curve Fit Now and then click OK. Make sure the Added Pressure selection is set to 
Stagnation.  
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Set the Compression Process to Polytropic with a constant of 1.5. Last, enter an elevation of 0 meters.  
Then click OK and the compressor/fan should be completely defined. Figure 13 shows the Com-
pressor/Fan Properties window.

Figure 13: Properties window for Compressor/Fan J2

ØOpen the Branch J3 properties window (see Figure 14). In this window, three connecting pipes 
should be displayed in the pipe table area. You can associate loss factors with each pipe by clicking 
within the pipe table and entering the data. These will be set to zero for this example.

ØEnter an elevation of 0 meters for the Branch J3 (an elevation must be defined for all junctions). You 
could also click the Optional tab and then specify a flow source or sink at the junction. For this example, 
we will not use the Flow Source or Sink option in the Optional tab. Click OK and the branch is now 
defined.



Walk-Through Examples

- 22 -

Figure 14: Properties window for Branch J3

ØOpen the Heat Exchanger J4 Properties window. The thermal behavior of the heat exchanger is 
specified under the Thermal Data tab.

If you know the heat load for the exchanger, you can choose the Specified Heat Rate In thermal model 
and enter the heat rate directly. Adding heat to the system fluid is positive (i.e., heat flows out of the junc-
tion) while cooling is negative (heat flows into the junction).

You also have the option of choosing among a number of common heat exchanger configurations such 
as parallel and counter-flow. When you choose one of the other models, you must enter the secondary 
fluid conditions, heat exchanger area and heat transfer coefficient data. The secondary fluid can be 
either liquid or gas, although the models used to calculate heat transfer will be more accurate for liquids.

Whichever model is selected, the heat is added to or removed from the heat exchanger in accordance 
with the input model.  The pressure drop through the heat exchanger is based on the Loss Model that is 
selected.

For this example, choose the Counter-Flow heat exchanger model with the following characteristics.

 l Heat Transfer Area = 1 meter2
 l Overall Heat Transfer Coefficient = 57 W/m2-K
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 l Secondary Fluid Flow Rate = 0.25 kg/sec
 l Secondary Fluid Specific Heat = 4 kJ/kg-K
 l Secondary Fluid Inlet Temperature = 50 deg C

The Thermal Data tab should now look like see Figure 15.

ØGo to the Loss Model tab and specify the K factor at a value of 2. Enter an elevation of 0 meters, 
then click OK and the heat exchanger should be completely defined.

Figure 15: Properties window for Heat Exchanger J4

ØOpen Tank J5 and enter a Pressure of 0.5 barG (50 kPa(g)), a Temperature of 40 deg. C and an Elev-
ation of 0 meters.

ØSave the model again before proceeding.

VIII. Define Pipe P1

The next step is to define all the pipes. To open the Pipe Properties window, double-click the pipe object 
on the Workspace.

ØFirst open the Pipe Properties window for Pipe P1 (see Figure 16). For Pipe P1 choose Steel - 
ANSI from the Pipe Material drop down menu, 4 inch for Size, STD (schedule 40) for the Type, and a 
length of 3 meters. 

ØOn the Heat Transfer tab, select the Convective Heat Transfer model and for the Ambient Condi-
tions, set the Temperature to 5 deg. C, the Fluid Velocity to 25 km/hr, and the Fluid to Air (see Figure 17). 
Click OK. Pipe P1 is now defined.
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Figure 16: Properties window for Pipe P1

Figure 17: Heat transfer data for Pipe P1

The Pipe Properties window

The Pipe Properties window offers control over all important flow and heat transfer parameters that are 
related to pipes.
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The Inspection feature also works within the Pipe Properties window.  To Inspect a connected junction, 
position the mouse pointer on the connected junction's ID number and hold down the right mouse button. 

 

This is helpful when you want to quickly check the properties of connecting objects.  You can also use 
this feature in the junction properties windows for checking connected pipe properties.

By double-clicking the connected junction number, you can jump directly to the junction's properties 
window.  Or you can click Jump to jump to any other part of your model.

IX. Define Other Pipes

ØOpen the Pipe Properties window for pipe P2 and choose pipe P1 from the Copy Data From Pipe 
drop-down menu (alternatively you can click the Copy Previous button). Choose all the properties and 
click OK. This will copy all pipe P1 input data to pipe P2. Then change the length of pipe P2 to 9 meters.

Open the other three Pipe Property windows and similarly copy all input data from pipe P1. Set the length 
of pipe P4 to 1.5 meters. Note that pipes P1, P3, and P5 will all have the same exact input  data.

After completing the last pipe, all groups in Analysis Setup should be complete.

X. Check Pipes And Junctions

ØCheck if all the pipes and junctions are defined. If not, turn on the Show Object Status from the 
View menu and open each undefined pipe and junction. The Status tab will indicate what information is 
missing.

XI. Check Model Data             

ØBefore running the model, save it to file one more time.  It is also a good idea to review the input 
using the Model Data window.

Reviewing input in the Model Data window

The Model Data window is shown in Figure 18. To change to this window, you can select it from the 
Primary Window tabs or the Window menu, or by pressing CTRL+M. The Model Data window provides a 
tabular format for your model's input property data. Data in the Model Data window can be selected and 
then copied and pasted into other Windows programs, saved to a formatted file, printed to an Adobe 
PDF, or printed out for review.

Data is displayed in three general areas. The top area is called the General Section, the middle area is 
the Pipe Section, and the bottom area is the Junction Section. 

The Model Data window allows access to all Properties windows by double-clicking the appropriate ID 
number in the far left column of the table. You may want to try this right now.
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Figure 18: The Model Data window shows all input in text form

D. Define the remaining groups in Analysis Setup

Open Analysis Setup once more to confirm that all groups are defined. No inputs or alterations are 
required to complete the remaining groups: Steady Solution Control, Environmental Properties, Cost Set-
tings, and Miscellaneous. All seven groups should have a green checkmark next to its name. Click OK.

 Step 3. Run The Solver

ØChoose Run Model from the Toolbar or Analysis menu. During execution, the Solution Progress win-
dow displays (see Figure 19). You can use this window to pause or cancel the Solver's activity. When the 
solution is complete, the Output, Workspace, and Graphs Results windows can be accessed directly 
from the Solution Progress window. Click the Output button and the text-based Output window will 
appear (see Figure 20). The information in the Output window can be reviewed visually, saved to file, 
exported to a spreadsheet-ready format, copied to the clipboard, printed to an Adobe PDF file, and prin-
ted out on the printer.



Walk-Through Examples

- 27 -

Figure 19: The Solution Progress window displays the convergence progress
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Figure 20: The Output window displays output in text form

 Step 4. Examine the Output

The Output window is similar in structure to the Model Data window. Three areas are shown, and you can 
minimize or enlarge each area by clicking the arrow next to the General, Pipes, and Junctions tabs.

A. Specify Output Control

By default, AFT Arrow has a predefined set of Output Control parameters that are specified and the 
default units used depend on which unit set was selected when first running AFT Arrow (see Figure 1).  A 
default title is also assigned in the Output Control. 

ØOpen Output Control from the from the Common Toolbar or Tools menu. (Figure 21 shows the Out-
put Control window). Click the General tab, enter a new title (if you like you can title this Air Heating Sys-
tem), then click OK to accept the title and other default data.

In addition, this window allows you to select the specific output parameters you want in your output from 
the Display Parameters tab.  You also can choose the units for the output. 
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Figure 21: The Display Parameters tab allows you to customize which output data is displayed in AFT Arrow

B. Modify The Output Format

If you selected the default AFT Arrow Output Control, the Pipe Results table will show mass flow rate in 
the second column with units of kg/sec. 

ØSelect Output Control from the Tools menu. On the right side of the Display Parameters tab for 
Pipes is the list of selected output parameters that will be displayed in the Output window. The left side 
shows all available parameters, including those that are not in the current output report but can be added 
at your option. You can view the list on the left either alphabetically or by categories by clicking the appro-
priate tab. On the list on the right, click Mass Flow Rate and change the units by selecting kg/hr from the 
drop-down menu.

ØClick OK to display changes to the current results. You should see the mass flow rate results, still 
in the second column, in units of kg/hr. Notice the Velocity Inlet (Vel. In) results in the third column.

ØSelect Output Control from the Tools menu one more time. Select the Pipes in the Display Para-
meters tab. The parameters can be reordered by clicking the Reorder arrows on the right of the list, or by 
dragging the Reorder parameter icon on the left of the Output parameter you would like to reorder.

ØSelect the Velocity Inlet parameter and move it up to the top of the parameter list.

ØClick OK to display the changes to the current results. You will see in the Pipe results table that 
the first column now contains Vel. In (Velocity Inlet), the second column now contains the pipe name, and 
the third column the mass flow rate.  The Output Control window allows you to obtain the parameters, 
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units, and order you prefer in your output. This flexibility will help you work with AFT Arrow in the way that 
is most meaningful to you, reducing the possibility of errors.

ØLastly, double-click the column header for Vel. In in the Output window Pipe Results Table. 
This will open a window in which you can change the units once again if you prefer. These changes are 
extended to the Output Control parameter data you have previously set.

C. View The Results Using Workspace Layers

ØChange to the Workspace window by clicking the Workspace tab or by choosing it from the Window 
menu.  Workspace Layers allow you to integrate your text results with the graphic layout of your pipe net-
work from within the Workspace itself.

ØClick the Workspace Layers tab in the bottom right of the Quick Access Panel to view the Work-
space Layers interface. Pipe and junction parameters can be added to new layers and applied to the 
labels of specified pipes or junctions as desired, or they can be added to the All Objects Layers. The All 
Objects Layer is a special default layer that displays all pipes, junctions, and annotations, and therefore 
any pipe and junction parameters added to this layer will be applied to all applicable pipes and junctions. 

Note: It is typically preferable to create a new layer when adding a parameter to labels on the Work-
space, but for the sake of simplicity, this example adds the parameters to the All Objects Layer.

Select the All Objects Layer and open its Layer Settings menu by clicking the gear icon in the Layers Tool-
bar (or to the right of the All Objects Layer's visibility icon) or by double clicking on the layer title.

Navigate to the Pipe Parameters panel within the Label Control group. Both input and output parameters 
are listed, though output parameters will only be displayed on the Workspace when output exists to do 
so. When no output exists, the output pipe label parameters in the right hand list will be gray. You can 
hover over each parameter to see a description of the parameter and whether it is an input or output para-
meter. Three categories of parameters will be listed to the left - Commonly Used Pipe Parameters, Pipe 
Parameters, and Pipe Heat Transfer Parameters. Expand the Pipe Parameters category and find the 
item Velocity Outlet. You can also use the parameter filter to search for desired parameters.

Note: Some parameter categories are contextual and may only appear in certain circumstances 
(when there is heat transfer in a model, when certain modules are active, when certain junctions 
are present, etc.).

 ØAdd Velocity Outlet to the pipe label parameters by double clicking on it or single clicking it within 
the left hand list and pressing the arrow button in between the left-hand and right-hand lists to add it to 
the right-hand list, as shown in Figure 22. Leave the units as the default unit of meters/sec.

Workspace-Layers.html#Layer-Settings-Label-Control
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Figure 22: The Pipe Parameters panel in Layer Settings determines the parameters, their order, and their 
units for display in pipe labels on the Workspace

ØAdd Pressure Static Inlet to the junction label parameters in the same manner as before. It will be 
found in the Junction Parameters panel within the category Junction Parameters, as shown in Figure 23. 
Unlike the Tank Summary Parameters or Compressor/Fan Summary Parameters, which are specific to 
certain junction types, the Junction Parameters category is more general and will apply to labels for all 
types of junctions. The pressure unit may be left to its default value, bar.
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Figure 23: The Junction Parameters panel in Layer Settings determines the junction parameters, their order, 
and their units for display in junction labels on the Workspace

It is common for the text in the labels to overlap when first generated. You can change this by selecting 
smaller fonts in Global Layer Settings, where you can also show units in a legend to reduce clutter, or by 
dragging the text to a new area to increase clarity. In Figure 24, units have been moved to the legend and 
labels rearranged for better readability. The Workspace window and currently visible layers can be prin-
ted or copied to the clipboard for import into other Windows graphics programs, saved to a file, or printed 
to an Adobe PDF file.

Figure 24: Workspace Layers integrate results with model Layout directly from the Workspace window

Workspace-Layers.html#Global-Layer-Settings
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D. Graph The Results

ØChange to the Graph Results window by clicking the Graph Results tab, choosing it from the Win-
dows menu, or by pressing CTRL+G. The Graph Results window offers full-featured Windows plot pre-
paration.

The Graph Parameters section will automatically be displayed in the Graph Control tab on the Quick 
Access Panel on the far right of the Graph Results window. The Graph Parameters section on the Graph 
Control tab is where you can specify which graphs you would like to generate. Multiple types of graphs 
can be generated such as Profiles, Compressor/Fan vs. System Curves, System Curves, or Multi-Scen-
ario Graphs. 

Select the Profile Graph tab in the Graph Parameters area in the Graph Control on the Quick Access 
Panel. Plot Single Path selected by default, select pipes P1 through P4 from the Pipes list.  Choose Pres-
sure Static, if not already selected, from the Parameter drop-down menu. Make sure meters as the 
Length Units and bar as the Pressure Static Units. Then click Generate. The Show Junction Locations 
feature is located on the Graph Results Toolbar and can be enabled or disabled by clicking the icon (see 
Figure 25).

A graph appears showing the static pressure along the flow-path defined by pipes P1 through P4 in Fig-
ure 26.

You can use the other buttons in the Graph Results window to change the graph appearance and to save 
and export data for cross-plotting. The Graph Results window can be printed, saved to file, copied to the 
clipboard, or printed to an Adobe PDF file.  The graph’s x-y data can be exported to file or copied to the 
clipboard.

Figure 25: The Graph Parameters section of the Graph Control tab on the Quick Access Panel controls the 
Graph Results content
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Figure 26: The Graph Results window offers full-featured plot generation

You have now used all of AFT Arrow's Primary Windows to build and analyze a simple model. Review 
the rest of the Arrow Help File contents for more detailed information on each of the windows and func-
tions. 
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Orifice CdA and Sonic Choking 

Summary

This example demonstrates a sample calculation to determine the maximum flow through a system 
where sonic choking occurs, as well as the sonic pressure and area, and it explores the effect of CdA on 
the system flow rate. 

Topics Covered

 l Determining the maximum flow through a system
 l Determining sonic (stagnation) pressure
 l Determining sonic area 
 l Using scenarios

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Orifice CdA and Sonic Choking.aro

Problem Statement

For this problem, steam flows from one tank to another, through an orifice.

The first pipe from the inlet tank to the orifice is 3 meters long, and the second pipe leading from the ori-
fice to the discharge tank is 6 meters long. Both pipes are 2 inch, STD (schedule 40) pipes, and are well 
insulated (adiabatic).

The inlet tank has a pressure of 16 barG (1600 kPa (g)) and a temperature of 260 deg. C. The discharge 
tank has a pressure of 0 barG (0 kPa (g)). Set the discharge temperature to 260 deg. C. The discharge 
temperature is not important in this case because no fluid is entering the system at the discharge, so the 
fluid temperature cannot impact the system temperature. Both tanks are at 0 meters elevation.

The orifice at the end of the first pipe has an area of 20 cm2, and a K Factor of 10.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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Determine the following:

 1. What is the maximum flow through the system?
 2. What is the sonic (stagnation) pressure at the system exit?
 3. At the maximum flow, what is the sonic area at the orifice? At the discharge tank?

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Navigate to the Fluid panel in Analysis Setup
 2. Define the Fluid panel with the following inputs

 a. Fluid Library = AFT Standard
 b. Fluid = Steam

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Workspace window showing the model layout for Flow Through an Orifice example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 2 inch
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = 

Pipe Length (meters)

1 3

2 6

Junction Properties

 1. J1 Tank 
 a. Name = Inlet Tank
 b. Elevation = 0 meters
 c. Fluid = Steam
 d. Pressure = 16 barG (1600 kPa(g))
 e. Temperature = 260 deg. C
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 2. J2 Orifice
 a. Elevation = 0 meters
 b. Orifice Type = User Specified
 c. Subsonic Loss Model = K Factor
 d. Orifice Dimensions = Area
 e. Area = 20 cm2
 f. K = 10

 3. J3 Tank
 a. Name = Discharge Tank
 b. Elevation = 0 meters
 c. Fluid = Steam
 d. Pressure = 0 barG (0 kPa(g))
 e. Temperature = 260 deg. C

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 5. Specify the Output Control

Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.

The Output window (Figure 2) contains all the data that is specified in the Output Control window. The 
window starts with a default set of outputs, which is normally sufficient. You can also specify the units for 
each output parameter from this window. For this example, change the Pressure Stagnation Inlet units to 
barG (after making the change, click Same Units below the Output list, then click OK to change all pres-
sure units to barG. Next, click the Junctions button at the top and change the Sonic Flow Area units to 
cm2. 

 Step 6. Examine the Output 

Because this system chokes at the discharge tank, the Sonic Choking tab appears in the General section 
of the Output window. This tab will appear when sonic choking occurs in the system, and will contain mes-
sages pertaining to the sonic choking conditions.  

Because the flow is choked at the exit, the mass flow rate shown in the Output reflects the maximum flow 
rate through the system for the given conditions. The maximum flow rate through this system is 1.966 
kg/sec. The stagnation pressure at the exit is 5.617 barG (561.7 kPa(g)). The output in the junction data 
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portion of the Output window shows the Sonic Area at the orifice is 8.890 cm2, and the Sonic Area at the 
discharge tank is 21.647 cm2.

Figure 2: Output window showing results for Flow Through an Orifice Example

 Step 7. System Modification

Set the Sonic CdA in the Orifice Properties window to 20% higher than the sonic area and then 20% 
lower than the sonic area, and rerun the model for each scenario. How do the results change for each 
case? 

Note: This is a situation where a user can create two new scenarios using the Scenario Manager to 
examine several what-if situations, without disturbing the basic model.

 Step 8. Re-evaluate the Model

Setting the orifice CdA higher than the sonic area has no affect on the model because the system is 
already choking at the exit. Setting the CdA 20% lower than the sonic area (7.112 cm2) causes the flow 
rate to decrease to 1.594 kg/sec, and the exit discharge stagnation pressure to decrease to 4.360 barG 
(436.0 kPa(g)).  Also, lowering the CdA has caused the system to choke in two places rather than just 
one.  This can be seen on the Sonic Choking tab in the General section of the Output window.
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Control Valve 

Summary

This example will walk you through a simple calculation to calculate a pipe size for a system with a con-
trol valve. 

Topics Covered

 l Using flow control valves
 l Entering and changing pipe size data
 l Adding items to the output using Output Control
 l Modifying output using Output Control

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Control Valve.aro

Problem Statement

For this problem, steam flows from one tank to another. The pipe between the tanks is horizontal, and 
140 meters long. A control valve is used to control the flow. The control valve must have a pressure drop 
of at least 1.5 bar (150 kPa) to operate correctly. Assume the control valve is in the middle of the pipe. 
The ambient temperature is 15 deg. C. The pipe has an ambient air velocity of 25 km/hr, and no insu-
lation. The inlet stagnation pressure and temperature values are 16 barG (1600 kPa(g)) and 220 deg. C, 
and the outlet stagnation pressure and temperature values are 9 barG (900 kPa(g)) and 220 deg. C. 
Note that the discharge temperature does not have an impact on calculations unless the discharge 
boundary happens to be supplying flow. Therefore, an assumed temperature can be used.

The pipe must be sized correctly to allow 2 kg/sec to flow from one reservoir to the other. Consider only 
STD (schedule 40) pipes.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Navigate to the Fluid panel in Analysis Setup
 2. Define the Fluid panel with the following inputs

 a. Fluid Library = AFT Standard
 b. Fluid = Steam

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 1: Workspace window showing the model layout for Control Valve example
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The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties.

For this example, you need to find the correct pipe size but you are limited to STD (schedule 40) pipe 
sizes. You need to use your engineering judgment to take an initial guess at the pipe size for 2 
kg/sec. Try 2-½ inch pipe. Specify the pipes as follows:

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 2-1/2 inch
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length = 70 meters

 2. Heat Transfer tab
 a. Heat Transfer Model = Convective Heat Transfer
 b. Temperature = 15 deg. C
 c. Fluid Velocity = 25 km/hr
 d. Fluid = Air

Figure 2: Pipe Heat Transfer Properties window

Junction Properties
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 1. J1 Tank
 a. Elevation = 0 meters
 b. Fluid = Steam
 c. Pressure = 16 barG (1600 kPa(g)) 
 d. Temperature = 220 deg. C

 2. J2 Control Valve
 a. Elevation = 0 meters
 b. Valve Type = Flow Control (FCV)
 c. Control Setpoint = Mass Flow Rate
 d. Flow Setpoint =  2 kg/sec
 e. Always Control (Never Fail) = Unchecked

 3. J3 Tank
 a. Elevation = 0 meters
 b. Fluid = Steam
 c. Pressure = 9 barG (900 kPa(g))
 d. Temperature = 220 deg. C

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 5. Specify the Output Control

Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.

In this example, you want to review the effects of changing the pipe nominal size. To simplify this, add 
this parameter to the output. 

 1. Click the Pipes button in the Display Parameters tab.
 2. In the list on the left, find the parameter Nominal Size.
 3. Select the Nominal Size parameter and then click the Add button, which adds the parameter to the 

list of displayed parameters on the right.
 4. Use the Reorder buttons (in the upper right) to move the Nominal Size up so that it becomes the 

second parameter in the list (see Figure 3).
 5. Click OK.
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Figure 3: Output Control window 

 Step 6. Examine the Output

The Output window contains all the data that was specified in the Output Control window. The output is 
shown in Figure 4. In the General section of the Output window, there is a Warnings tab. Select this tab 
and you can see that for this case, the flow control valve was not able to achieve the required flow rate of 
2 kg/sec. Even when there is no pressure loss across the control valve, the flow rate is below the set-
point, so the valve is unable to maintain control for this size of pipe.

In addition warnings are shown that the fluid is above the saturation pressure line. AFT Arrow cannot cal-
culate the actual behavior of the gas when the saturation line is reached. Instead Arrow will extrapolate 
the fluid properties assuming that the fluid would remain in the gas phase, and will warn the user that the 
saturation line was exceeded as is seen here.
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Figure 4: Output for Control Valve Example

 Step 7. Size Piping Insulation

It is necessary to evaluate a new pipe size and to address the condensation warnings. Let's first address 
the condensation warnings, the pipe size will be addressed in the next step. We will assume that the 
necessary insulation thickness will not vary largely with pipe size because the expected change in pipe 
size should be relatively small in the next step.

One way to keep the fluid temperature above saturation and prevent condensation, would be to add insu-
lation to the pipe. Assume there are three sizes of insulation available, 1.0 cm, 1.5 cm, and 2.0 cm thick, 
each of which has a thermal conductivity of 0.2 W/m-K. Assuming the same insulation for both pipes, 
which insulation size would be necessary to prevent condensation in the line?

Because this 2-1/2 inch model may be useful for comparison, keep this scenario by returning to the Work-
space and then creating a new scenario on the Scenario Manager as a Child scenario by right-clicking on 
the Base Scenario and selecting Create Child. Name the child scenario 2.5 inch Pipe.

Repeat this process to create another new scenario as a child to the 2.5 inch Pipe scenario called With 
Insulation. Insulation is added on the Pipe Properties window's Heat Transfer tab. AFT Arrow allows you 
to specify up to three layers of insulation. The insulation can be specified as internal insulation, external 
insulation, or a combination of the two. 

Add the insulation to the pipe by changing the Number of Insulation Layers to 1 External, and then add 
the insulation thermal data to the table (see Figure 5). For Conductivity, enter 0.2 W/m-K and for thick-
ness, enter 1.5 cm as an initial guess. Make these changes to both pipes. Running the scenario, the insu-
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lation proves sufficient to prevent condensation in the 2.5 inch pipes, but the pipes remain too restrictive 
for the control valve to achieve the desired flow rate.

Figure 5: Insulation data is added on the Heat Transfer tab of the Pipe Properties window

 Step 8. Change Pipe Size

Create a child scenario of the With Insulation scenario and name it 3 inch Pipe. From this scenario, select 
a new pipe size in the Pipe Properties window for both pipes. By trial and error, you can determine that by 
using 3-inch pipe, the minimum 1.5 bar (150 kPa) pressure drop requirement can be satisfied (see Valve 
Summary tab in Figure 6). Do the results change if the valve is not in the middle of the pipe?

Figure 6: Output results for 3 inch Nominal Pipe Size modified Control Valve Example

Conclusion

To meet the system requirements, 3-inch pipe should be used. If the valve were not in the middle of the 
pipe, the results would change because there is less pressure drop available as the valve is moved 



Control Valve

- 47 -

towards the pipe inlet. To prevent condensation in the line, the 1.5 cm thick insulation would have to be 
used.
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Natural Gas Burner 

Summary

This example will walk you through an example to size a heat exchanger to deliver natural gas at a min-
imum required temperature.

Topics Covered

 l Sizing a Heat Exchanger
 l Entering a loss curve for a Heat Exchanger
 l Specifying heat transfer data for pipes

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Natural Gas Burner.aro

Problem Statement

An underground storage reservoir containing natural gas made up mostly of methane supplies gas to five 
burners. The gas is at 34.5 barG (3459 kPa (g)), and 10 deg. C. The gas is supplied to each of the burn-
ers at 6.9 barG (690 kPa (g)). To ensure that the flow rate to each of the burners is equal, each burner 
has a control valve that controls the flow to 2.25 kg/sec. The pipes in the system are uninsulated STD 
(schedule 40) steel, with standard roughness. The ambient temperature surrounding the pipes is 24 deg. 
C, and the pipes have an ambient air velocity of 25 km/hr.

In order to operate at the best efficiency, the gas should be delivered to the burners at a minimum stag-
nation temperature of 38 deg. C. In order to achieve this, the gas flows through a heat exchanger, which 
has a 0.7 bar (70 kPa) pressure drop at 11 kg/sec. 

How much heat must be added to the heat exchanger to ensure that all of the burners will receive gas at 
the specified minimum temperature?  (Neglect elevation changes)

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Methane

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Model layout for Natural Gas Burner example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

Pipe Size Length (meters)

1 4 inch 30

2-6 4 inch 6

7-16 3 inch 1.5

 2. Heat Transfer tab
 a. Heat Transfer Model = Convective Heat Transfer
 b. Temperature = 24 deg. C
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 c. Fluid Velocity = 25 km/hr
 d. Fluid = Air

Figure 2: Pipe Heat Transfer Data window

Junction Properties

 1. All Control Valves 
 a. Elevation = 0 meters
 b. Valve Type = Flow Control (FCV)
 c. Control Setpoint = Mass Flow Rate
 d. Flow Set Point = 2.25 kg/sec

 2. J1 Tank
 a. Elevation = 0 meters
 b. Fluid = Methane
 c. Pressure = 34.5 barG (3450 kPa(g))
 d. Temperature = 10 deg. C

 3. J13-J17 Tanks
 a. Elevation = 0 meters
 b. Fluid = Methane
 c. Pressure = 6.9 barG (690 kPa(g))
 d. Temperature = 260 deg. C

 4. J3-J7 Branches
 a. Elevation = 0 meters

 5. J2 Heat Exchanger
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 a. Elevation = 0 meters
 b. Loss Model = Resistance Curve
 c. Enter Curve Data = 

Mass Pressure

kg/sec bar

0 0

11 0.7

22 2.8

 d. Curve Fit Order = 2
 e. Click Generate Curve Fit Now

To solve this problem, you will have to guess how much heat to add to the heat exchanger, examine the 
results, and adjust the heat added until you achieve the desired minimum temperature at the burners. To 
do this, select the Heat Transfer tab on the Heat Exchanger Properties window, and for the Thermal 
Model, select Specified Heat Rate In Constant. Next, enter a value for Heat Flow Into System. For the 
first guess, use 500 kW.

Figure 3: Heat Exchanger Loss Curve Fit
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ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 5. Examine the Output

Examination of the stagnation temperature at the outlets of the pipes discharging to the burners shows 
that the lowest temperature is 16.9 deg. C (see Figure 4). This is well below the required minimum tem-
perature of 38 deg. C. The heat added to the system fluid from the heat exchanger must be increased, 
and the model ran again to determine the outlet temperature at the value.

Figure 4: Output window showing results for Natural Gas Burner Example, based on HX Heat Rate of 500 kW

By trial and error, the correct amount of heat that needs to be added to the system fluid from the heat 
exchanger to achieve a minimum stagnation temperature of 38 deg. C at each burner is about 1052 kW.

Conclusion

Using AFT Arrow, you were able to determine the amount of heat required by the heat exchange to sup-
ply natural gas to the burners at the minimum required temperature.

The goal seeking capabilities in the AFT Arrow GSC Module would allow this problem to be solved dir-
ectly without manual iteration. The variable would be specified as the heat exchanger heat rate, and the 
goal would be the minimum discharge pipe exit temperature.
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Compressed Air System 

Summary

This example will demonstrate how to determine the range of outlet temperatures for a system given the 
range values for the system parameters. 

Topics Covered

 l Modeling Compressors with curve data
 l Entering heat transfer data for pipes
 l Using Scenarios
 l Using the Copy Data From Jct... editing feature 

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Compressed Air System.aro

Problem Statement

In this example, four machine tools are supplied air for operations. The machine tools are sensitive to 
temperature; therefore, the manufacturer needs to know the delivery temperature extremes the tools will 
see. 

The air is taken from atmospheric conditions outside the building. Atmospheric pressure will remain con-
stant at 0 barG (0 kPa (g)), and the air temperature outside can vary from -18 to 45 deg. C. The tem-
perature inside the building ranges from 21 to 24 deg. C.

The compressor used to drive the system has the following pressure characteristics: 

 l 83 kPa (0.83 bar) at 0 kg/sec
 l 69 kPa (0.69 bar) at 0.25 kg/sec

https://www.aft.com/products/arrow/video-tutorial-series
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 l 41 kPa (0.41 bar) at 0.5 kg/sec

The compressor efficiency is not known for certain, but it is expected to be between 80% and 90%.

The nozzles at the tools have a pressure drop of 55 kPa (0.55 bar) at 0.1 kg/sec. The nozzles discharge 
to atmospheric pressure.

The pipes in the system are uninsulated steel with an ambient air velocity that varies from 1.5 to 25 
km/hr. The pipe at the compressor inlet is heavily insulated (adiabatic). All of the components in the sys-
tem are at an elevation of 0 meters.

What are the temperature extremes at the tools that this system could have?

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Air

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Model Layout for Compressed Air System Model

For this problem, you are required to determine the temperature extremes at the tools based on the 
range of system specifications. To do this, you will use the Scenario Manager to examine the hot and 
cold extremes for the system.  

The Scenario Manager is a powerful tool for managing variations of a model, referred to as scenarios.

The Scenario Manager allows you to:

 l Create, name, and organize scenarios
 l Select the scenario to appear in the Workspace (the ‘current’ scenario)
 l Delete, clone, and rename scenarios
 l Duplicate scenarios and save them as separate models
 l Review the source of a scenario’s specifications
 l Pass changes from a parent scenario to its child scenarios

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. The Base Scenario will contain all of the basic model data for 
the system.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = STD (schedule 40)
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 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

Pipe Size Length (meters)

1 2 inch 0.3

2-5 2 inch 8

6-9 1 inch 3

Junction Properties

 1. J1 Tank
 a. Elevation = 0 meters
 b. Fluid = Air
 c. Pressure = 0 barG (0 kPa(g))
 d. Temperature = 45 deg. C

 2. J2 Compressor/Fan
 a. Elevation = 0 meters
 b. Model Type = Centrifugal Compressor
 c. Compressor Model = Curve
 d. Added Pressure = Stagnation
 e. Compression Process Thermodynamics = Determine From Efficiency Data
 f. Enter Curve Data = 

Mass Pressure Efficiency

kg/sec kPa Percent

0 83 80

0.25 69 80

0.5 41 80

 g. Curve Fit Order = 2
 h. Click Generate Curve Fit Now
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Figure 2: Compressor/Fan Configuration window

 3. J3-J6 Branches
 a. Elevation = 0 meters

 4. J7 Valve
 a. Elevation = 0 meters
 b. Loss Source = User Specified
 c. Loss Model = Resistance Curve
 d. Exit Valve (optional) = Checked
 e. Exit Pressure = 0 barG (0 kPa(g))
 f. Exit Temperature = 21 deg. C

 g. Enter Resistance Curve Data = 

Mass Pressure

kg/sec kPa

0.1 55
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 h. Click Fill As Quadratic
 i. Curve Fit Order = 2
 j. Click Generate Curve Fit Now

 5. J8-J10 Valves (Tool #2, Tool #3, and Tool #4)
 a. Open the Valve Property window, and in the Copy Data From Jct drop-down list at the top, 

select J7. This will open the Copy Data From Junction window. Click All at the top. This will 
cause all of the properties  to be set to the same as the properties for J7. Since you want the 
J8 tool to retain its unique name, click on the check box next to the Name parameter to 
deselect it (see Figure 3). Click OK. J8 now has all of the same properties as J7 except for 
the junction name.

 b. Enter the junction name as Tool #2.
 c. Repeat this process for J9 and J10, entering the names as Tool #3 and Tool #4, respect-

ively.

Figure 3: Copy Data From Junction 7 window for J8

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

Note: Optionally, you can create a layer named Valve Labels with the valves set to visible within the 
Show/Hide Labels group in Layer Settings and the parameters Junction Name and Tem-
perature Static Inlet selected in Junction Parameters.
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 Step 4. Create the Scenarios

Now you will use the Scenario Manager on the Quick Access Panel to create our temperature extreme 
scenarios. Note that you can also use the Scenario Manager from the Tools menu if you prefer.

From the Quick Access Panel, either right click on the Base Scenario and select Create Child, or select 

the Create Child icon .  Enter the name Hot Case in the Create Child Scenario window, as shown in 
Figure 4. Then click OK.

Figure 4: New  scenario named Hot Case in the Create Child Scenario window

Select the Base Scenario in the Quick Access Panel, and then create another child. Enter the name Cold 
Case in the Create Child Scenario window and click OK. The Scenario Manager on the Quick Access 
Panel should now show two child scenarios below the Base Scenario, as shown in Figure 5.

Figure 5: Scenario Manager with two child scenarios
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 Step 5. Modify the Hot Case Scenario 

Double-click on the Hot Case scenario in the Quick Access Panel to load the Hot Case scenario. Altern-
atively, you can select the Hot Case scenario from the Quick Access Panel and then click on the Load 

Scenario icon  to load the scenario.

In order to simulate the Hot Case such that the tools would experience the highest temperatures, you 
must assume the highest inlet and ambient temperatures as well as the worst heat transfer properties of 
the piping and lowest compressor efficiency. Make these changes to the following pipes:

 1. P2-P9 Pipes
 a. The heat transfer properties of the uninsulated pipes should be set to the values as shown 

in Figure 6 (the wall thickness for the Pipe Wall will vary, depending on the diameter of the 
pipe). Change the Heat Transfer Model to Convective Heat Transfer. Next, enter a Tem-
perature of 24 deg. C and enter a Fluid Velocity of 1.5 km/hr. Doing so will minimize the 
heat transfer occurring in the pipe, and result in the highest temperature at the tools. Use 
the Global Pipe Edit tool to define the heat transfer information for all pipes at once.

Figure 6: Pipe Heat Transfer Data for Hot Case Scenario

 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.
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 Step 7. Examine the Output

The Output window contains all the data that was specified in the Output Control window. The output for 
the Hot Case Scenario is shown in Figure 7. The valve output window shows the highest static tem-
perature at the tools for the Hot Case is 93.52 deg. C at Tool #1 (T Static In).

Figure 7: Output window showing the results for Hot Case Scenario

 Step 8. Modify the Cold Case Scenario 

Open the Scenario Manager again from the Tools menu (or use the Scenario Manager in the Quick 
Access Panel). Select the Cold Case scenario in the Scenario Manager, and then click Load As Current 
Scenario to open the Cold Case scenario.

In order to simulate the Cold Case such that the tools would experience the lowest temperatures, you 
must assume the lowest inlet and ambient temperatures as well as the best heat transfer properties of 
the piping and highest compressor efficiency. Make these changes to the following objects:

 1. J1 Tank
 a. Temperature = -18 deg. C

 2. J2 Compressor
 a. The compressor will generate less heat if it is more efficient. Since this is the lower tem-

perature case, you must assume the best feasible efficiency, which is 90%. This data is 
entered in the Compressor/Fan Configuration window. Since you used 80% in the table 
when you added the compressor information in the Base Scenario (Step 6), change the effi-
ciency in the Raw Data table to 90%, and then click Generate Curve Fit Now to generate a 
new compressor curve.

 3. Pipes P2-P9
 a. Set the heat transfer properties of the uninsulated pipes after the compressor to the values 

that will result in the lowest gas temperatures at the tools. The appropriate ambient tem-
perature to use is the lowest of 21 deg. C. However, it is not clear which convection coef-
ficient should be used. If the heat of compression at the compressor heats the gas to a 
temperature higher than 21 deg. C, we should use the highest ambient air velocity of 25 
km/hr. This will permit maximum cooling of the gas in the pipe. On the other hand, if the 
compressor discharge temperature is less than 21 deg. C, then the lowest ambient air velo-
city of 1.5 km/hr should be used. This will yield the least heating of the gas in the pipes, giv-
ing the lowest possible temperature at the tools. Here we will use the value of 25 km/hr. As 
just discussed, in practice one would need to verify the validity of this assumption.
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 Step 9. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 10. Examine the Output

The Output window contains all the data that was specified in the Output Control window. The output for 
the Cold Case Scenario is shown in Figure 8. The valve output window shows the lowest static tem-
perature at the tools for the Cool Case is 18.49 deg. C at Tool #4 (T Static In).

Note that the compressor discharge stagnation temperature is 26.07 deg. C, and thus the assumption of 
25 km/hr for the ambient air velocity was appropriate.

Figure 8: Output window showing results for Cool Case Scenario

 Step 11. Use the Isometric Grid

AFT Arrow allows the user to place pipe or junction objects anywhere in the Workspace. Objects are 
placed on a 2D grid by default, as was the case with this example. At times it may be convenient to 
demonstrate the three-dimensional nature of a system. For example, if you are building a model based 
on isometric reference drawings. AFT Arrow includes an Isometric Pipe Drawing Mode for these cases. 
The isometric grid has three gridlines that are offset by 60°, representing the x, y, and z axes. Figure 9 
shows the compressed air system built on an isometric grid. 
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Figure 9: Compressed air system with isometric grid shown

You can enable the isometric grid by going to the Arrange menu. Under Pipe Drawing Mode, there are 
three options: 2D Freeform (default), 2D Orthogonal, and Isometric. 

Creating the compressed air system on an isometric grid will demonstrate how to use this feature. 

 1. Go to the File menu and select New. 
 2. From the Arrange menu, Show Grid and choose Isometric under Pipe Drawing Mode. 
 3. Place junctions J1-J7 on the Workspace in the positions shown in Figure 9. 
 4. You will notice that placing junctions onto the Workspace follows the usual rules, however, the 

visual appearance of the icons can be more complex than on a 2D grid. Due to the increased num-
ber of axes, the preferred icon and rotation can be selected to obtain visual consistency. Right 
click on J7 and select Customize Icon. Click the Rotate button and select the icon shown in Figure 
10. 
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Figure 10: Right click on the junction to open the Customize Icon window and select the preferred icon and 
rotation

 5. Copy J7 for the tools, J8-J10, to maintain the preferred icon. 
 6. Draw P1, as shown in Figure 11 
 7. Draw P2 from J2 to J3. A red-dashed preview line will show how the pipe will be drawn on the iso-

metric grid. As you are drawing a pipe, you can change the preview line by clicking any arrow key 
on your keyboard or scrolling the scroll wheel on your mouse. Figure 11 shows Pipe 2 being 
drawn with the preview line. 

Figure 11: A preview line shows when drawing or adjusting pipes

Note: You can hold the ALT key while adjusting a pipe by the endpoint to add an additional segment. 
This can be used with the arrow key or mouse scroll wheel to change between different preview 
line options. 



Compressed Air System

- 66 -

 8. Draw pipes P3-P9, as shown in Figure 12.
 9. The grid can be shown or turned off in the Arrange menu. 

Figure 12: Compressed air system with isometric grid not shown

Conclusion

By carefully selecting the input parameters from the specified system parameters, you were able to use 
AFT Arrow to determine the temperature extremes of the gas being supplied to the tools in the com-
pressed air system. This information can now be sent to the tool manufacturer, who will use it to com-
pensate for the temperature sensitivity of the tools.
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Process Steam System 

Summary

The objective of this example is to determine the minimum delivery pressure of a process steam supply 
system.

Topics Covered

 l Determining the minimum delivery pressure of a steam supply system.
 l Understanding Solution Control sensitivity

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Process Steam System.aro

Problem Statement

A process steam supply system has two boilers at 20.7 barG (2070 kPa(g)) and 430 deg. C. 

All of the pipes in the system have 5 cm of insulation with a thermal conductivity of 0.03 W/m-K, and an 
ambient air velocity of 11 km/hr. The ambient temperature is 24 deg. C. The pipes are all Steel - ANSI 
schedule 40. All of the elbows in the system are Smooth, with an r/D of 1.5.

All of the tees in the system should be modeled using the Detailed loss model, with sharp edges.

The system has six users with the following peak flow demands:

 1. 18,000 kg/hr
 2. 23,000 kg/hr
 3. 25,000 kg/hr
 4. 25,000 kg/hr

https://www.aft.com/products/arrow/video-tutorial-series
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 5. 18,000 kg/hr
 6. 27,000 kg/hr

Determine the following:

 l What is the minimum delivery (stagnation) pressure of the system, and at which user?

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Navigate to the Fluid panel in Analysis Setup
 2. Define the Fluid panel with the following inputs

 a. Fluid Library = AFT Standard
 b. Fluid = Steam

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Model Layout for Process Steam System

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = Use table below
 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

Pipe Size (inch) Type Length 
(meters)

1 12 schedule 40 30

2 12 schedule 40 46
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Pipe Size (inch) Type Length 
(meters)

10 12 schedule 40 23

101 8 schedule 40 122

102-103 8 schedule 40 229

104 8 schedule 40 76

105 6 schedule 40 30

106 6 schedule 40 15

107 6 schedule 40 23

201 8 schedule 40 76

202-204 8 schedule 40 152

205 & 207 6 schedule 40 15

206 6 schedule 40 23

 2. Heat Transfer tab
 a. Heat Transfer Model = Convective Heat Transfer
 b. Number of Insulation Layers = 1 External
 c. Temperature = 24 deg. C
 d. Fluid Velocity = 11 km/hr
 e. Insulation #1 Conductivity = 0.03 W/m-K
 f. Insulation #1 Thickness = 5 cm

Junction Properties

 1. J1 & J2 Tanks
 a. J1 Name = Boiler 1
 b. J2 Name = Boiler 2
 c. Elevation = 0 meters
 d. Pressure = 20.7 barG (2070 kPa(g))
 e. Temperature = 430 deg. C

 2. All Bends 
 a. Elevation = 0 meters
 b. Type = Smooth Bend (flanged or butt-welded)
 c. Angle = 90 Degrees
 d. r/D = 1.5

 3. All Tee/Wye
 a. Elevation = 0 meters
 b. Loss Model = Simple
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 c. Initial Pressure = 7 barG (on Optional tab)
 4. All Assigned Flows

 a. Elevation = 0 meters
 b. Type = Outflow
 c. J106 Name = User 1
 d. J107 Name = User 2
 e. J108 Name = User 3
 f. J206 Name = User 4

 g. J207 Name = User 5
 h. J208 Name = User 6
 a. J106 Flow Rate = 18,000 kg/hr
 b. J107 Flow Rate = 23,000 kg/hr
 c. J108 Flow Rate = 25,000 kg/hr
 d. J206 Flow Rate = 25,000 kg/hr
 e. J207 Flow Rate = 18,000 kg/hr
 f. J208 Flow Rate = 27,000 kg/hr

Note: Sometimes adding initial guesses to pipes or junctions can help difficult solutions converge.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Create Workspace Layers

To show the names of the tanks, a new Workspace Layer will be created.

 1. Select both tanks on the Workspace using a selection box (dragged from left to right) or holding 
CTRL while clicking each tank.

 2. In the Quick Access Panel, open the Workspace Layers tab.
 3. Create a new layer by selecting New Layer and then select the option From Workspace Selec-

tions in the drop-down menu. This creates a layer in which the selected objects and their labels 
are set to be visible.

 4. Name the layer Boiler Labels.
 5. Edit the layer by selecting it and clicking the gear icon to bring up the Layer Settings window or by 

double clicking on the layer name.
 6. Navigate to the Junction Parameters panel and expand the Commonly Used Junction Parameters 

list.
 7. Double-click Junction Name to add it to the list on the right-hand side. This will add the Junction 

Name to the tank labels.
 8. Close the Layer Settings window.

Another layer will be built to show the discharge pressure at each of the Assigned Flow junctions.
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 1. Select all of the Assigned Flow junctions on the Workspace.
 2. Create a new layer called Discharge Pressures using the From Workspace Selections 

method.

 3. Open Layer Settings for the Discharge Pressures layer and navigate to the Junction Parameters 
panel.

 4. In the list to the left, double-click Junction Name and Pressure Stagnation Outlet (barG) to add 
them to the list on the right-hand side. Since there is currently no output, the pressure parameter will 
appear grayed out.

After running the model, this layer will display the discharge pressures on the Workspace.

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 6. Examine the Output

The pipes output section, shown in Figure 2, indicates the minimum delivery stagnation pressure is 9.766 
bar (976.6 kPa) at J108.

Figure 2: Output window showing results for Process Steam System example

Pressure results can also be seen on the Workspace from the Discharge Pressures layer that was cre-
ated earlier, but note that the labels on the Workspace are in units of barG rather than bar.

 Step 7. Solution Control Sensitivity

Open Analysis Setup and navigate to the Solution Method panel again. Change the Solution Method to 
User Specified with an Initial Number of Segments per Pipe as 10 (see Figure 3). Rerun the model, and 
compare the results to the previous run.  
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Figure 3: The Solution Method panel can be used to adjust the solution sensitivity

Repeat the run again with 20 segments, and 40 segments. What are the results?

 l With 2 segments, the minimum  (stagnation) pressure is 9.766 bar (976.6 kPa) at J108.
 l With 10 segments, the minimum (stagnation) pressure is 9.888 bar (988.8 kPa) at J108.
 l With 20 segments, the minimum (stagnation) pressure is 9.892 bar (989.2 kPa) at J108.
 l With 40 segments, the minimum (stagnation) pressure is 9.893 bar (989.3 kPa) at J108.

This example points out the fact that some models are sensitive to the Solution Method used. While with 
most systems changing the solution control will not affect the results, in systems such as this were there 
are large pressure changes and high Mach numbers, the Solution Control settings can have a strong 
affect on the results. This is something that ALL engineers should be aware of, and keep in mind when 
creating computer model solutions.
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Hydrocarbon Process Relief System 

Summary

This example will demonstrate how to determine the relief capacity of a system, where sonic choking 
occurs, and the pressure drop across a shock wave.

Topics Covered

 l Understanding sonic choking
 l Observing pressure drop across shock waves
 l Using fluid mixtures
 l Understanding the basics of sound power level (acoustically induced vibration)

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Hydrocarbon Process Relief System.aro

Problem Statement

A mixture of 89% methane and 11% hydrogen (by mass) exists at a process facility. There is a plan to 
increase the process conditions to 65 barG (6500 kPa(g)) at 40 deg. C. The relief system needs to be re-
evalutated to determine if it will still be adequate under these conditions. Assume that all of the pipes are 
well insulated (i.e. adiabatic).

Determine the following:

 l What is the relief capacity of the system under the new conditions?
 l Where does sonic choking occur in the system, and why?
 l What is the pressure drop across the shock wave(s)?
 l Is acoustically induced vibration a concern for this design?

https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

For this analysis, you will need to create and use a fluid mixture using the NIST REFPROP fluid library.

 1. Open Analysis Setup from the toolbar or from the Analysis menu
 2. Navigate to the Fluid panel
 3. In the Fluids Available in Library section, select NIST REFPROP 
 4. Click Create New Mixture and Add to open the Create Mixture window
 5. Enter the name hydrogen/methane in the New Mixture Name field
 6. Select Hydrogen (normal) from the list of Fluids Available In Library
 7. Enter a Mass Fraction of 11% in the Mass Fraction field, then click Add Fluid to Mixture to add 

hydrogen to the list components in the mixture
 8. Repeat this process for Methane, with a Mass Fraction of 89%
 9. The Create Mixture window should now appear as shown in Figure 1

 10. Click OK to add the mixture to the Fluids in Current Model on the Fluid panel, as shown in Figure 2
 11. Ensure that Library is selected as the Specific Heat Ratio Source
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Figure 1: The Create Mixture window is used to create mixtures of NIST REFPROP fluids

Figure 2: The Fluid panel in Analysis Setup
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 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 3: Model layout for Hydrocarbon Process Relief System example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. Note the following:

 l The Total K Factor listed for the pipes should be entered as the Total K Factor on the Fittings & 
Losses tab in the Pipe Properties window.

 l The CdA values given for the valves are required for Sonic Choking calculations.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = Use table below
 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

 g. Total K Factor = Use table below
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Pipe Size (inch) Type Length 
(meters)

Total K 
Factor

1 6 STD (sched-
ule 40) 7 4.4

2 6 STD (sched-
ule 40) 6 4.2

3 10 STD (sched-
ule 40) 10 2.1

4 16 STD (sched-
ule 30) 80 8.9

Junction Properties

 1. J1 Tank
 a. Name = Process
 b. Elevation = 4 meters
 c. Fluid = hydrogen/methane (mixture)
 d. Pressure = 65 barG (6500 kPa(g))
 e. Temperature = 40 deg. C

 2. J2 Valve
 a. Name = Manual Valve
 b. Elevation = 2 meters
 c. Valve Data Source = User Specified
 d. Subsonic Loss Model = K Factor
 e. K = 10
 f. Sonic CdA = 100 cm2

 3. J3 Branch
 a. Name = Header Connection
 b. Elevation = 4 meters

 4. J4 Valve
 a. Name = Relief Valve (assumed open)
 b. Elevation = 0 meters
 c. Valve Data Source = User Specified
 d. Subsonic Loss Model = K Factor
 e. K = 8.3
 f. Sonic CdA = 300 cm2

 5. J5 Assigned Pressure
 a. Name = Atmosphere
 b. Elevation = 7 meters
 c. Fluid = hydrogen/methane (mixture)
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 d. Pressure = 0 barG (0 kPa(g))
 e. Temperature = 40 deg. C
 f. Pressure Specification = Stagnation

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

Optionally, the Junction Name parameter can be added to the All Objects Layer to display the junction 
names on the Workspace.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 5. Specify the Output Control

Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.

Set the units for Mass Flow to kg/hr for pipes. In the Junctions section, add the parameter Sound Power 
Level to the Output parameters list.

 Step 6. Examine the Output

The output shows the capacity of the system is 176,038 kg/hr, as shown in Figure 4.

The Sonic Choking tab in the General section of the Output window shows that the system chokes at J3, 
the Header Connection, and at J5, the discharge to atmosphere. The system chokes at J3 because of 
the expansion from 6-inch (15.4 cm ID) pipe to 10-inch (25.4 cm ID) pipe. The system chokes at J5 
because of endpoint choking.

The pressure drop across the choke point is the same as the change in stagnation pressure. This can be 
seen in the Junction output section. The pressure drop across the choke point at J3 is 2.503 bar (250.3 
kPa), and the pressure drop across the shock wave at J5 is 2.227 bar (222.7 kPa).
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Figure 4: Output window showing results for Hydrocarbon Process Relief System example

Sound Power Level

Note that both valves are identified by the warning message The following junctions have a predicted 
Sound Power Level greater than 155 dB, as shown in Figure 5.

In a real system, further analysis would need to be performed to ensure that the system does not have an 
unacceptably high likelihood of failure due to high frequency acoustically induced vibration. Changes to 
support structures, to welded discontinuities such as pressure gauges, or changes to the valve design 
(e.g. low noise trim) may be necessary to prevent system failure.

If the other design requirements can still be met, another approach to address this could be to modify the 
relief system design to reduce the Sound Power Level at these junctions. For example, using 8 inch pip-
ing for this relief system reduces the Sound Power Level at these valves below the 155 dB threshold 
without decreasing the mass flow rate that can be accommodated. High frequency acoustically induced 
vibrations are an important consideration when designing relief or blowdown subsystems.
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Figure 5: Sound Power Level output and vibration fatigue warning
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Refinery Relief System 

Summary

This example will demonstrate how to evaluate an emergency relief system for relief capacity, and mass 
and mole fraction of a discharge mixture for an environmental impact assessment.

Topics Covered

 l Evaluating Relief Valves
 l Using Scenarios
 l Using Global Junction Edit Feature

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Refinery Relief System.aro

Problem Statement

A new emergency relief system at an oil refinery is being considered, and the process calculations need 
to be evaluated.

The system provides relief to processes for methane, propane, and ethane. Each process is at 13 barG 
(1300 kPa(g)) when the relief event occurs.  

The relief valve CdA is 100 cm2. Assume K=0 since this system will choke. The elbow is a standard 
elbow, and the tees should all be modeled as simple tees.  All of the pipes are STD (schedule 40) Steel - 
ANSI pipe, with standard roughness, and the flow can be assumed to be adiabatic.

The process engineer has evaluated the relief capacity at the minimum process temperature of 150 deg. 
C. Depending on the properties of the crude oil, all three processes can operate at up to 315 deg. C. The 
process engineer did not look at this case due to time constraints, but he thinks the higher temperatures 

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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will not affect the relief capacity. The process engineer also neglected any elevation changes to simplify 
the calculations, even though the relief point is 35 meters above the discharge header.

Determine the following:

 l The relief capacity (i.e. flow rate) of each process.
 l The mass and mole fraction of the discharge mixture for the environmental impact assessment.
 l Determine if neglecting the high temperature case and the elevation effects are acceptable.

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Steady Solution Control Group 

There is an option available in Solution Control when using one of the marching methods that can some-
times result in an overall reduction in solution runtime. This option is to first solve the system using the 
Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since 
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduc-
tion in runtime for the marching method.

The Steady Solution Control Group is already defined using the default inputs. This means that no user 
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this 
model. 

To activate this option, do the following:

 1. Open Analysis Setup
 2. Navigate to the Solution Method panel in the Steady Solution Control group
 3. Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For 

Marching Solution

The Steady Solution Control Group is now defined for this model.

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = NIST REFPROP
 b. Fluid = Methane

 i. After selecting, click Add to Model
 c. Repeat this to add Ethane and Propane
 d. Specific Heat Ratio Source = Library
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 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 1: Model layout for Refinery Relief System example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

Pipe Size (inch) Length (meters)

1-3 3 15

4 3 10
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Pipe Size (inch) Length (meters)

5 4 10

6 6 45

Junction Properties

 1. All Tanks
 a. J1 Name = Methane Tank
 b. J2 Name = Ethane Tank
 c. J3 Name = Propane Tank
 d. Elevation = 0 meters
 e. J1 Fluid = Methane
 f. J2 Fluid = Ethane

 g. J3 Fluid = Propane
 h. Pressure = 13 barG (1300 kPa(g))
 i. Temperature = 150 deg. C

 2. J4 Bend 
 a. Elevation = 0 meters
 b. Type = Standard Elbow (knee, threaded)
 c. Angle = 90 Degrees

 3. All Tees
 a. Elevation = 0 meters
 b. Loss Model = Simple

 4. J7 Valve
 a. Name = Relief Valve
 b. Elevation = 0 meters
 c. Valve Data Source = User Specified
 d. Loss Model = K Factor
 e. K Factor = 0
 f. Sonic CdA = 100 cm2

 g. Exit Valve (optional) = Checked
 h. Exit Pressure = 0 barG (0 kPa(g))
 i. Exit Temperature = 21 deg. C

To show the names of the tanks and valve, a new Workspace Layer will be created.

 1. Create a new layer by selecting New Layer and then Blank Layer from the Workspace Layers tab 
of the Quick Access Panel.

 2. Name the layer Junction Labels.
 3. Edit the layer by selecting it and clicking the gear icon to bring up the Layer Settings window.
 4. Open the Show/Hide Labels panel and uncheck Force Shown Labels to Match Shown Objects.
 5. Toggle the visibility icon next to the tanks and valve to on. This will cause their labels to be shown.
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 6. Navigate to the Junction Parameters panel and expand the Commonly Used Junction Parameters 
list.

 7. Double-click Junction Name to add it to the list on the right-hand side. This will add the Junction 
Name to the label of the junctions that were defined in the Show/Hide Labels panel.

 8. Close the Layer Settings window.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 6. Specify the Output Control

Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.

With the Pipes button selected at the top, add Composition Mass Fraction and Composition Mole Frac-
tion to the pipe output list by highlighting these parameters (holding CTRL will allow you to select both at 
the same time) and then clicking the purple Add arrow. 

 Step 7. Examine the Output

The Composition tab in the pipes output section displays the component mass flow rate through each of 
the pipes, as shown in Figure 2).  

The output for this model shows:

 l The total relief capacity is 16.236 kg/sec
 l 2.930 kg/sec for methane
 l 5.382 kg/sec for ethane
 l 7.924 kg/sec for propane

 l The mass fraction at discharge (observed from clicking on the Composition tab): 18.05% meth-
ane, 33.15% ethane, and 48.81% propane

 l The mole fraction at discharge from the Composition tab: 33.74% methane, 33.06% ethane, and 
33.20% propane
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Figure 2: Output window showing results for Refinery Relief System example

 Step 8. Create a Child Scenario

In order to determine if the process engineer has made good assumptions by neglecting the higher tem-
perature process and the elevation data, it will be necessary to change the model. This can be done eas-
ily using the Scenario Manager on the Quick Access Panel. Note that the Scenario Manager can also be 
accessed from the Tools menu.

The Scenario Manager is a powerful tool for managing variations of a model, referred to as scenarios. 

The Scenario Manager allows you to:

 l Create, name and organize scenarios
 l Select the scenario to appear in the Workspace (the ‘current’ scenario)
 l Delete, copy and rename scenarios
 l Duplicate scenarios and save them as separate models
 l Review the source of a scenario’s specifications
 l Pass changes from a scenario to its variants

The Scenario Manager should currently appear as shown in Figure 3.

Figure 3: The Scenario Manager window on the Quick Access Panel is used to create and manage model 
scenarios
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Create a child scenario by either right-clicking on the Base Scenario and then selecting Create Child. 
Enter the name High Inlet Temp in the Create Child Scenario window, as shown if Figure 4. Click OK. 
The new High Inlet Temp scenario should now appear in the Scenario Manager on the Quick Access 
Panel below the Base Scenario as shown in Figure 5. 

Figure 4: Create Child Scenario window

Figure 5: Scenario Manager on the Quick Access Panel with New Child Scenario

 Step 9. Modify the Higher Inlet Temp Scenario with Global Junction Editing

Double-click on the High Inlet Temp scenario in the Scenario Manager on the Quick Access Panel to 
make it the active scenario if it is not already.

To check the process engineer's assumption about the 315 deg. C process, the inlet temperature for all 
of the process tanks must be changed from 150 to 315 deg. C. These changes could be made by open-
ing the Tank Properties window for each of the tanks and changing the inlet temperatures one at a time.

AFT Arrow has a feature that can be used to change the temperature for all of the tanks at the same time. 
This feature is called Global Junction Editing.

Open the Global Junction Edit window by selecting Global Junction Edit | Tanks from the Edit 
menu. Select all of the tanks in the Junction List by clicking All at the top (see Figure 6). 
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Figure 6: Global Junction Edit window

Click the Select Tank Data button. This will open a Tank Properties window. Enter a temperature of 315 
deg. C and click OK to close the Tank Properties window. The Global Junction Edit window now contains 
a list of all the parameters that can be changed in the selected junctions. The data in the list is grouped 
together by the tab on the Properties window on which the data is entered. Any items that are selected in 
this list will be applied to all of the junctions selected in the Junction list.  Check the box next to Tem-
perature in the list, which now shows a value of 315 deg. C  (see Figure 7).  Since this is the only item in 
the parameter list that is selected, it is the only parameter that will be changed in the selected tank junc-
tions. Click Apply Selections at the bottom then click OK to close the Global Junction Edit window. The 
temperatures for all three of the tanks have now been updated to 315 deg. C. Open the Properties win-
dow for one of the tanks to verify that the change was made.
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Figure 7: Global Junction Edit window with Temperature Parameter Selected

 Step 10. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 11. Examine the Output

See Figure 8 for the output from this scenario. The output for this model shows:

At 315 deg. C, the relief capacity is reduced to 13.519 kg/sec, a 17% reduction, which is significant. The 
original assumption and calculation by the process engineer based on this assumption was not con-
servative, as he assumed.
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Figure 8: Output window showing the results for High Inlet Temp Scenario

 Step 12. Create and Run a Child Scenario for Elevation Effects

Create a child scenario to the High Inlet Temp scenario to examine the affect including the elevation 
information has on the model.

Change the elevation data for the J7 Valve to 35 meters. Rerun the model, and examine the results.

Adding the 35-meter elevation to the relief valve has a negligible effect on the system solution.
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Air Blower Sizing 

Summary

The objective of this example is to size a blower for an air distribution system, and evaluate the effect of 
different blower efficiencies on the blower size.

Topics Covered

 l Sizing a Blower
 l Changing Compressor Efficiencies 
 l Using Design Factors
 l Using Scenario Manager

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Air Blower Sizing.aro

Problem Statement

An air distribution system requires a new blower. All of the pipes in the system are STD (schedule 40) 
steel, with adiabatic flow. You are to use a design factor of 1.1 on all of the pipe and junction friction 
losses. You can neglect elevation changes, and any losses at the branches. All of the pipes leading to 
the discharge rooms discharge at atmospheric pressure.

Use Redlich-Kwong for the equation of state model, and Generalized for the enthalpy model.

For the blower, there are three compression process cases to be examined:

 l Adiabatic
 l Efficiency = 80 Percent (set as Nominal Efficiency)
 l Efficiency = 60 Percent

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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For these three cases, determine:

 l The size of the blower for both flow and pressure rise to deliver a minimum of  430 sm3/h to each 
room.

 l How the different compression process models for the blower affect the blower sizing and the dis-
charge temperatures.

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Air

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Model layout for Air Blower Sizing example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

Pipe Size (inch) Length 
(meters)

1 6 12

2 6 30

3-5, 7-8 4 75

6 4 150

9-13 2 30
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 2. Optional tab
 a. Pipe Friction = 1.1

Junction Properties

For this example, we need to determine the correct flow through the compressor. Now we need to use 
our engineering judgment to take an initial guess at the flow rate through the compressor. Assume  2150 
sm3/h to start:

 1. J1 Tank
 a. Elevation = 0 meters
 b. Fluid = Air
 c. Pressure = 0 barG (0 kPa(g))
 d. Temperature = 21 deg. C

 2. J2 Compressor/Fan
 a. Elevation = 0 meters
 b. Compressor Type = Centrifugal Compressor
 c. Compressor Model = Sizing
 d. Compression Process Thermodynamics = Isentropic
 e. Compressor Sizing Parameter = Mass Flow Rate
 f. Fixed Flow Rate = 2150 sm3/h

 3. All Assigned Pressures
 a. Elevation = 0 meters
 b. Pressure Model tab

 i. Fluid = Air
 ii. Pressure = 0 barG (0 kPa(g))
 iii. Temperature = 21 deg. C
 iv. Pressure Specification = Stagnation

 c. Loss Coefficient tab
 i. K - Flow into pipe = 1
 ii. K - Flow out of pipe = 1

 d. Optional tab
 i. Junction Friction Loss = 1.1

 4. All Branches
 a. Elevation = 0 meters

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.
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 Step 4. Specify the Output Control

Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.

Select the units sm3/h for the Mass Flow Rate parameter for both Pipes and Junctions output.

 Step 5. Create Child Scenarios

Using the Scenario manager, create one child scenario named 2150 sm3h then three child scenarios to 
that scenario for the air blower evaluation. Name the first Adiabatic, name the second 80% Efficient, and 
name the third 60% Efficient. For the compressor in each scenario, open the Compressor/Fan Properties 
window, and set the following:

 1. For the Adiabatic case, no changes are necessary. The Compression Process Thermodynamics 
for the Compressor is already set to Isentropic (i.e adiabatic) and no Nominal Efficiency is 
entered.

 2. For the 80% Efficient case, set the Nominal Efficiency to 80 Percent, and set the Compression Pro-
cess Thermodynamics to Determine From Efficiency Data.

 3. For the 60% Efficient case, set the Nominal Efficiency to 60 Percent, and set the Compression Pro-
cess Thermodynamics to Determine From Efficiency Data.

 Step 6. Run the Models

Load the Adiabatic scenario and click Run Model on the toolbar or from the Analysis menu. This will open 
the Solution Progress window. This window allows you to watch as the AFT Arrow solver converges on 
the answer. This model runs very quickly. Now view the results by clicking the Output button at the bot-
tom of the Solution Progress window.

Repeat this process for each of the three child scenarios.

 Step 7. Examine the Output

The Output window contains all the data that was specified in the Output Control window.  

Based upon the initial flow rate guess for the blower of  2150 sm3/h, not all rooms are receiving a min-
imum flow rate of  430 sm3/h. Therefore, the flow rate at the blower must be increased until each room 
receives a minimum flow rate of  430 sm3/h.

Determining the required blower flow rate can be easily accomplished through manual iteration on the 
blower flow rate. In order to automate this process of iteration, the AFT Arrow Goal Seek and Control 
(GSC) add-on module can assist with this greatly.

Right-click the 1250 scfm scenario and select Clone with Children. Iterate the blower mass flow rate until 
the  430 sm3/h is achieved.

The output for each of the scenarios is shown in Figure 2, Figure 3, and Figure 4. This output is based 
upon the final required blower flow rate that will deliver a minimum flow rate of  430 sm3/h to each room.
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The results are as follows:

Scenario
Total Flow 

Stagnation 
Pressure 

Rise

Max Static 
Discharge 

Temp

sm3/h bar (kPa) deg. C

Adiabatic 2300 0.55748 
(55.748) 58.43

80% Efficient 2300 0.57339 
(57.339) 69.32

60% Efficient 2300 0.60128 
(60.128) 88.60

Figure 2: Output window showing the results for Adiabatic scenario
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Figure 3: Output window showing the results for 80% Efficient scenario

Figure 4: Output window showing the results for 60% Efficient scenario

 Step 8. Evaluate 60% Efficiency with Heat Transfer

The engineers on the project have realized that the pipes are not insulated, and that the adiabatic 
assumption may be overly conservative. One engineer has also expressed concern that the discharge 
air could be too hot.
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Create a child scenario to the  2300 sm3/h 60% efficient case named With Heat Transfer. Add heat trans-
fer to the model on all the pipes by selecting Convective Heat Transfer as the Heat Transfer Model. For 
the Ambient Conditions, enter a Temperature of  26 deg. C, a Fluid Velocity of  11 km/hr, and Air as the 
Fluid. See Figure 5 for this input.

Figure 5: Pipe heat transfer window

Run the new scenario and determine the following:

 l Do the compressor size requirements change significantly?
 l How much do the discharge temperatures decrease?

 Step 9. Examine the Output for 60% Efficiency with Heat Transfer

The output for this scenario is shown in Figure 6.

The blower stagnation pressure rise decreases from  0.60128 to 0.52391 bar, which is a 13% reduction. 
The max discharge temperature decreases to  31.45 deg. C.
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Figure 6: Output window showing the results for 60% Efficiency Scenario with Heat Transfer in Pipes
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Compressed Air System - Cost 

Summary

This example demonstrates how to use the cost calculation features in AFT Arrow. All cost calculation 
features are included with Arrow.

Topics Covered

 l Estimating simple costs
 l Connecting cost libraries
 l Using Cost Settings
 l Using the Cost Report

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Compressed Air System.aro
 l Metric - Compressed Air System - Cost.aro
 l Compressed Air System.dat - engineering library
 l Compressed Air System Costs.cst - cost library for Compressed Air System.dat
 l Steel - ANSI Pipe Costs.cst - cost library for Steel - ANSI

Problem Statement

Use the cost calculation features in AFT Arrow to determine the cost of the compressed air system over a 
10-year period for both the hot and cold cases. Include material, installation, and energy costs.

https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Important: The GSC module and cost calculations can be used in the same run, but we are not going 
to do this here. Before proceeding, make sure to disable GSC by selecting the radio button for 
Ignore in the Modules panel in Analysis Setup.

 Step 2. Define the Pipes and Junctions Group

Open the Metric - Compressed Air System.aro example file listed above, which is located in the 
Examples folder in the AFT Arrow application folder. Save the file to a different folder. 

Once the model is opened and saved to a new location, load the Base Scenario. The workspace should 
look like Figure 1

Figure 1: Model Layout for Compressed Air System - Cost Example

 Step 3. Define the Steady Solution Control Group 

There is an option available in Solution Control when using one of the marching methods that can some-
times result in an overall reduction in solution runtime. This option is to first solve the system using the 
Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since 
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduc-
tion in runtime for the marching method.



Compressed Air System - Cost

- 103 -

The Steady Solution Control Group is already defined using the default inputs. This means that no user 
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this 
model. 

To activate this option, do the following:

 1. Open Analysis Setup
 2. Navigate to the Solution Method panel in the Steady Solution Control group
 3. Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For 

Marching Solution

The Steady Solution Control Group is now defined for this model.

 Step 4. Define the Cost Settings Group

To use the cost calculation feature, navigate to the Cost Settings panel in Analysis Setup. 

The Cost Settings panel is where the types of costs to be included in the cost calculations are specified. 
The Cost Settings panel is shown in Figure 2.

Energy cost data can be specified through an energy cost library, or by directly entering an energy cost in 
the Cost Settings window. Using an energy cost library allows you to specify multiple energy costs, such 
as energy costs at both peak and off-peak rates.

For this example, in the Cost Calculation section at the top, select Calculate. Next, in the Energy Cost 
section,  enter an energy cost of 0.12 U.S. Dollars Per kW-hr, as shown in Figure 2.

The Cost Definitions section allows you to specify the type of costs to be determined. You may select 
from actual monetary costs, including Material, Installation, Maintenance, and Operation/Energy costs.

For this example, include Material, Installation, and Operation/Energy costs by selecting them from the 
list of available Monetary Costs, as shown in Figure 2.

The system lifetime to be applied for the cost calculations is specified in the Cost Time Period section. 
You can also specify interest and inflation rates to be applied to the cost calculations as well.

For this example, enter a System Life of 10 years, as shown in Figure 2, then close the Cost Settings win-
dow by clicking OK.
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Figure 2: The cost calculations are enabled on the Cost Settings window

 Step 5. Engineering and Cost Libraries

The actual material and installation costs that the cost calculation feature uses are contained in cost lib-
raries. The cost libraries needed for this example already exist, and just need to be accessed.

The Library Manager (opened from the Library menu) shows all of the available and connected libraries. 
Libraries can either be engineering libraries or cost libraries. Cost libraries are always associated with an 
engineering library, and are thus displayed subordinate to an engineering library in the library lists.

Here we will summarize some key aspects of libraries:

 l Cost information for a pipe system component is accessed from a cost library. Cost library items 
are based on corresponding items in an engineering library. (The engineering libraries also 
include engineering information such as pipe diameters, hydraulic loss factors, etc.) 

 l To access a cost for a particular pipe or junction in a model, that pipe or junction must be based on 
items in an engineering library. Moreover, that library must be connected.

 l There can be multiple cost libraries associated with and connected to an engineering library. This 
makes it easier to manage costs of items.

Add the Engineering and Cost Libraries

Select Library Manager from the Library menu. Add the Compressed Air System.dat engineering lib-
rary file to the list of available libraries by clicking  Add Existing Library at the bottom. Browse to the engin-
eering library file in the AFT Arrow 10 Examples folder. The engineering library should now appear in the 
list of available libraries.

Now add the cost libraries by clicking  Add Existing Cost Library, and browsing to the Compressed Air 
System Costs.cst and the Steel - ANSI Pipe Costs.cst cost library files.
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All the added libraries should be connected automatically. If not connected, connect the newly added 
engineering libraries by selecting them in the list of available libraries, and clicking the Add to Con-
nections button.

The Library Manager should appear as shown in Figure 3.

Figure 3: The Library Manager window displays all of the available and connected libraries

The engineering libraries associated with these two cost libraries are the Steel - ANSI pipe materials lib-
rary, and an external library called Compressed Air System. For the cost data in the two cost libraries to 
be accessed by pipes and junctions in the model, the pipes and junctions must use these two engin-
eering libraries.

The pipes for this example are already using data from the Steel - ANSI pipe material library, so no modi-
fications need to be made for the pipes. 

All of the junctions except the tank junction must be modified to use the component data contained in the 
engineering library. Do this by opening the Properties window for each junction, and selecting the com-
ponent name displayed in the Library Jct list, as shown in Figure 4 for the Compressor/Fan junction.

Note that there are two compressor junctions in the library. One uses an efficiency of 80% for the Hot 
Case scenario, and the other uses an efficiency of 90% for the Cool Case scenario. For this case, select 
the Metric 80% efficient compressor.
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Figure 4: The components to be included in the cost analysis must be associated with an engineering library

 Step 6. Include Cost in Report

The final step before performing a cost analysis is to specify which pipes and junctions you want to be 
included in the final cost report. This is done by choosing Include in Cost Report on the Cost tab in the 
Properties window for each pipe and junction to be included, as shown for Pipe 1 in Figure 5.

The Global Edit feature may be used to update this information for all of the pipes and junctions.
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Figure 5: The Cost tabs on the pipe and junction Properties windows are used to include the objects in the 
Cost Report

 Step 7. Set up and Run the Hot Case Scenario

Once all the necessary Pipes and Junctions have been set to be included in the Cost Report, load the 
Hot Case scenario. Repeat Step 4 to re-enable cost calculation. The other cost-related parameters 
should be retained from the parent scenario.

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 8. Examine the Output

The Cost Report is displayed in the General section of the Output window. View the Cost Report by 
selecting the Cost Report tab. The content of the Cost Report can be controlled from the Output Control 
window. Figure 6 shows the Cost Report for this example with the Material, Installation, Operation, and 
Total costs displayed.

The Cost Report shows the total system cost, as well as the individual totals for the material, installation, 
and energy costs. In addition, the Cost Report displays the detailed cost for each pipe, junction, and fit-
ting that was included in the report. The items are grouped together by type, and a subtotal for each cat-
egory is listed.
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Figure 6: The Cost Report in the General Output section shows the results of the cost analysis

 Step 9. Set up and Run the Cold Case Scenario

Load the Cold Case scenario. Repeat Step 4. Open the J2 compressor Properties window and select the   
Metric - 90% Compressed Air System Compressor from the Library Junctions list. The results from run-
ning the Cold Case scenario are shown in Figure 7.

Figure 7: The Cost Report for the Cold Case scenario
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Cost Analysis Summary

The cost analysis for the Hot Case scenario shows that the total system cost over 10 years for the com-
pressed air system is $191,212. Of that cost, $10,156 was for Material costs, $4,494 was for Installation 
costs, and $176,563 was energy cost over the life of the system.

By contrast the cost analysis for the Cool Case scenario shows that the total system cost over 10 years 
for the compressed air system is $145,703. Of that cost, $10,156 was for Material costs, $4,494 was for 
Installation costs, and $131,054 was energy cost over the life of the system.
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Process Steam System - Cost 

Summary

This example demonstrates the fundamental concepts of the cost calculation features of AFT Arrow. The 
example illustrates how the cost calculation features can be used to calculate costs for a given system 
design.

Topics Covered

 l Creating cost libraries
 l Entering pipe, junction and fitting cost data into libraries
 l Connecting cost libraries
 l Using Cost Settings
 l Using the Cost Report

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition, it is assumed that the user has worked through the Beginner: Compressed Air System - Cost 
example and is familiar with the basics of  cost analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Process Steam System.aro
 l Metric - Process Steam System - Cost.aro
 l Process Steam System.dat - engineering library
 l Process Steam System Costs.cst - completed cost library for Process Steam System.dat
 l Metric - Process Steam System Pipe Costs.cst - completed cost library for Steel - ANSI

Problem Statement

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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After designing a process steam plant, it is necessary to calculate the system cost to determine the feas-
ibility of the design. Use the cost calculation features to determine the initial cost of the system. Include 
material and installation costs for pipes and fittings. 

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Important: The GSC module and cost calculations can be used in the same run, but we are not going 
to do this here. Before proceeding, make sure to disable GSC by selecting the radio button for 
Ignore in the Modules panel in Analysis Setup.

 Step 2. Define the Pipes and Junctions Group

Open the Metric - Process Steam System.aro example file listed above, which is located in the 
Examples folder in the AFT Arrow application folder. Save the file to a different folder. 

Once the model is opened and saved to a new location, load the Base Scenario. This is the only scenario 
needed for this example, so right-click the Base Scenario and select Delete All Children. The workspace 
should look like Figure 1 below:
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Figure 1: Model layout for Process Steam System Cost example

 Step 3. Define the Cost Settings Group

Open Analysis Setup and go to the Cost Settings panel. Turn on Cost Calculation by selecting the Cal-
culate option at the top.

This example does not have any components for which energy costs can be calculated, so oper-
ational/energy costs will not be included in the Cost Report. For this example,  leave the energy cost 
blank. 

In the Cost Definitions section, select Material and Installation costs. Additionally, because we are only 
accounting for material and installation costs, there is no need to enter a system life period for costing pur-
poses.

The Cost Settings panel should now resemble Figure 2



Process Steam System - Cost

- 113 -

Figure 2: The cost calculations are enabled on the Cost Settings window

 Step 4. Connect the Engineering Library

For detailed information on using the Library Manager, consult the AFT Arrow Help System.

Select Library Manager from the Library menu. Add the Process Steam System.dat engineering library 
file to the list of available libraries by clicking Add Existing Library at the bottom. Browse to the engin-
eering library file in the AFT Arrow Examples folder. The engineering library should now appear in the list 
of available libraries.

Make sure the library is connected to the model - indicated by the check mark next to its name.

The Library Manager should appear as shown in Figure 3.
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Figure 3: The engineering library is connected using the Library Manager

Any pipes and junctions for which costs are to be generated must be associated with an engineering lib-
rary.

The engineering libraries associated with the junctions in this example are the AFT INTERNAL 
LIBRARY, and an external library called Process Steam System. The junctions in the model must be 
associated with one of these two engineering libraries to be able to access the cost data in the cost lib-
raries we will be creating.

The pipes for this example are already using data from the Steel - ANSI pipe material library, so no modi-
fications need to be made for the pipes. 

The Bend and Tee junctions must be modified to use the component data contained in the external engin-
eering library. Do this by opening the Properties window for each junction, and selecting the component 
name displayed in the Library Jct list. Make this change for all of the Bend and Tee junctions.

 Step 5. Create the Cost Libraries

Refer to the AFT Arrow Help System for detailed information regarding creating and using cost libraries.

In order to calculate the material and installation cost for the pipes and fittings, these costs must be 
included. This will be accomplished by creating two new cost libraries. The first library will be associated 
with the engineering library that contains the pipe material data, and the second library will be associated 
with the engineering library that contains the fitting data.
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Create a new cost library for the pipe costs

Create a new cost library for the pipe costs by opening the Cost Library window from the Library menu. 
Create a new cost library by clicking on the New button. When you click on the New button, you are 
prompted to choose the engineering library with which the cost library will be associated. 

The piping material data used in the model comes from the default Steel - ANSI library, so the pipe cost 
library will be connected to this library. Select Steel - ANSI from the library list shown in the Select Library 
window, then click the Select button.

Note: Make this choice carefully, because once you have made the association you cannot change it. 

Once the library is created, you must enter a meaningful description and select the cost units. Enter the 
following data on the General tab:

 1. Cost Type = Monetary
 2. Monetary Unit = U.S. Dollars
 3. Description = Metric - Process Steam System Pipe Costs
 4. Notes = This library is for the Process Steam System Cost example file

Save the cost library to a file by clicking the Save button. Name the library Metric - Process Steam Sys-
tem Pipe Costs.cst. When prompted, choose to add the new library to the list of available and con-
nected libraries. The information on the General tab should appear as shown in Figure 4. The selected 
library file information, cost type and monetary units, a description of the cost library, and any notes you 
have added will be displayed.

Note: The library file pathnames may be different than those shown in Figure 4. 

For this example, you will enter Pipe Material costs for the pipes.
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Figure 4: The Edit Cost Library window is used to enter cost data

Enter the pipe material costs

After the pipe cost library has been created, select the Pipe Materials tab in the Cost Library window. This 
is where you will enter the material and installation costs for the piping. 

The Pipe Materials tab shows all the pipes in the engineering library (Steel - ANSI pipe material library). 
Costs can be entered at several levels. You can enter costs at the material level, the nominal size level, 
and finally at the type (i.e., schedule) level. Costs entered at the material level apply to all nominal sizes 
and types in that material type. Costs entered at the nominal size level apply to all schedules within that 
nominal size. Costs entered at the type (schedule) level apply only to that type. For this example, all of 
the pipe material costs will be entered at the type (schedule) level.

To enter a new cost, navigate to the material, nominal size and type combination for which you want to 
enter a cost. Click the New Cost button to create a new cost item in the table below. The new cost item 
will appear as a new column.

Each pipe size in this example has two non-recurring costs associated with it. The costs to be entered 
are the material and installation costs. Figure 5 shows the costs entered for 8-inch STD (schedule 40) 
Steel.

Switch the sort option to Material, Type or Schedule, Nominal Size before adding the costs and expand 
Steel ANSI and schedule 40to see a list of pipe sizes. Enter the non-recurring pipe costs for the pipe in 
this example, as shown below.
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Cost Type Material (NR) Installation 
(NR)

Size (inches) Cost (U.S. 
Dollars)

Cost (U.S. 
Dollars)

6 28.00 65.50

8 34.50 78.75

12 67.25 169.00

Cost Per Length Length

Cost Per 
Units meters meters

Figure 5: Non-recurring pipe costs, such as material and installation costs, are entered on the Pipe Materials 
tab

When finished, save the cost library and close the Edit Cost Library window.

Create a new cost library for the piping components

To enter cost for a pump, or any other junction type, the junction must first be added to an engineering lib-
rary. Cost data is then entered in a cost library associated with that engineering library. The piping com-
ponents (bends and tees) used in this example have been added to an engineering library. Create a new 
cost library associated with the Process Steam System.dat engineering library with the following gen-
eral information:
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 1. Cost Type = Monetary
 2. Monetary Unit = U.S. Dollars
 3. Description = Process Steam System Costs

Save the cost library to a file by clicking the Save button. Name the library Process Steam System Cost-
s.cst. When prompted, choose to add the new library to the list of available and connected libraries.

Create cost scale tables for the bends

The model contains several 90-degree bend junctions. The cost of these bend fittings can be included in 
the cost calculation. The costs for these items will be accounted for in scale tables. Scale tables can be 
used to vary a cost with a parameter such as diameter (i.e., size). Once created, this scale table can be 
applied to the bend items.

The first table you will create is the scale table for the 90-degree bend installation costs. Select the 
Tables tab, and click the New Table button.

Enter the following data for the scale table on the New Scale Table window:

 1. Name = Installation Table
 2. Table Type = Diameter
 3. Table Format = Cost

The window should appear as shown in Figure 6. After entering the data, click OK.

Figure 6: Scale tables are created using the New Scale Table window

After the table has been created, enter the cost data for the table. Do this by selecting the table name in 
the Table list, then entering the cost values in the table provided. Enter the following installation cost data 
into the scale table:
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Diameter (inches) Cost (U.S. Dollars)

4 85

6 125

8 185.5

12 298

18 446

You do not need to enter data in the scale tables for every diameter in the model. If a diameter falls 
between two data points in the table, AFT Arrow will use the points on either side to linearly interpolate for 
a value. If the cost function is non-linear, you may need to add additional data points to achieve a more 
accurate cost value.

Create another scale table for the material costs using the following data:

Name = Material Table

Table Type = Diameter

Table Format = Cost

Diameter (inches) Cost (U.S. Dollars)

4 30

6 45

8 68

12 151.5

18 262.5

After the scale tables have been created, and the cost data entered, the Tables tab should appear as 
shown in Figure 7.
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Figure 7: The Tables tab on the Cost Library window is used to create cost scale tables

Add the costs for the bends

With the cost scale tables for the bends defined, the costs for the bends can be added. Select the Junc-
tions tab. A list of all of the available junctions is displayed in Junction Components list.

The bends in the model are called Bend for Process Steam System Cost Example. Select this junction 
and add the material cost by clicking the New Cost button, and entering the following data:

 1. Description = Material
 2. Cost Type = Material (NR)
 3. Use Size Table = Table of Costs
 4. Multiplier = 1
 5. Size Scaling Table = Material Table

Now add the installation cost by clicking the New Cost button, and entering the following data:

 1. Description = Installation
 2. Cost Type = Installation (NR)
 3. Use Size Table = Table of Costs
 4. Multiplier = 1
 5. Size Scaling Table = Installation Table
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The actual cost values used for the fittings are the values that were entered in the scale tables on the 
Tables tab. The scale table to use for each cost is specified when the cost is defined. After the cost data 
is entered, the Junctions tab should appear as shown in Figure 8.

Figure 8: The Junctions tab on the Edit Cost Library window is used to specify costs junction items

Add the costs for the tees

Add the material cost for the tees by selecting Tee for Process Steam System Costs and clicking the New 
Cost button, and entering the following data:

 1. Description = Material
 2. Cost Type = Material (NR)
 3. Use Size Table = (None)
 4. Cost (U.S. Dollars) = 150
 5. Cost Per = Item

Now add the installation cost for the tees by clicking the New Cost button, and entering the following 
data:

 1. Description = Installation
 2. Cost Type = Installation (NR)
 3. Use Size Table = (None)
 4. Cost (U.S. Dollars) = 225
 5. Cost Per = Item

Save the cost library and click the Close button.
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Connecting the cost libraries

The cost libraries should have been added to the list of available libraries, and been connected to the 
example model. If they were not, you can use the Library Manager to connect the cost libraries now (see 
Figure 9). Refer to the AFT Arrow Help system for information on how to connect libraries using the 
Library Manager.

Figure 9: The Library Manager is used to connect engineering and cost libraries

 Step 6. Including Items in the Cost Report

The final step before performing a cost analysis is to specify which pipes and junctions you want to be 
included in the final cost report. This is done by choosing Include in Cost Report on the Cost tab in the 
Properties window for each pipe and junction to be included, as shown for Pipe 1 in Figure 10.

The Global Edit feature may be used to update this information for all of the pipes and junctions.

For this example, we want to include the costs for all pipes, bends and tees.
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Figure 10: The Cost tab in the properties window is used to include the objects in the Cost Report

 Step 7. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 8. Examine the Output

The Cost Report is displayed in the General section of the Output window. View the cost report by select-
ing the Cost Report tab. The content of the Cost Report can be controlled from the Output Control win-
dow. Figure 11 shows the Cost Report for this example with the Material, Installation, and Total costs 
displayed.

The Cost Report shows the total system cost, as well as the individual totals for the material and install-
ation costs. In addition, the Cost Report displays the detailed cost for each pipe, junction, and fitting that 
was included in the report. The items are grouped together by type, and a subtotal for each category is lis-
ted.
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Figure 11: The Cost Report in the General Output section shows the results of the cost analysis

Cost analysis summary

The Cost analysis for the Process Steam System shows that the total initial system cost for the process 
steam system is $172,504. Of that cost, $52,203 was for Material costs and $120,301 was for Installation 
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costs
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Module Walk-Through Examples
The examples in the Arrow Module Help System are designed to get new users trained to use the Arrow 
modules correctly in the shortest amount of time. 

If this is your first time using Arrow, please start with the Walk-Through Examples to learn how to create 
and run Arrow models. Start with the Air Heating System, because it provides the most complete, basic 
description on how to set up and run an Arrow model. After this example, it is recommended that you 
work through the remaining Walk-Through examples. 

If you are just learning to work with the Arrow modules, start with the Beginner model for each module, 
then choose an example from the tables on the Module pages that most closely matches your applic-
ation. The examples are arranged in order of increasing complexity. 

Arrow GSC Examples

Arrow ANS Examples

Arrow XTS Examples
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Goal Seek and Control (GSC) Examples
The examples below utilize the Goal Seek and Control module.

Arrow GSC Examples

Example Complexity Fluid Pipes Compressors Description

Beginner -
 Heat Transfer 

in a Pipe
Beginner Air 1 0

Learn the basics of the 
GSC module. See how to 
use Analysis Setup to activ-
ate and enable the GSC 
module and to use the Goal 
Seek and Control group to 
define variables and goals. 
Learn where to find the 
GSC Variables and GSC 
Goals tabs in the Output 
window.

Refinery 
Relief System Beginner Steam 6 0

Learn how to use the GSC 
module to achieve a 
desired mass flow rate by 
varying the CdA of a valve. 

Natural Gas 
Burner Intermediate Methane 16 0

Learn how to create groups 
and use the Group Max/Min 
goal with the GSC module.

Compressed 
Air System Beginner Air 9 1

Learn how to use the GSC 
module to specify multiple 
unique variables and goals 
to achieve a desired sys-
tem configuration. 

Process 
Steam System Intermediate Steam 17 0

Learn how to link GSC vari-
ables together to apply mul-
tiple variables and goals in 
a single simulation.

Beginner - Heat Transfer in a Pipe - GSC 

Summary

The objective of this example is to demonstrate how goals and variables are used in the GSC module to 
achieve an objective. 
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Note: This example can only be run if you have a license for the GSC module. 

Topics Covered

 l Using the Goal Seek and Control group
 l Setting Variables and Goals
 l Understanding Goal Seek and Control Output

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Beginner - Heat Transfer in a Pipe - GSC.aro

Problem Statement

For this example, we will use the GSC module to determine the flow rate required such that air at the out-
let of a 60-meter section of pipe, with heat transfer, reaches a temperature of 38 deg. C. The initial air 
temperature is 150 deg. C at a pressure of 3.5 barG (350 kPa(g)), the ambient temperature is 21 deg. C, 
and the ambient air velocity is 25 km/hr.

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Modules Group

The GSC module is controlled through the Goal Seek and Control group in Analysis Setup. Open Ana-
lysis Setup, and navigate to the Modules panel. Check the box next to Activate GSC. The Use option 

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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should automatically be selected, making GSC enabled for use. Alternatively, GSC can be enabled from 
the Analysis menu by going to the Goal Seek & Control option and selecting Use, as shown in Figure 1.

Figure 1: Select Use from the Goal Seek & Control menu item on the Analysis menu to instruct AFT Arrow to 
perform goal seeking when it runs

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Air

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 2: Model layout for GSC Heat Transfer example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 4 inch
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length = 60 meters

 2. Heat Transfer tab
 a. Heat Transfer Model = Convective Heat Transfer
 b. Temperature = 21 deg. C
 c. Fluid Velocity = 25 km/hr 
 d. Fluid = Air

Junction Properties

 1. J1 Assigned Pressure
 a. Elevation = 0 meters
 b. Fluid = Air
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 c. Pressure = 3.5 barG (350 kPa(g)) 
 d. Temperature = 150 deg. C 
 e. Pressure Specification = Stagnation

 2. J2 Assigned Flow
 a. Elevation = 0 meters
 b. Type = Outflow
 c. Fluid = Air
 d. Flow Rate = 0.9 kg/sec

 Step 5. Define the Goal Seek and Control Group

The GSC module is controlled through the Goal Seek and Control group in Analysis Setup. The Goal 
Seek and Control group has three items: Variables, Goals, and Numerical Controls. Use the Variables 
panel to define the variables, use the Goals panel to define the goals, and use the Numerical Controls 
panel to specify the convergence and calculation methods. The default inputs in the Numerical Controls 
panel will suffice for the vast majority of models using the GSC module.

Variables Panel

In the GSC module, variables are the parameters that Arrow will modify in order to achieve the specified 
goals. In order to help maintain unique answers, there should typically be the same number of goals as 
there are variables. 

Open the Variables panel. The Variables panel allows users to create and modify the system variables. 
The object and junction type are selected. Then, the name and number of the object to which the variable 
applies and the object parameter that is to be varied are specified on the Variables tab. 

Click the New Variable button, and enter the following variable data:

 1. Apply = Selected
 2. Object Type = Junction 
 3. Junction Type = Assigned Flow
 4. Junction Number and Name = J2 (Assigned Flow)
 5. Variable Parameter = Flow 
 6. Link To = (None)
 7. Lower Bound (Optional) = 0

The Apply column allows users to specify which of the variables that have been defined will be used. This 
allows the flexibility of creating multiple variable cases, while only applying selected variables for any 
given run.

The Link To column allows users to apply the same variable to multiple objects. This allows users to force 
parameters for several objects to be varied identically.

Upper and lower bounds provide logical extremes during the goal search. A lower bound of zero outflow 
prevents the solver from treating the Assigned Flow junction as an inflow (i.e. negative outflow).

After entering the data, the Variable tab should appear as shown in Figure 3:
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Figure 3: The Variables panel is used to specify the variables

Goals Panel

Goals are the parameter values set by the user that Arrow adjusts the variables to achieve. Again, there 
should be the same number of system goals as there are system variables. 

Select the Goals panel in Analysis Setup. The Goals panel allows users to create and modify the system 
goals. The goal type, object type, and the goal parameter are selected. A criterion for determining if the 
goal has been met is then specified, along with a value and units for the goal parameter. The user then 
selects the object to which the goal applies, and, if applicable, the location on the object at which the goal 
applies (i.e. the inlet or outlet of a pipe object).

Click the New Goal button, and enter the following goal data:

 1. Apply = Selected
 2. Goal Type = Point 
 3. Object Type = Pipe
 4. Goal Parameter = Temperature Stagnation
 5. Criteria = = 
 6. Goal Value = 38
 7. Goal Units = deg. C
 8. Object ID = P1 (Pipe)
 9. Object Location = Outlet

After entering the data, the Goals tab should appear as shown in Figure 4:
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Figure 4: GSC Manager Goals tab is used to specify the goals

As variables and goals are added to a model, AFT Arrow will display symbols beside the pipes and junc-
tions that have variables or goals applied to them. The default is a V for variables, and a G for goals. The 
goal symbol is not displayed next to objects that are part of a group goal. This is illustrated in Figure 5:

Figure 5: Workspace with Goal and Variable symbols displayed
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 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 7. Examine the Output

The Output window contains all the data that was specified in the Output Control window. Figure 6 shows 
the Output window.

Figure 6: The Output window contains all the data that was specified in the Output Control window

The results of the GSC analysis are shown in the General Output section. The GSC Variables tab 
shows the final value for the variable parameter, as shown in Figure 7. The GSC Goals tab shows the 
final value achieved for the goal, as shown in Figure 8.

Figure 7: GSC Variable Results are displayed in the General section of the Output window
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Figure 8: GSC Goal Results are displayed in the General section of the Output window

The GSC module analysis determined that a mass flow rate of 0.2240 kg/sec results in a pipe outlet tem-
perature of 38.00 deg. C.  In order to achieve the desired temperature, the assigned flow rate was varied 
from the initial value of 0.9 kg/sec, to the final value of 0.2240 kg/sec. In addition to the GSC module tabs 
in the General Output section, the resulting pipe flow and temperature results can be seen in the Pipes 
section of the Output window.
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Refinery Relief System - GSC 

Summary

The objective of this example is to demonstrate how goals and variables are used in the GSC module to 
achieve an objective. 

Note: This example can only be run if you have a license for the GSC module. 

Topics Covered

 l Defining the Goal Seek and Control group
 l Setting Variables and Goals
 l Understanding Goal Seek and Control output

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Refinery Relief System.aro
 l Metric - Refinery Relief System - GSC.aro

Problem Statement

For this example, we will use the GSC module to determine the relief valve CdA value required such that 
the capacity of a steam relief system is a minimum of 13 kg/sec. 

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Refinery Relief System.aro example file listed above, which is located in the 
Examples folder in the AFT Arrow application folder. Save the file to a different folder. This is the only 
scenario needed for this example, so right-click the Base Scenario and select Delete All Children. The 
workspace should look like Figure 1

Figure 1: Model layout for GSC Refinery Relief System example

 Step 2. Define the Fluid Properties Group

 1. Navigate to the Fluid panel in Analysis Setup
 2. Define the Fluid panel with the following inputs

 a. Fluid Library = AFT Standard
 b. Fluid = Steam

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library

When applying these fluid settings, a message will appear asking whether you wish to discard the exist-
ing fluids from the NIST REFPROP library. Click Yes to continue.

 Step 3. Define the Pipes and Junctions Group

All pipes and junctions should already be defined. However, a few changes need to be made to adapt the 
model to this example. Make the following changes:
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Junction Properties

 1. J1 Tank 
 a. Name = Steam Process 1
 b. Fluid = Steam
 c. Temperature = 205 deg. C

 2. J2 Tank
 a. Name = Steam Process 2
 b. Fluid = Steam
 c. Temperature = 205 deg. C

 3. J3 Tank
 a. Name = Steam Process 3
 b. Fluid = Steam
 c. Temperature = 205 deg. C

 Step 4. Define the Modules Group

Navigate to the Modules panel in Analysis Setup. Check the box next to Activate GSC. The Use option 
should automatically be selected, making GSC enabled for use.

 Step 5. Define the Goal Seek and Control Group

Specify the variables and goals for the model using the Goal Seek and Control group in Analysis Setup.

Variables Panel

Open the Variables panel, click New Variable, and enter the following variable data:

 1. Apply = Selected
 2. Object Type = Junction 
 3. Junction Type = Valve
 4. Junction Number and Name = J7 (Relief Valve)
 5. Variable Parameter = CdA
 6. Link To = (None)
 7. Lower Bound (Optional) = 0
 8. Upper Bound (Optional) = 180

Note: The units used for the Lower and Upper Bound are the same as what is specified in the junction 
properties window: cm2 in this case.
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Goals Panel

Open the Goals panel, click New Goal, and enter the following goal data:

 1. Apply = Selected
 2. Goal Type = Point 
 3. Object Type = Pipe
 4. Goal Parameter = Mass Flow Rate
 5. Criteria = = 
 6. Goal Value = 13
 7. Goal Units = kg/sec
 8. Object ID = P6 (Pipe)
 9. Object Location = NA

 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 7. Examine the Output

The results of the GSC analysis are shown in the General section of the Output window. The GSC Vari-
ables tab shows the final value for the variable parameter, as shown in Figure 2. The GSC Goals tab 
shows the final value achieved for the goal, as shown in Figure 3.

The GSC module analysis determined that a relief valve CdA value of 142.9 cm2  will result in a relief 
capacity of 13.00 kg/sec.

Figure 2: GSC Variable results are displayed in the General section of the Output window            

Figure 3: GSC Goal results are displayed in the General section of the Output window



- 141 -

Natural Gas Burner - GSC 

Summary

The objective of this example is to demonstrate how multiple goals and variables are used in the GSC 
module to achieve an objective. 

Note: This example can only be run if you have a license for the GSC module. 

Topics Covered

 l Defining the Goal Seek and Control group
 l Setting Variables and Goals
 l Using Group Max/Min Goals
 l Understanding Goal Seek and Control output

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Natural Gas Burner.aro
 l Metric - Natural Gas Burner - GSC.aro

Problem Statement

An underground storage reservoir containing natural gas made up mostly of methane supplies gas to five 
burners. The gas is at 34.5 barG (3450 kPa(g)), and 10 deg. C. The gas is supplied to each of the burners 
at 6.9 barG (690 kPa(g)). To assure that the flow to each of the burners is equal, each burner has a con-
trol valve that controls the flow to 2.25 kg/sec. The pipes in the system are uninsulated STD (schedule 
40) Steel - ANSI, with standard roughness. The ambient temperature surrounding the pipes is 24 deg. C, 
and the pipes have an ambient air velocity of 25 km/hr.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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In order to operate at the best efficiency, the gas should be delivered to the burners at a minimum stag-
nation temperature of 38 deg. C. In order to achieve this, the gas flows through a heat exchanger, which 
has a 0.70 bar (70 kPa) pressure drop at 11 kg/sec. 

How much heat must be added to the heat exchanger to ensure that all of the burners will receive gas at 
the specified minimum temperature? (Neglect elevation changes)

Use GSC to size the heat exchanger.

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Natural Gas Burner.aro example file listed above, which is located in the Examples 
folder in the AFT Arrow application folder. Save the file to a different folder. This is the only scenario 
needed for this example, so right-click the Base Scenario and select Delete All Children. The workspace 
should look like Figure 1

Figure 1: Model layout for GSC Natural Gas Burner example

 Step 2. Define the Steady Solution Control Group 

There is an option available in Solution Control when using one of the marching methods that can some-
times result in an overall reduction in solution runtime. This option is to first solve the system using the 
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Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since 
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduc-
tion in runtime for the marching method.

The Steady Solution Control Group is already defined using the default inputs. This means that no user 
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this 
model. 

To activate this option, do the following:

 1. Open Analysis Setup
 2. Navigate to the Solution Method panel in the Steady Solution Control group
 3. Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For 

Marching Solution

The Steady Solution Control Group is now defined for this model.

 Step 3. Create a Group

In order to use the Group Max/Min goal type, the junctions or pipes included in the goal must be added to 
a group. To create a group, select the pipes and/or junctions for the desired group, then select the 
Groups | Create option from the Edit menu.  In this case, only the pipes that are directly connected to the 
burners will be selected (i.e., Pipes P12-P16).

When prompted, give the new group the name Burner Discharge Pipes, and click OK. After naming the 
new group, the Group Manager will be displayed. Select the new group name from the list, and confirm 
all of the burner discharge pipes from the pipe list are selected, as shown in Figure 2. Click OK to return 
to the Workspace.



Natural Gas Burner - GSC

- 144 -

Figure 2: Groups are displayed in the Group Manager window

 Step 4. Define the Modules Group

Navigate to the Modules panel in Analysis Setup. Check the box next to Activate GSC. The Use option 
should automatically be selected, making GSC enabled for use.

 Step 5. Define the Goal Seek and Control Group

Specify the variables and goals for the model using the Goal Seek and Control group in Analysis Setup.

Variables Panel

Open the Variables panel, click New Variable, and enter the following variable data (Figure 3):

 1. Apply = Selected
 2. Object Type = Junction 
 3. Junction Type = Heat Exchanger
 4. Junction Number and Name = J2 (Heat Exchanger)
 5. Variable Parameter = Heat Rate
 6. Link To = (None)
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 7. Lower Bound (Optional) = 0
 8. Upper Bound (Optional) = 2000

Note: The units used for the Lower and Upper Bound are the same as what is specified in the junction 
properties window: kW in this case.

Figure 3: Variables are set on the Variables panel in Analysis Setup

Goals Panel

For this example, we will be using a Group Max/Min goal. This type of goal allows a single goal to be 
applied to a group of objects. Arrow applies a Group Max/Min goal by ensuring the final goal value is 
either greater than or equal to (Min) or less then or equal to (Max) the specified value. For our example, a 
Group Max/Min goal will be applied to ensure the minimum gas discharge temperature out of all of the 
burner discharge pipes is at least 38 deg. C.

Open the Goals panel, click New Goal, and enter the following goal data:

 1. Apply = Selected
 2. Goal Type = Group 
 3. Object Type = Group Max/Min
 4. Goal Parameter = Temperature Stagnation
 5. Criteria = >=
 6. Goal Value = 38
 7. Goal Units = deg. C
 8. Object ID = Burner Discharge Pipes
 9. Object Location = Outlet
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 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 7. Examine the Output

The results of the GSC analysis are shown in the General section of the Output window. The GSC Vari-
ables tab shows the final value for the variable parameter, as shown in Figure 4. The GSC Goals tab 
shows the final value achieved for the goal, as shown in Figure 5.

The GSC module analysis determined the required heat rate to ensure a minimum gas delivery tem-
perature of 38 deg. C is 1052 kW. This is the same result that was obtained in the Natural Gas Burner 
example where the iterations to determine the heat rate were performed manually.

Figure 4: GSC Variable Results are displayed in the General section of the Output window

Figure 5: GSC Goal Results are displayed in the General section of the Output window
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Compressed Air System - GSC 

Summary

The objective of this example is to demonstrate how multiple goals and variables are used in the GSC 
module to achieve an objective. 

Note: This example can only be run if you have a license for the GSC module. 

Topics Covered

 l Defining the Goal Seek and Control group
 l Setting Variables and Goals
 l Applying multiple Variables and Goals
 l Interpreting Goal Seek and Control Output

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Compressed Air System.aro
 l Metric - Compressed Air System - GSC.aro

Problem Statement

For this example, we will use the GSC module to determine the valve K-factors required to achieve a spe-
cified flow of 55 gram/sec to all four tools.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series


Compressed Air System - GSC

- 148 -

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Compressed Air System.aro example file listed above, which is located in the 
Examples folder in the AFT Arrow application folder. Save the file to a different folder. This is the only 
scenario needed for this example, so right-click the Base Scenario and select Delete All Children. The 
workspace should look like Figure 1

Figure 1: Model Layout for GSC Compressed Air System Example

 Step 2. Define the Steady Solution Control Group 

There is an option available in Solution Control when using one of the marching methods that can some-
times result in an overall reduction in solution runtime. This option is to first solve the system using the 
Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since 
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduc-
tion in runtime for the marching method.

The Steady Solution Control Group is already defined using the default inputs. This means that no user 
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this 
model. 

To activate this option, do the following:

 1. Open Analysis Setup
 2. Navigate to the Solution Method panel in the Steady Solution Control group
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 3. Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For 
Marching Solution

The Steady Solution Control Group is now defined for this model.

 Step 3. Define the Pipes and Junctions Group

Make the following changes to these junctions:

 1. J7-J10 Valves
 1. Loss Model = K Factor
 2. K = 10

 Step 4. Define the Modules Group

Navigate to the Modules panel in Analysis Setup. Check the box next to Activate GSC. The Use option 
should automatically be selected, making GSC enabled for use.

 Step 5. Define the Goal Seek and Control Group

Specify the variables and goals for the model using the Goal Seek and Control group in Analysis Setup.

Variables Panel

Open the Variables panel, click New Variable, and enter the following variable data:

 1. J7 Valve (Tool #1)
 a. Apply = Selected
 b. Object Type = Junction 
 c. Junction Type = Valve
 d. Object Number and Name = J7 (Tool #1)
 e. Variable Parameter = Loss Value 
 f. Link To = (None)

 g. Lower Bound = 0
 h. Upper Bound = Leave blank

 2. J8 Valve (Tool #2)
 a. Apply = Selected
 b. Object Type = Junction 
 c. Junction Type = Valve
 d. Object Number and Name = J8 (Tool #2)
 e. Variable Parameter = Loss Value 
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 f. Link To = (None)
 g. Lower Bound = 0
 h. Upper Bound = Leave blank

 3. J9 Valve (Tool #3)
 a. Apply = Selected
 b. Object Type = Junction 
 c. Junction Type = Valve
 d. Object Number and Name = J9 (Tool #3)
 e. Variable Parameter = Loss Value 
 f. Link To = (None)

 g. Lower Bound = 0
 h. Upper Bound = Leave blank

 4. J10 Valve (Tool #4)
 a. Apply = Selected
 b. Object Type = Junction 
 c. Junction Type = Valve
 d. Object Number and Name = J10 (Tool #4)
 e. Variable Parameter = Loss Value 
 f. Link To = (None)

 g. Lower Bound = 0
 h. Upper Bound = Leave blank

After entering the data, the Variables tab should appear as shown in Figure 2.

Figure 2: Goal Seek and Control group, Variables panel is used to specify the variables

Goals Panel

Open the Goals panel, click New Goal, and enter the following goal data:
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 1. Pipe P6
 a. Apply = Selected
 b. Goal Type = Point
 c. Object Type = Pipe
 d. Goal Parameter = Mass Flow Rate
 e. Criteria = =
 f. Goal Value = 55

 g. Goal Units = gram/sec
 h. Object ID = P6 (Pipe)
 i. Object Location = NA

 2. Pipe P7
 a. Apply = Selected
 b. Goal Type = Point
 c. Object Type = Pipe
 d. Goal Parameter = Mass Flow Rate
 e. Criteria = =
 f. Goal Value = 55

 g. Goal Units = gram/sec
 h. Object ID = P7 (Pipe)
 i. Object Location = NA

 3. Pipe P8 
 a. Apply = Selected
 b. Goal Type = Point
 c. Object Type = Pipe
 d. Goal Parameter = Mass Flow Rate
 e. Criteria = =
 f. Goal Value = 55

 g. Goal Units = gram/sec
 h. Object ID = P8 (Pipe)
 i. Object Location = NA

 4. Pipe P9
 a. Apply = Selected
 b. Goal Type = Point
 c. Object Type = Pipe
 d. Goal Parameter = Mass Flow Rate
 e. Criteria = =
 f. Goal Value = 55

 g. Goal Units = gram/sec
 h. Object ID = P9 (Pipe)
 i. Object Location = NA

After entering the data, the Goals tab should appear as shown in Figure 3. 
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Figure 3:                      Use the Goals panel is used to specify the goals

 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 7. Examine the Output

The results of the GSC analysis are shown in the General Output section. The GSC Variables tab 
shows the final value for the variable parameter, as shown in Figure 4. The GSC Goals tab shows the 
final value achieved for the goal, as shown in Figure 5.

The GSC module analysis determined the following valve K-factors would result in the desired flow of 55 
gram/sec to each valve:

Object Value

J7 (Tool #1) 13.98

J8 (Tool #2) 11.48

J9 (Tool #3) 10.39

J10 (Tool #4) 10.08
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Figure 4: GSC Variable Results are displayed in the General section of the Output window

Figure 5:       GSC Goal Results are displayed in the General section of the Output window
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Process Steam System - GSC 

Summary

The objective of this example is to demonstrate how multiple goals and variables are used in the GSC 
module to achieve an objective. 

Note: This example can only be run if you have a license for the GSC module.

Topics Covered

 l Defining the Goal Seek and Control group
 l Setting Variables and Goals
 l Using Group Max/Min Goals
 l Linking Variables
 l Interpreting Goal Seek and Control output

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Process Steam System.aro
 l Metric - Process Steam System - GSC.aro

Problem Statement

For this example, we will use the GSC module to determine the supply pressure necessary to meet a 
minimum delivery pressure of 7 barG (700 kPa(g)) at each discharge location for the specified flows.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Process Steam System.aro example file listed above, which is located in the 
Examples folder in the AFT Arrow application folder. Save the file to a different folder. This is the only 
scenario needed for this example, so right-click the Base Scenario and select Delete All Children. The 
workspace should look like Figure 1:

Figure 1: Model layout for GSC Process Steam System example

 Step 2. Create a Group

In order to use the Group Max/Min goal type, the junctions or pipes included in the goal must be added to 
a group. To create a group, select the Groups | Create option from the Edit menu. When prompted, give 
the new group the name Users and click OK. After naming the new group, the Group Manager will be dis-
played. Select the new group name from the list, and then select all of the assigned flow junctions from 
the junction list, as shown in Figure 2. After choosing the assigned flow junctions, click OK on the Group 
Manager window.
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Figure 2: Groups are created using the Group Manager window

 Step 3. Define the Modules Group

Navigate to the Modules panel in Analysis Setup. Check the box next to Activate GSC. The Use option 
should automatically be selected, making GSC enabled for use.

 Step 4. Define the Goal Seek and Control Group

Specify the variables and goals for the model using the Goal Seek and Control group in Analysis Setup.

Variables Panel

For this example, we want to find the supply pressures that will give us a specific minimum discharge 
pressure. We will define the delivery pressures as a single Group Max/Min goal. But that gives us only 
one goal for two variables. To solve this issue, we will use variable linking. Variable linking allows you to 
tie multiple variables together, forcing them to be the same. To accomplish this, we will add a constraint 
to the problem that both of the boiler supply pressures must be the same. 

To implement variable linking, add both tank junctions pressures as variables. Then link them together by 
specifying Boiler 1 (J1) in the Link To column of the Boiler 2 (J2) variable. Enter the data as shown below. 

Open the Variables panel, click New Variable, and enter the following variable data:
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 1. J1 (Boiler 1)
 a. Apply = Selected
 b. Object Type = Junction 
 c. Junction Type = Tank
 d. Junction Number and Name = J1 (Boiler 1)
 e. Variable Parameter = Pressure 
 f. Link To: (None)

 g. Lower Bound: Leave blank
 h. Upper Bound: Leave blank

 2. J2 (Boiler 2)
 a. Apply = Selected
 b. Object Type = Junction 
 c. Junction Type = Tank
 d. Junction Number and Name = J2 (Boiler 2)
 e. Variable Parameter = Pressure 
 f. Link To = J1 (Boiler 1)

 g. Lower Bound: Leave blank
 h. Upper Bound: Leave blank

After entering the variable data, the Variables tab in the Goal Seek and Control manager should appear 
as shown in Figure 3.

Figure 3: Variable solutions can be linked together using the Link To option

Goals Panel

For this example, we will be using a Group Max/Min goal. This type of goal allows a single goal to be 
applied to a group of objects. Arrow applies a Group Max/Min goal by ensuring the final goal value is 
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either greater than or equal to (Min) or less then or equal to (Max) the specified value. For our example, a 
Group Max/Min goal will be applied to ensure the minimum discharge pressure at all of the assigned flow 
junctions is at least 7 barG (700 kPa(g)).

Open the Goals panel, click New Goal, and enter the following goal data:

 1. Apply = Selected
 2. Goal Type = Group
 3. Object Type = Group Max/Min
 4. Goal Parameter = Pressure Stagnation
 5. Criteria = >=
 6. Goal Value = 7
 7. Goal Units = barG
 8. Object ID = Users
 9. Object Location = NA

As variables and goals are added to a model, AFT Arrow will display symbols beside the pipes and junc-
tions that have variables or goals applied to them. The default is a V for variables, and a G for goals. The 
goal symbol is not displayed next to objects that are part of a group goal, so you will see only the V dis-
played on the Workspace for this example.

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 6. Examine the Output

The results of the GSC analysis are shown in the General section of the Output window. The GSC Vari-
ables tab shows the final value for the variable parameter, as shown in Figure 4. The GSC Goals tab 
shows the final value achieved for the goal, as shown in Figure 5.

The GSC module analysis determined the supply pressure required to ensure a minimum delivery pres-
sure of 7 barG (700 kPa(g)) at the users is 20.02 barG (2002 kPa(g)). 

Figure 4: GSC Variable Results are displayed in the General section of the Output window
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Figure 5: GSC Goal Results are displayed in the General section of the Output window             
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Automatic Network Sizing (ANS) Examples
The examples below utilize the Automated Network Sizing module.

Arrow ANS  Examples

Example Complexity Fluid Pipes Compressors Description

Beginner - 
Three Tank 
Steam Sys-

tem

Beginner Steam 3 0

Learn the basics of the ANS 
module such as defining all 
panels in the Sizing window 
to achieve a minimum pipe 
weight objective

Control Valve Beginner Steam 2 0

Learn how to use the ANS 
module and how Common 
Size Groups work to min-
imize the pipe weight of a 
system.

Air Dis-
tribution - 
Libraries

Intermediate Air 18 1

Learn how to build cost lib-
raries and engineering lib-
raries for use with the ANS 
module. See how to use 
Scale Tables for defining 
compressor costs, how to 
specify material versus 
installation costs, and how to 
define costs for pipes. 

Air Dis-
tribution Intermediate Air 18 1

Learn how to use the ANS 
module to minimize mon-
etary cost based on initial 
cost and recurring costs. 
See how to use the Assign 
Cost Libraries panel and the 
Sizing Summary panel. 
Explore how the system life 
and the sizing objective 
impacts the optimal pipe 
sizes.

Air Dis-
tribution - 
Multiple 
Design 
Cases

Intermediate Air 18 1

Learn how to use the ANS 
module to minimize mon-
etary cost using a Depend-
ent Design Case.

Helium Trans- Beginner Helium 3 0 Learn how to use the ANS 
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Example Complexity Fluid Pipes Compressors Description

fer

module to minimize the pipe 
weight of a system based on 
a dependent design con-
figuration, called a Depend-
ent Design Case.

Natural Gas 
Burner Intermediate Methane 16 0

Learn how to use the ANS 
module to minimize the mon-
etary cost using a Depend-
ent Design Case then 
comparing the results to the 
same system but with an 
objective to minimize pipe 
weight.

Process 
Steam Sys-

tem
Intermediate Steam 17 0

Learn how to use the ANS 
module and how the Search 
Method impacts results

Beginner - Three Tank Steam System - ANS 

Summary

The objective of this example is to familiarize the user with the components of the ANS module. We will 
apply automated sizing to determine the ideal pipe sizes from our previously built three-reservoir model 
to reduce costs while meeting certain requirements.

Note: This example can only be run if you have a license for the ANS module. 

Topics Covered

 l Minimizing the pipe weight to minimize cost
 l Defining Pipe Design Requirements
 l Choosing Candidate Sets

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Three Tank System - ANS - Initial.aro
 l Metric - Three Tank System - ANS - Final.aro

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Three Tank System - ANS Initial.aro example file listed above, which is located in 
the Examples folder in the AFT Arrow application folder. Save the file to a different folder. The workspace 
should look like Figure 1:

Figure 1: Layout of Three Tank System model in Workspace

 Step 2. Define the Modules Group

The ANS module is controlled through the Sizing window which is activated and enabled through Ana-
lysis Setup. Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate 
ANS. The Network option should automatically be selected, making ANS enabled for use. Alternatively, 
ANS can be enabled from the Analysis menu by going to the Automated Sizing option and selecting Net-
work, as shown in Figure 2.
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Figure 2: Activating Network Sizing from the Analysis menu

 Step 3. Define the Automatic Sizing Group

Here we will pursue a brief introduction to some of the sizing capabilities in the ANS module. A more 
complete discussion is given in the AFT Arrow Help file. 

The Sizing window is comprised of multiple panels which can be accessed using the buttons on the Siz-
ing Navigation Panel along the bottom of the window, as shown in Figure 3. The sizing panels can be 
accessed in any order, though it is easiest to enter the information by navigating the panels from left to 
right, since the input on panels such as the Sizing Objective and Sizing Assignments panels will affect 
the options available on later panels. Depending on the type of sizing being done, some panels may be 
disabled or unused.

Similar to Analysis Setup, each panel button contains either a green checkmark or red circle which 
denotes the completion status of that panel. If the minimum required information is present to run the 
model, the symbol will be green, whereas the red symbol represents incomplete input. The amount of 
information required will vary based on whether the Sizing Level Status is set to Perform Sizing, Cal-
culate Costs, or Do Not Size. A detailed summary of the items which have been completed and the items 
which are still incomplete can be seen in the Sizing Status panel, opened from the Sizing Toolbar.

Note that some panels will always be shown as complete since the model can be run without any addi-
tional information entered on them, such as with the Design Requirements panel. However, in order to 
find the best system design it will often be necessary to enter more than the minimum information 
required by the solver.

The Lock Panel toggle located on the Sizing Toolbar prevents changes to the current panel when it is 
enabled. This is primarily useful to prevent editing once a scenario has been run, since any changes that 
are made to a scenario which has output will cause all output to be erased. By default, the ANS module 
will lock all panels after a sizing run is completed, requiring panels to be unlocked before any changes 
can be made. This setting can be changed on the Sizing Objective panel. All panels can be locked or 
unlocked simultaneously by using the Lock/Unlock All Panels buttons on the Sizing Toolbar. This setting 
can be changed on the Sizing Objective panel, as can be seen in Figure 3.
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Figure 3: Sizing Window showing common sizing panel features

A. Sizing Objective

The Sizing Objective panel is used to set the type of calculation that will be performed, and to select an 
Objective which will be used in the sizing process.

For the Sizing Option, Perform Sizing should generally be selected, since this is the primary function of 
the ANS module. However, the other two options may be used for troubleshooting or informational pur-
poses. For example, the Calculate Cost, Do Not Size option may be useful to calculate an initial cost for 
the system, or to verify your cost libraries. The Do Not Size option allows the model to be run normally in 
AFT Arrow without requiring any cost or sizing information. This is useful to preserve the information 
already entered in the Sizing window while running the model normally.

ØSelect Perform Sizing to begin configuring the sizing settings.

Note: The Sizing Level Status, which shows the type of calculation being performed, can always be 
seen on the box on the left of the Sizing Navigation panel. Clicking this box will bring you to the 
Sizing Objective panel, where this status can be changed.

The next step is to set a Sizing Objective, which can be monetary cost, or a non-monetary cost such as 
pipe weight or flow volume. It is easier to perform a non-monetary sizing, since all of the geometry and 
material information necessary to calculate the pipe weight/volume is already contained in the pipe mater-
ial libraries. A monetary cost objective would require cost information to be obtained and entered into 
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cost libraries.  For many systems, sizing the system using one of the simpler non-monetary objective 
options provides a sufficient approximation for minimized cost. In this case, we will be performing a min-
imization for pipe weight.

ØFor the Objective, choose Pipe Weight, and select the Minimize option from the drop-down list if not 
already selected, as shown in Figure 3 above.

The other option available in the Sizing Objective panel is to configure the Sizing Lock Options as men-
tioned previously. This option will be left as the default.

B. Sizing Assignments

On the Sizing Navigation panel at the bottom of the window select the Sizing Assignments button. The 
Sizing Assignments panel allows the user to define what objects will be sized in the model, and what will 
be included in the cost calculation without being sized. Common Size Groups for pipes, or Maximum 
Cost Groups for compressors/control valves can be created on this panel as well when appropriate.

Let's consider the Sizing Assignments for the pipes, which should be displayed by default when we open 
this panel. In this case since the Sizing Objective is Pipe Weight we will discuss all costs in terms of 
weight.

In the Sizing and Weight Options table there are several options under the categories to Automatically 
Size, or Do Not Size the pipe.

If an Automatically Size option is selected, the ANS module will treat the pipe diameter as a variable and 
vary it according to certain criteria that will be discussed shortly. 

For a new system, typically all pipes will be desired to be sized and included in the weight calculation by 
choosing Always Include in Weight. If you are instead analyzing the possible replacement of existing 
pipes, it may be better to size the pipes, but only include the weight if the size changes from that which 
exists by choosing Include in Weight if Size Changes.

If Do not Size is selected, the pipe will retain the settings currently set in the Workspace. Why would one 
choose to not size a pipe? There could be a number of reasons, but one good reason is that the pipe rep-
resents a pipe in an existing system and the design does not allow the replacement of that pipe with a 
new one. Therefore its diameter is fixed, and sizing the pipe would be unrealistic.

Another reason may be if a certain size is necessary for the design due to certain requirements, in which 
case the pipe weight can be included without sizing the pipe by choosing Include in Weight.

This model is a new system, so all pipes will be sized and included in the weight calculation.

ØSelect Always Include in Weight under Automatically Size for all three pipes (Figure 4).

Since we want to size the pipes independently in this model, we do not need to make any changes to the 
Pipe Grouping section of the table, so this panel is complete.
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Note: For models which have junctions that can be sized, a Junctions button at the top of this panel 
will be available to set the Junctions Sizing Assignments. In this case we have chosen to ana-
lyze pipe weight. While this value can easily be calculated for the pipes, Arrow does not have 
enough information to calculate a weight for the branch or the reservoirs, which means that they 
cannot be sized using this method, and the Junctions tab is unavailable. This same limitation 
exists when using other non-monetary objectives as well, such as flow volume. If the size of a 
junction will have a large impact on the system cost, such as a compressor, Monetary Cost 
should be used as the Objective.

Figure 4: Sizing Assignments panel for Three Tank model

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.

Since commercial piping is limited to certain sizes, the ANS module needs a list of possible sizes from 
which to choose. This list is called a Candidate Set.

So as not to limit the sizing unnecessarily, the candidate sets should include both smaller and larger 
pipes than your anticipated final size. If you make the candidate set too small, you may limit the ability of 
the ANS module to find the best sizing. It is better to make the candidate set too large than too small. 
Experience applying the ANS module to actual systems will help you choose appropriate candidate sets. 
If after obtaining a solution you find that one or more of the sized pipes is at the extreme of the candidate 
set, a warning will appear, and it is recommended to expand the defined candidate set.

To create a Candidate Set, do the following:

 1. Under Define Candidate Sets, click New.
 2. Give the set the name STD Steel and click OK.
 3. From the drop down list choose Steel - ANSI.
 4. In the bottom of the Select Pipe Sizes window, click the Sort option Type, Schedule, Class if it is 

not already selected.
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 5. In the Available Material Sizes and Types list on the left, select STD so that the schedule name is 
now highlighted.

 6. Click the Add button to add all STD pipe sizes to the list on the right (Figure 5).
 7. In the Select Pipe Sizes window, click the OK button.

The STD Steel set will now appear in the Define Candidate Sets section.

We will apply the STD Steel set shortly. First, let’s take a moment to understand what we have just done. 
We have created a Candidate Set that includes all pipe sizes in the library that are STD Steel - ANSI. At 
the low end this includes 1/8th inch pipe, and at the high end 48 inch pipe. This Candidate Set contains 
pipe sizes from a library of Steel-ANSI pipe, and not just specific pipes from the model. After we apply 
this candidate set to a specific pipe in the model and the  sizing is run, the ANS module will select the 
best pipe size from this set of pipe sizes to achieve the objective.

We now need to define which pipes will use this Candidate Set during the sizing calculation. Each pipe 
that is being sized must have a Candidate Set assigned to it. Under Assign Candidate Sets to Pipes, set 
each pipe in the model to use STD Steel by selecting the radio button under this Candidate Set for each 
of the pipes. The Candidate Sets should now be fully defined and assigned to the appropriate pipes, as 
can be seen in Figure 6.

Figure 5: Select Pipe Sizes window for defining a new Candidate Set
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Figure 6: Candidate Sets window fully defined for the Three Tank model

D. Design Requirements

Select the Design Requirements button. If we do not define any design requirements for this model, the 
ANS module will choose the smallest pipe size in the Candidate Set, since it has the smallest pipe 
weight. Along with the smallest pipes we may get unacceptably low flowrates, or unacceptably high velo-
cities and pressure drops. To maintain acceptable system operating conditions, we need to set Design 
Requirements. 

We are going to define one Design Requirement for this case. Before adding any requirements, let’s look 
more closely at the results of the model we are starting with. Pipe 1 is 14 inch, and the other two are 12 
inch. The results show that the steam flows from tank J1 to tanks J2 and J3. The mass flow rate out of J1 
is 68.30 kg/sec, and the mass flow rates to J2 and J3 are  21.82 and 46.49 kg/sec, respectively. Let's 
assume that there is a requirement to deliver at least 13 kg/sec each to J2 and J3.



Automatic Network Sizing (ANS) Examples

- 169 -

We need to create a Design Requirement that represents the flow requirement. To do this:

 1. Make sure that the Pipes button is selected.
 2. Click New under Define Design Requirements.
 3. Enter the name Min Flow.
 4. A new row will appear in the Pipe Design Requirements table. In this row, select Mass Flow Rate 

as the Parameter.
 5. Choose Minimum for Max/Min, and enter 13 kg/sec

We now need to apply this Design Requirement to the pipes. In the Assign Design Requirements to 
Pipes section select the check box for Min Flow next to pipes P2 and P3. This will set the minimum flow 
rate going into Tanks J2 and J3 as described above. The fully defined and assigned Design Require-
ments are shown in Figure 7.

Figure 7: Design Requirements window with the minimum flow requirements defined

E. Assign Cost Libraries

When the Sizing Objective has been defined as Monetary Cost, it is necessary to create and assign cost 
libraries for the automated sizing, which can be done in the Assign Cost Library panel. Since we have 
defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is 
grayed out.
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F. Sizing Method

Select the Sizing Method button to go to the Sizing Method Panel.

The Sizing Method Panel is used to set up the calculation methods for sizing the system. The User has 
the option to select whether discrete or continuous sizing will be used, and which method will be applied.

If Continuous Sizing is selected, the ANS module will use the maximum and minimum pipe sizes from 
the Candidate Sets as bounds, and report the ideal hydraulic diameter for the pipes between those 
bounds. This would result in pipe sizes which  would not match any of the possible chosen commercial 
sizes. While this is not useful as a final solution, this can be helpful as a baseline to check the final dis-
crete sizing solution. Discrete Sizing will typically perform a continuous sizing calculation as a basis, after 
which multiple discrete sizes above and below this solution will be evaluated to find the ideal sizing based 
on the provided Candidate Set.

ØFor this model, select Discrete Sizing if it is not already selected.

For the Search Method, the ideal method will often change based on the number of independent pipe 
sizes (shown in the Sizing Assignments panel on the bottom right), number of Design Requirements, and 
feasibility of the initial system design. The Help file provides more information on the strengths and weak-
nesses of each method. It is generally recommended to run the sizing with more than one method, as it is 
often not obvious which method will be most effective for each system. The Suggest Best Method button 
can be used as a guide for which method to start with.

For a simple model such as this one, the MMFD or SQP method should be appropriate since there are 
only two Design Requirements (the minimum flow at the two delivery pipes), and only three pipe sizes 
are being varied.

ØChoose the default Modified Method of Feasible Directions (MMFD) (Figure 8).



Automatic Network Sizing (ANS) Examples

- 171 -

Figure 8: Sizing Method panel defined for Three Tank model

 Step 4. Run the Model

Select Run from the Toolbar or Analysis menu. While the model is running, the Solution Progress window 
shows the Sizing Calls to Solver. This is how many times a complete hydraulic analysis was run.

The solver also displays the Current Cost and Best Feasible Cost, which will display the last calculated 
value for the cost, as well as the Best Feasible Cost which has been found so far (Figure 9). The solver 
will continue to iterate using the defined method until it finds the ideal sizing. For the selected method, the 
solver will first perform a continuous sizing to find a starting point, then test discrete solutions close to this 
continuous solution to find the final, discrete solution.
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Figure 9: Solution Progress Window showing the progress of the sizing calculation

 Step 5. Examine the Output

Click the View Output button to see the results. The General section shows the Cost Report, which indic-
ates the volumes for the final solution. As shown in Figure 10, the minimum total pipe weight identified by 
the ANS module was 16,583 kg. In the Pipes section of the output on the Sizing tab, the final pipe sizes 
of  12, 8, and 6 inches are shown (Figure 10). 

Now switch to the Pipe Design Requirements tab in the Pipe section (Figure 11). We can confirm that the 
calculated design is feasible, since all of the Design Requirements were met. That is, the mass flow from 
J1 (as shown in pipe P1) was 33.70 kg/sec, and the flows to J2 and J3 were20.16 and 13.55 kg/sec 
respectively. Notice that some of the Design Requirements are highlighted, indicating that they were act-
ive. An active design requirement is defined as a requirement that had an impact on the solution. If an act-
ive design requirement were disabled,  a different solution would be found. Yellow highlights indicate that 
the design requirement was active in the final solution, while blue highlights indicate that the requirement 
was active when the continuous sizing was performed, but the difference between the discrete and con-
tinuous solutions was outside of a pre-defined tolerance.

You can also display the adjusted pipe sizes and resulting flow rates in the Visual Report. Options are 
available in the Visual Report Control which would allow the user to compare parameters such as the 
final pipe sizes to the original pipe sizes.
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Figure 10: Output window with Cost Report and Pipe Sizes for Three Tank Model

Figure 11: Design Requirements results for Three Tank Model

Transferring Sized Results

When performing sizing, the Transfer Results to Initial Guesses feature on the Output window Edit menu 
takes on new meaning. When used in a non-sizing context, this feature takes the solved hydraulic results 
(i.e., pressures, flows rates, etc.) and assigns them to the initial guess values for the pipes and junctions.

When you select Transfer Results to Initial Guesses after automated sizing, you will see a dialog window 
appear like that shown in Figure 12. The ANS module allows you to transfer the hydraulic results, the 
sized pipe diameters, or both. If you transfer the sized pipe diameters, each pipe's input diameter (back 
on the Workspace) will become the sized diameter.

This feature allows the sizing results to be saved to the model for use in further analysis as needed.
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Figure 12: After sizing, the Transfer Results to Initial Guesses feature transfers both the hydraulic results and 
sized pipe size results

Conclusion

You have now used performed a network sizing to minimize pipe weight with the ANS module.
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Control Valve - ANS 

Summary

This example will show how to use AFT Arrow ANS module to size a system based on pipe weight. For 
many systems the necessary cost data is not available to directly minimize cost, so minimizing system 
parameters such as weight or flow volume is useful. By minimizing parameters such as these we min-
imize pipe diameter, which directly correlates to minimizing pipe costs.

We will create a system that feeds water from an elevated reservoir to a lower reservoir at a specified 
flow rate. A control valve will be used to control the flow rate and can be placed anywhere within the line. 
We will need to determine what size of piping to use in order to achieve a minimum pressure drop of 140 
kPa across the control valve.

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Sizing using pipe weight
 l Creating a Common Size Group
 l Defining Control Valve Design Requirements

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition, it is assumed that the user has worked through the Beginner - Three Tank Steam System - 
ANS example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Control Valve.aro
 l Metric - Control Valve - ANS.aro

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Control Valve.aro example file listed above, which is located in the Examples folder 
in the AFT Arrow application folder. Save the file to a different folder. 

Make sure the With Insulation scenario is the active scenario by double clicking on that scenario in the 
Scenario Manager. The workspace should look like Figure 1

Note: Optionally, you can create a new model file from the With Insulation scenario to use for this 
example . To do so, right-click on the scenario and select Save Scenario to File Without Chil-
dren.

Figure 1: Control Valve System Layout

 Step 2. Define the Modules Group

Navigate to the Modules panel in Analysis Setup. Check the box next to Activate ANS. The Network 
option should automatically be selected, making ANS enabled for use.

 Step 3. Define the Automatic Sizing Group

In this model we are going to perform sizing to minimize the pipe weight (therefore minimizing cost), while 
maintaining a minimum pressure drop of 140 kPa across the control valve. 

To do this, first go to the Sizing window by clicking on the Sizing tab, or from the Windows menu.
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A. Sizing Objective

The Sizing Objective panel should be selected by default from the Sizing Navigation Panel along the bot-
tom of the window.

Set the Sizing Option as Perform Sizing.

For the Objective, choose Pipe Weight, and select the Minimize option from the drop-down list if it is not 
already selected.

B. Sizing Assignments

On the toolbar at the bottom of the window select the Sizing Assignments button.

In this case we are sizing a new pipeline, so we want to size all pipes in the model.

ØUnder Automatically Size select Always Include in Weight next to each of the pipes.

For this system it is required that both pipes be the same size. We will need to add both pipes to a Com-
mon Size Group to specify this. To do this:

 1. Click New above Pipe Grouping, and give it new Common Size Group the name Main Pipes
 2. A new section will now appear with the Main Pipes group listed under Common Size Groups. Add 

both pipes to this group by clicking the corresponding radio buttons (Figure 2).

Note that as many Common Size Groups as necessary can be created. Selection tools are available at 
the bottom of the window to help assign multiple pipes to a Common Size Group for larger models. Addi-
tionally, pipes can only be assigned to a group once they are set to be included in sizing. 

Figure 2: Pipes P1 and P2 settings in the Sizing Assignments window

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.
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To select a discrete pipe size, ANS needs a list of candidates from which to choose. This list is called a 
Candidate Set. To create a Candidate Set, do the following:

 1. Under Define Candidate Sets, click the New button.
 2. Give the set the name STD Pipes and click OK.
 3. From the drop down list choose Steel - ANSI.
 4. In the Available Material Sizes and Types on the left, expand the STD pipe sizes list.
 5. Double-click each of the sizes from 1 to 10 inches to add them to the list on the right.
 6. In the Select Pipe Sizes window, click the OK button.

The STD Pipes set will now appear, and will be automatically defined as a Discrete set.

We now need to define which pipes will use this Candidate Set during the sizing calculation. 

ØUnder Assign Candidate Sets to Pipes, set the Main Pipes Common Size Group to use the STD 
Pipes Candidate Set. The Candidate Sets are now fully defined and assigned to the appropriate pipes, 
as can be seen in Figure 3.

Figure 3: Candidate Sets panel fully defined for the Control Valve model
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D. Design Requirements

Select the Design Requirements button at the bottom of the Sizing window to open the Design Require-
ments panel.

For this model we only have one Design Requirement, which is for the minimum pressure drop across 
the Control Valve. To define this requirement:

 1. Select the Control Valves button at the top of the window.
 2. Click the New button under Define Control Valve Design Requirements.
 3. Enter the name Min Pressure Drop.
 4. For the Parameter, select Pressure Drop Static.
 5. For the Max/Min, select Minimum
 6. For the Value and Units, select 140 kPa.

Now we need to apply the defined Design Requirement to the Junction.

ØCheck the box next to the Control Valve Junction J2 in the Assign Design Requirements to Con-
trol Valves section.

Note: It is strongly recommended that flow control valves have a Design Requirement specified for the 
minimum pressure drop/head, or the maximum Cv/percent open at the valve. If no Design 
Requirements are applied, the ANS module will allow the control valve to control to any pres-
sure required to meet the control setpoint, even if this requires the control valve to add pressure 
to the system for design purposes. To avoid this behavior in the final solution, a Design Require-
ment should be applied.

E. Assign Cost Libraries

When the Sizing Objective has been defined as monetary cost, it is necessary to create and assign cost 
libraries for the automated sizing, which can be done in the Assign Cost Library panel. Since we have 
defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is dis-
abled.

F. Sizing Method

Select the Sizing Method button to go to the corresponding panel.

Select Discrete Sizing, since we are sizing based on commercial pipe sizes.

For the Search Method in a simple model such as this one, the MMFD or SQP method should be appro-
priate since there is only one Design Requirement, and only one pipe size is being varied. Choose the 
default Modified Method of Feasible Directions (MMFD).
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 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 5. Examine the Output

The output is shown below in Figure 4. We have shown all three sections of the output window with the 
General, Pipes, and Junctions sections. In the General Section, we have selected the Cost Report tab 
that shows the variable that was sized for this run. The pipe weight in each pipe was minimized. 

In the pipe section, we have selected the Sizing tab that shows the final pipe sizes chosen. We can see 
that the ideal pipe size was found to be 3 inch pipe. In the Junction section, we have selected the CV 
Design Requirements tab that shows how we have satisfied the Design Requirement set on the control 
valve. The only Design Requirement was on pressure drop and we are above the minimum pressure 
drop of 140 kPa. 

Figure 4: Output for the Control Valve model showing the Cost Report, final pipe sizes and Design Require-
ment for the Control Valve
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Conclusion

This example has demonstrated how simple it is to perform an automated sizing to design a system for a 
set of requirements. Pipe weight may not be directly proportional to pipe cost but it can be implemented 
very quickly when cost data is not available. 
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Air Distribution - Libraries - ANS 

Summary

This example focuses on creating Engineering and Cost Libraries for a system, then connecting the lib-
raries to the model in order to obtain accurate results based on the cost data.

Note: This sizing for this example can only be completed if you have a license for the ANS module. 
However, the libraries can be built without access to ANS.

Topics Covered

 l Using external libraries 
 l Building engineering and cost libraries 
 l Using Scale Tables for cost 
 l Connecting and using existing engineering and cost libraries  

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition, it is assumed that the user has worked through the Beginner - Three Tank Steam System - 
ANS example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Air Distribution - Libraries - ANS - Initial.aro
 l Metric - Air Distribution -  Libraries - ANS - Final.aro
 l Air Distribution.dat - engineering library
 l Air Distribution Costs.cst - cost library for Air Distribution.dat
 l Steel - ANSI Pipe Cost.cst - cost library for Steel - ANSI pipes
 l Air Distribution Costs - ANS.xlsx - template file for building cost libraries

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Air Distribution - Libraries - ANS - Initial.aro example file listed above, which is loc-
ated in the Examples folder in the AFT Arrow application folder. Save the file to a different folder.

 Step 2. Create an Engineering Library

If it is desired to size any of the junctions in the system, such as the Compressors/Fans, the first step is to 
create an Engineering Library containing information for each of the components that will be sized. This 
engineering library can later be used to attach a cost library for the components. Engineering libraries 
can also be connected to future models to reuse any of the components in future systems.

To add a defined compressor to an engineering library:

 1. Define the Compressor/Fan junction in the workspace. 
 1. For this example, the junction is already defined in the initial model.

 2. Select the Compressor/Fan, go to the Library menu, and choose Add Junction to Library. 
 3. Give the Compressor/Fan a meaningful name such as Fixed Flow 2125 sm3/h and add it to the 

desired library by selecting it from the list, in this case the LOCAL USER LIBRARY.

If we had multiple Compressor/Fan models, valve types, etc. then we might need to add multiple Com-
pressors/Fans, valves, etc.

The local user library is the default location where user defaults are placed for the local machine. If the 
junctions are stored in the local user library, it is possible to run all the calculations, and attach a cost lib-
rary for the junctions. However, this restricts the use of the saved data, as the local user library cannot be 
shared with other users or be moved to different machines. Therefore, it is often preferred to place the 
components into an external library. Follow the steps below to move the components:

 1. Open the Library Manager from the Library menu. 
 2. Click Create New Library at the bottom of the window.
 3. Give it a unique filename, such as Air Distribution.dat. It is important to use a descriptive name 

to avoid confusion later if the library needs to be reconnected or sent to someone else. 
 4. Enter a Library Description. This is the name that will be displayed within the Library Manager 

itself and may be different from the file name. It is helpful to make the description the same name 
as the filename to avoid confusion. We will use the name Air Distribution for this library.

 5. For the compressor that we added earlier, right-click the name, then click Move Content to move 
the junction from the LOCAL USER LIBRARY to the Air Distribution library. The Fixed Flow 2125 
sm3/h compressor should now be visible in the Junctions section below the Air Distribution library 
name, as is shown in Figure 1.

 6. Select Close to complete the process. If you open the folder where the library was created in step 
3, the library file should now be available. 
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Note: The Copy option is also available if you want to preserve the items within the original library.

We are now ready to enter the cost data for the junctions in the model.

Figure 1: Library Manager showing the components moved to the new external library from the local user lib-
rary

 Step 3. Create a Cost Library for Junctions

Use the Library menu to select Cost Library and open the Edit Cost Library window, which is used to cre-
ate and view cost libraries. In this case we need to enter new cost data that we have obtained, so click 
New.

The list of Available Libraries should now be displayed as shown in Figure 2. Every cost library must be 
built of an existing engineering or pipe material library in order to link the cost information with the appro-
priate components in the model. Select to the newly created library, Air Distribution. You may need to use 
the Browse button to find it if the library is not shown in the list. Then click Select.
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Figure 2: The Available Engineering Libraries list which can be used to build a cost library

From here we will be brought to the General tab of the Edit Cost Library window. The description field is 
used as the name displayed within the Library Manager, similar with the engineering library.

The Notes field can be used to provide information on sources for the data, or other details which may be 
useful for tracking purposes and can be seen when reviewing the library contents in the Library Manager.

The other item of note is the Multipliers table. This can be useful to apply multipliers to account for infla-
tion or uncertainty, without needing to calculate the costs directly. Note that multipliers can also be 
applied within the Assign Cost Libraries panel, so be cautious to avoid duplicate multipliers.

Ø In the Description field enter Air Distribution Costs, as seen in Figure 3. Now let’s move on to enter-
ing cost data. Click the Junctions tab to view the Junctions overview.
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Figure 3: The General tab within the Cost Library window

Within the Junctions tab each individual library item can be viewed under each Junction type. First 
expand the Compressor/Fan section by clicking the + icon and select the Fixed Flow  2125 sm3/h com-
ponent that was added earlier.

Note: The Show Engineering Data button can be used to view the properties window for the selected 
component in the engineering library.

ØClick the New Cost button to add an item to the table. By default, a cost item will be added that is con-
figured for cost entry per item. Costs can be categorized as Material, Installation or Maintenance Cost 
Type. This categorization becomes useful if it is desired to exclude certain costs from the calculation or 
the sizing, but otherwise does not impact how the costs are calculated.

In the file explorer open the Excel spreadsheet titled Air Distribution Costs - ANS.xlsx found in the 
Examples folder, and go to the Metric - Junction  Costs tab. The cost data for the compressor can be 
seen here, categorized by cost type.

In this case we are sizing the compressor, so rather than having a cost for a specific compressor model, 
we have a range of costs specified based on the power requirement for the compressor. We will need to 
enter this data into the Tables tab first before we can define the cost item on the Junctions tab, so click on 
the Tables tab at the top of the window.

Ø Click the New Table button to begin defining the data table, and name it Compressor Material. Mul-
tiple Table Types are offered as the dependent variables for the table, which can either be plotted against 
a set of multipliers which will be applied to a specific data point, or directly against cost, as can be seen in 
Figure 4.

The data we have available is the cost for the compressor over a range of different power requirements, 
so choose Power and Cost as shown below, then click OK.
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The new table name will now appear in the Tables list, and an entry section for Power vs Cost will 
become available. Copy the data in the  spreadsheet for compressor material, then click the Edit Table 
button and choose Paste. Make sure that the table Units have been set to kW. Repeat this process for 
the compressor installation costs using the data from the spreadsheet as shown in Figure 5.

Figure 4: Table type and formatting options when creating a cost library

Figure 5: Complete tables list with material and installation cost tables for each of the junctions being ana-
lyzed
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Now that the data tables have been created, we must assign them to the Compressor/Fan junction in the 
Junctions tab. Click on the Junctions tab and make sure that the Fixed Flow 2125 sm3/h compressor 
model has been selected, then enter the cost information as follows:

 1. For Cost #1 in the Description row, enter the name Material. This row is optional, but can be useful 
to provide clarification on the source of the entered cost. 

 2. The Cost Type should be specified as Material (NR), which is the default option. Note that NR 
denotes a non-recurring cost type, while R denotes a recurring cost type. 

 3. We want to use the Compressor Material table specified earlier, so next to Use Size Table select 
Table of Costs. 

 4. Select the Compressors Material table as the Size Scaling Table. Cost #1 is now complete.
 5. Click New Cost to create a second cost item for the Compressor, and name it Installation. 
 6. Choose Installation as the cost type.
 7. Specify Table of Costs for Use Size Table, then set the Size Scaling Table to the Compressor 

Installation table. The window should now appear as shown in Figure 6. 

Click Save and give the cost library a name. We will use Air Distribution Costs.cst in this case. It is 
often useful to give the cost library a similar name to the engineering library to make transferring and 
reconnecting the library faster. Once you have finished saving the library, click Close.

Figure 6: Compressor Material and Installation costs assigned using cost tables

 Step 4. Create a Cost Library for Pipes

We now have costs for the equipment, but we still need costs for the pipes. Cost data for Steel-ANSI pipe 
from 1 to 20 inches are provided in the Excel spreadsheet opened earlier.
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 1. Open to the Edit Cost Library window again from the Library menu. 
 2. Click New
 3. From the Available Engineering Libraries list, click Steel – ANSI. 
 4. Click Select to choose this library. You should now be on the General tab of the Cost Library win-

dow. 
 5. In Description, give the new pipe cost library a descriptive but unique name to differentiate it from 

the original library created for this model, such as Steel - ANSI Pipe Costs. 
 6. Go to the Pipe Materials tab. In the list section, we will be able to view all the sizes and types for 

the Steel - ANSI material. Under Sort choose Material, Type or Schedule, Nominal Size so that 
they will be sorted by type rather than size. 

 7. Expand the Steel - ANSI list, then expand the STD list (Figure 7). 

Figure 7: Pipe Materials tab in the Cost Library window showing the properties for the currently selected pipe

If a size from the list is selected, the hydraulic diameter can be viewed, along with a summary of the 
material, size and type. The New Cost button will also become active (Figure 7). There are a few meth-
ods available when adding the pipe costs. We could individually add the Material and Installation costs 
for each pipe size by selecting each size from the pipe materials list, then using the New Cost button to 
add these costs to the table individually. Alternatively, the pipe costs can be entered into a template in , 
then imported to the Cost Library all at once. 

In this case, we have the Pipe costs available in a spreadsheet, so we will use the  import/export option. 
To do this we will first export a template for the desired pipe sizes, then we will enter the cost information 
in the template and import the updated file as detailed below.

 1. Make sure that the STD pipe material type is highlighted in the list, then click the button labeled 
Export to Excel on the right side of the window. The Excel Export window should be shown as in 
Figure 8, with all Steel - ANSI STD pipe sizes displayed. 
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 2. Click Export, name the sheet, and save it to an easy to find location. The name does not matter, 
but we will need to be able to find this spreadsheet later to import back into the cost library. 

 3. When Arrow has finished the export, a message will be displayed notifying the user of a suc-
cessful transfer. Click OK, then browse to the exported worksheet and open it. The exported work-
sheet should contain a list of the selected pipe sizes, with empty columns where the cost per unit 
length can be entered for each cost type, as shown in Figure 9. 

 4. Open the Air Distribution Costs - ANS.xlsx spreadsheet with the costs for this example. 
Browse to the Pipe Costs tab and copy the Material and Installation costs for the 1 inch to 20 inch 
pipe sizes into the worksheet that we just exported. Ensure that data is entered for material and 
installation for each of the sizes from 1 to 20 inch, and that the length units are listed as feet in the 
worksheet, since these were the length units used by the manufacturer for their pricing. When this 
information is added back into the model where lengths are in meters, Arrow ANS will convert the 
cost/length information appropriately.

 5. Save and close the worksheet. 

Note: The length units used for the spreadsheet are taken from the default model units, which can be 
changed from User Options in the Tools menu.

Figure 8: Excel Export window showing pipe items that will be included in the  sheet
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Figure 9: Initial  sheet after exporting template for the Steel - ANSI Pipe Costs

Back in AFT Arrow in the Edit Cost Library window, click the Import from Excel button, then browse to the 
worksheet we just updated and open it. When the Import has finished click OK on the notification from 
Arrow, then click the 1 inch pipe size under the Steel ANSI STD pipe type. The Material and Installation 
costs should now be filled in, as shown in Figure 10. Click Save to save the cost library with a unique file 
name (i.e. Steel - ANSI Pipe Costs.cst), select Yes to make the library connected, then close the win-
dow.

Note: When using the Export/Import features for the cost library, it is not required to enter information 
for every size that was exported in order to import the worksheet. It is important to not delete any 
headings or descriptive information for the pipe data that was included in the template. Work-
sheets can be exported /imported as many times as desired, but whatever data is in the spread-
sheet will overwrite anything existing in the library, meaning that if the costs are left blank for a 
size, any cost information will be deleted for that pipe size in the library. Due to this fact it is 
recommended to export the current information in the library first before importing any change 
information so that an accidental overwrite does not occur.



Air Distribution - Libraries - ANS

- 192 -

Figure 10: The Pipe Materials tab in the Cost Library window, showing the data recently imported

 Step 5. Connect the Libraries

Open the Library Manager from the Library menu. Currently, the engineering library and two cost libraries 
should have automatically connected to the current model. In case they are not, we will now need to con-
nect the libraries so that the junctions in the model will be linked to the costs and junctions in the engin-
eering and cost libraries.

If the Air Distribution engineering library, Air Distribution Costs library, and Steel - ANSI Pipe Costs library 
are not connected to the model, follow the steps below to connect them.

ØChoose Add Existing Library at the bottom of the Library Manager window, then browse to Air Dis-
tribution.dat. Next choose Add Existing Cost Library and browse to Air Distribution Costs.cst then 
Steel - ANSI Pipe Costs.cst. This should make the libraries available, and automatically connect them, 
as shown in Figure 11.
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Figure 11: The Library Manager with the new cooling system engineering library and its associated equip-
ment costs

 Step 6. Define the Automatic Sizing Group

To make use of the newly creating engineering and cost libraries, a few inputs are required in the Sizing 
window. Go to this window now.

A. Sizing Objective

Go to the Sizing Objective panel. For the Objective, select Monetary Cost then select Calculate Cost, Do 
Not Size.

In the Options to Minimize Monetary Cost section, select the radio button to include Energy in Cost 
Report Only. The System Life and Energy Cost sections should now become available. Enter a System 
Life of 5 years and an Energy Cost of 0.12 U.S. Dollars Per kW-hr.

B. Size/Cost Assignments
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On the Size/Cost Assignments panel, make sure the Pipes button is selected at the top. Click All on the 
bottom left then click Always Include in Cost at the top to add all pipes to the Include in Cost list.

Click the Comp./Fans button at the top to go to the Compressors/Fans size/cost assignments page. 
Select the radio button for J2 to Include in Cost Report Only.

C. Assign Cost Libraries

Go to the Assign Cost Libraries panel. All 18 pipes should be assigned to the Steel - ANSI Pipe Costs lib-
rary. Go to the Comp/Fans page next and select Air Distribution Costs, as shown in Figure 12

Figure 12: Applying the newly built cost library for the compressor on the Assign Cost Libraries panel

Note: Before running the model, be aware that there are no design requirements set for the control 
valves. When the solver begins to run, a Model Diagnostics window will appear to inform you 
that this may result in control valves adding pressure in order to achieve the setpoint. As you will 
see, the control valves will not add pressure, so this message is safe to ignore.

 Step 7. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 8. Examine the Output

On the Cost Report, the total cost should be $184,952 as shown in Figure 13. In the Library Sources tab 
in the Junction section, the Compressor/Fan should list the Air Distribution Costs library as the cost 



Air Distribution - Libraries - ANS

- 195 -

source as shown in Figure 14. The Library Sources in the Pipes section should similarly show the new 
pipe cost library for Material and Installation.

Figure 13: Output tab showing the Cost Report

Figure 14: Output tab showing the current Library Sources used in the model calculations
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Air Distribution - ANS 

Summary 

This example focuses on a closed loop cooling system that demonstrates some key features in using 
ANS to size a piping system. An existing model is used to investigate four potential sizing cases:

 1. Size system for initial cost with a 5-year operating period
 2. Size system for life cycle cost with a 5-year operating period
 3. Size system for life cycle cost with an initial cost limit for a 5-year operating period

Note: This example can only be run if you have a license for the ANS module. 

Topics Covered

 l Connecting and using existing engineering and cost libraries
 l Sizing for Initial or Life Cycle Cost and using Initial Cost Limits
 l Sizing a compressor and sizing piping for the chosen compressor
 l Interpreting Cost Reports

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition, it is assumed that the user has worked through the Beginner - Three Tank Steam System - 
ANS example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Air Distribution - ANS - Initial.aro
 l Metric - Air Distribution - ANS - Final.aro
 l Air Distribution.dat - engineering library
 l Air Distribution Costs.cst - cost library for Air Distribution.dat
 l Steel - ANSI Pipe Cost.cst - cost library for Steel - ANSI pipes

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Air Distribution - ANS - Initial.aro example file listed above, which is located in the 
Examples folder in the AFT Arrow application folder. Save the file to a different folder.

 Step 2. Define the Pipes and Junctions Group

The Workspace should appear as shown in the figure below.

Figure 1: Workspace for Air Distribution model

Overview of Sizing Systems with Compressors

A centrifugal compressor can be modeled with either the Compressor Curve or as a fixed flow rate or 
pressure/head as the Sizing option. Generally, if a specific compressor has been identified, the Com-
pressor Curve type would be chosen, whereas the Sizing option is useful during the selection stage in 
order to identify the compressor requirements for the system. In some cases, even though the specific 
compressor has not been chosen, several candidate compressors are available. For this third case it 
would be best to model each candidate compressor with a compressor curve using separate scenarios 
for each compressor.
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Sizing a Compressor

The compressor in our air distribution case is set as Sizing with a fixed flows of 2125 sm3/h.  In order to 
allow the compressor to be defined as fixed flow the flow control valve at J12 has been defined at a fixed 
pressure drop. This model thus represents a first cut model where, based on the first cut results, the com-
pressor will become an actual compressor with a compressor curve, and control valve J12 will become a 
flow control valve controlling to 425 sm3/h, similar to the other control valves.

As already stated, when a compressor is modeled as a fixed flow, it is not a specific compressor from a 
specific manufacturer. Thus, the costs for the compressor can only be approximated. To a first approx-
imation, it should be possible to estimate the non-recurring cost (i.e., material and installation cost) for 
the pump as a function of power requirements. For instance, a typical ten horsepower compressor (of 
specific configuration and materials of construction for a given flowrate) may cost $2700, and a forty 
horsepower may cost $8250. Other typical costs for different power requirements can be approximated. 
The actual cost for the compressor will, of course, highly depend on the application. These costs are 
entered into a cost library and are accessed by the Solver. As AFT Arrow evaluates different com-
binations of pipe sizes, each combination will require a certain power from the compressor. With a cost 
assigned to this power, the ANS module can obtain a cost to enter into the objective which it sizes. Later 
in this chapter, we will look at the costs for the compressor in our example air distribution network.

In addition to non-recurring costs, recurring costs can also be estimated. Specifically, the cost of the 
power used by the compressor over a period of time (which the ANS module calls the System Life) can 
be determined. All AFT Arrow needs is an overall compressor efficiency to determine the actual power 
from the ideal power. Again, since we do not have a specific compressor selected yet, the efficiency can 
only be approximated. The ANS module calls this the Nominal Efficiency. 

Therefore, it is recognized that at this first cut phase the values for nominal efficiency are imprecise and 
users may need to go through a few iterations to arrive at satisfactory results.

A step-by-step method of compressor selection proceeds in two phases. The steps are outlined in the 
Help System.

For this example, we will be completing the compressor selection process considering the objective of 
minimizing initial cost, then minimizing life cycle cost.

 Step 3. Define the Automatic Sizing Group

The model is already defined for a regular AFT Arrow run, but we need to complete the sizing settings 
before running the analysis. Go to the Sizing window by clicking the Sizing tab.

A. Sizing Objective

The Sizing Objective window should be selected by default from the options along the bottom of the win-
dow. For this analysis, we are interested in sizing the system considering the monetary cost for the initial 
costs only.
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 1. Select Perform Sizing for this calculation.
 2. For the Objective, choose Monetary Cost and select the Minimize option from the drop-down list if 

these options are not already selected.
 3. Under Options to Minimize Monetary Cost, choose Size for Initial Cost, Show Energy Costs. This 

will update the cost table to include both initial costs in the sizing calculation, and moves the 
Energy costs to be included in the Cost Report so that we can later compare the costs in this scen-
ario to one where the Energy costs are included for the sizing. We do not have any information on 
Maintenance cost, so we will leave this cost in Ignore Cost.

 4. Set the System Life to 5 years with 0% interest and inflation rates.
 5. For the Energy Cost area choose Use this Energy Cost Information, with a cost of 0.12 U.S. Dol-

lars Per kW-hr. Note this assumes the pump will run all day, every day, for the entire 5 years. 
Alternatively, we could have created an Energy Cost Library, which would be connected in the 
Assign Cost Libraries section. An Energy Cost Library allows variable energy costs to be used to 
account for varying prices during different times of day, different seasons, etc. For now, we are 
simplifying the input by using a fixed cost.

The Sizing Objective window should now appear as shown in Figure 2.
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Figure 2: Sizing Objective panel setup for the initial cost analysis

B. Size/Cost Assignments

On the Sizing Navigation panel select the Size/Cost Assignments button. For this example we are sizing 
both the pipes and compressors for a new system, so we will need to calculate and minimize cost for all 
related components in the model.

ØClick All under the table to select all of the pipes, then click the Always Include in Cost button next to 
Move to. This will move all of the pipe selections to the corresponding column to be sized.
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To decrease the run time and reduce complexity, as well as to enforce some design uniformity, it is useful 
to create Common Size Groups to link the pipes in different sections of the model. 

For example, if all the 18 pipes are selected to be Not In Group, then 18 separate pipe sizes will be selec-
ted by the automatic sizing engine. That could potentially mean, for example, different pipe diameters in 
pipes P9 and P14. If one wanted pipes P9 and P14 to be sized to the same diameter, one would group 
them into a Common Size Group. To see how this works, in this model all discharge room piping will be 
put into a Common Size Group. What this means is that there will be a single diameter chosen for this 
group of pipes, rather than potentially six different diameters.

For this system we will define four groups to be sized in this model. To set the groups, it is standard to 
select pipes which must have the same size due to their placement relative to other pipes and junctions, 
such as pipes at the entrance and exit of valves. In Figure 3 we have identified these four groups.

Figure 3: Workspace with Common Size Groups shown in different colors

First create a Compressor size group for pipes P1 and P2, which are highlighted in red.

ØClick New above the Pipe Grouping section to create the group, and name it Compressor. Select 
the radio buttons under the Compressor heading next to P1 and P2 to add them to the group. Altern-
atively, the pipes can be selected in the Workspace, then moved to a group by right-clicking the Work-
space and selecting the corresponding option from the menu.

Repeat this process for the header piping. We will assume the header will have the same size, so there-
fore these pipes will have a common size. Like before, create a new group called Header A, and add the 
two header pipes on the right side of the system to the new group (pipes P4 and P5).

The headers supplying each room are one physical pipe in the field, represented as multiple pipes in AFT 
Arrow by necessity. Create two more groups and add the pipes as listed below and shown in Figure 4.
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 1. Header B = P6 - P8 
 2. Discharge = P9 - P18

The completed pipe Size/Cost Assignments can be seen in Figure 4. Note that pipe P3 should be the 
only pipe not in a group.

Note: Pipes in the Size/Cost Assignments table can be sorted by Common Size Group instead of sort-
ing by number by clicking on the Pipe Grouping header. Clicking on the header for a particular 
group will sort the pipes in that specific group to the top of the window.

Figure 4: Size/Cost Assignments panel with Common Size Groups defined as outlined above

ØClick the Comp./Fans button to switch to the Compressor/Fan Size/Cost Assignments. Select the 
option to Include in Cost Report and Sizing for the compressor J2 as shown in Figure 5. The compressor 
will now be sized concurrently with the pipes.

Similar to the Common Size Groups for pipes, compressors can be placed into Maximum Cost Groups 
based on monetary cost. If compressor costs are added to a Maximum Cost Group, the ANS module will 
determine the compressor in the group with the maximum costs, and set all compressors in the group to 
use the largest cost. In this case there is only one compressor, so this option is not available.
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Figure 5: Size/Cost Assignments panel defined for the compressor

Now go to the Workspace window. It is possible to inspect the Common Size Groups in the model by col-
oring the pipes. From the View menu, select All under Color Size Groups. The model should appear as 
shown in Figure 3, though the colors may be different.

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.

Create a new Candidate Set for all Steel - ANSI pipes between 2" and 10" in diameter. Click the New but-
ton, and name the Candidate Set STD Steel 2" - 10". Choose Steel - ANSI as the pipe material library, 
STD as the Material Type, and add all pipes from 2" to 10" in size. 

In the bottom section of the window, check that each of the Common Size Groups and pipe P3 have been 
assigned to use the existing Candidate Set. The window should appear as shown in Figure 6.
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Figure 6: Candidate Sets panel fully defined for the model

D. Design Requirements

Select the Design Requirements button from the Navigation Panel.

For this model we have multiple requirements for the system:

Define and assign the first requirement listed above as a Pipe Design Requirement as shown in Figure 7, 
and apply it to each of the pipes. 

Notice that we have accounted for the minimum flow requirement in this system by using flow control 
valves in each discharge line. By using assigned flow compressor and flow control valves we have incor-
porated the necessary flow rate as a boundary condition, so we do not need to apply a Design Require-
ment to account for the second item.
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For flow control valves J10, J11, J13, and J14, define and apply the minimum pressure drop requirement 
in the Control Valves section as shown in Figure 8. Note that for compressor sizing purposes as dis-
cussed earlier control valve J12 has been defined as a Constant Pressure Drop valve, so the pressure 
drop Design Requirement does not need to be applied to this valve.

Figure 7: Design Requirements panel for pipes
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Figure 8: Design Requirements panel defined for the control valves

E. Assign Cost Libraries

Select the Assign Cost Libraries button. For this model the engineering and cost libraries have already 
been created, but we will need to connect and apply them.

Note: The Creating Libraries for Sizing a System example provides instructions on how to build the lib-
raries for the first part of this example, and may be completed later for practice with creating lib-
raries. The provided pre-built libraries will be needed to obtain the compressor curve data for 
Step 10 of this example.

ØOpen the Library Manager by clicking the Library Manager button to see which libraries are con-
nected. The AFT INTERNAL LIBRARY, LOCAL USER LIBRARY, and Pipe Material libraries should be 
available and connected by default. Available libraries will be shown based on libraries that Arrow has 
identified on your machine. The default connected libraries will be visible here, and additional libraries 
may be visible from other example files, or from libraries previously built and used on your machine.

This example uses one user-defined engineering library, Air Distribution.dat, which contains the data 
for the compressor. There are also two cost libraries, Air Distribution Costs.cst and Steel - ANSI Pipe 
Costs.cst, which contain the cost data for the junctions and the pipe materials, respectively. Air 
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Distribution Costs.cst was built off of the engineering library Air Distribution.dat, and Steel - ANSI 
Pipe Costs.cst was built off of the Steel - ANSI Pipe Material library. To connect these libraries, do the 
following:

 1. Click the button to Add Existing Library.
 2. Browse to the AFT Arrow 10 Examples folder (located by default in C:\AFT Products\AFT Arrow 

10\Examples\), and open the file titled Air Distribution.dat.
 3. Repeat the above steps, but choose Add Existing Cost Library to browse for Air Distribution 

Costs.cst, then Steel - ANSI Pipe Costs.cst.

Note that it may be possible that the model file already has the cooling system libraries connected, in 
which case you will be notified that the library you are trying to add is already available. If the libraries are 
available, you will simply need to connect them by checking the box next to the library name for each of 
the three libraries.

Once these steps have been completed, you should now see that the new libraries have been added to 
the Available Libraries list, and have been automatically connected to the model, as shown in Figure 9 for 
the junction libraries. The junction libraries appear with the names Air Distribution, Air Distribution Costs, 
and Steel - ANSI Pipe Costs.

Note: When a library is selected in the Library Manager, the filename and location can be viewed in 
the Selected Library Information. Library names can be different from the given filename.

Once you have confirmed that the necessary libraries are connected, click Close to exit the Library Man-
ager.
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Figure 9: Library Manager with Air Distribution libraries connected

Since we are connecting a pre-built library, we will need to take an additional step to make sure that the 
compressor in the Workspace is linked to the Air Distribution engineering library that we added.

 1. Go to the Workspace, and open the compressor (junction J2) 
 2. From the Library Jct list, select Fixed Flow 2125 sm3/h. None of the input should change, as this 

library item is identical to the existing pump. However, AFT Arrow will now recognize that this junc-
tion is connected to the engineering and cost library for this compressor.

We have now re-connected the junctions that will be considered for the Cost Report and sizing cal-
culations to the engineering library. This is important, since a junction must be connected to an engin-
eering library before cost information can be assigned to it. Let's now return to the Sizing window.

Back in the Assign Cost Libraries panel for the Pipes, the Steel - ANSI Pipe Costs library should be the 
only visible cost library, since it is the only connected library for the pipe sizes in the Candidate Set. Make 
sure that the library is checked to be applied for the model as shown in Figure 10. 

ØClick on the Comp./Fans button to view the cost library assignments for the compressor. The only 
visible library should be the Air Distribution Costs library, as this was the only cost library connected for 
the associated engineering library. Make sure that the checkboxes are selected under the library name 
so that the cost data will be applied for the compressor (Figure 11).
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Figure 10: Assign Cost Libraries panel for pipes

Figure 11: Assign Cost Libraries panel for compressors

F. Sizing Method

Select the Sizing Method button to go to the Sizing Method panel.

Ø Choose Discrete Sizing, if not already selected, since it is desired to select discrete sizes for each of 
the pipes in the model.
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For this model we have five independent pipe sizes as noted on the Size/Cost Assignments panel (four 
groups and pipe P3), and two design requirements (one pipe design requirement applied to all of the 
pipes, and a minimum pressure drop applied to four control valves).  Due to the small number of inde-
pendent sizes, it would be recommended to try the MMFD or SQP search method. Though it is not shown 
here, if both methods are run for this scenario the same solution will be obtained, though the Sequential 
Quadratic Programming (SQP) Method is slightly faster. 

ØSelect Sequential Quadratic Programming (SQP) for the sizing method.

G. Sizing Summary

From the Sizing Navigation Panel select the Sizing Summary button.

The Sizing Summary panel allows the user to view all of the sizing input for the model in a tree view lay-
out, which is shown in Figure 12. Items can be organized by sizing parameters (Design Requirements, 
Candidate Sets, etc.), or information can be viewed based off an individual pipe. For clarity these cat-
egories can be shown/hidden using the check boxes at the top of the panel.

Each tree node can be expanded/collapsed individually by using the ‘+’ and ‘-‘ buttons on the node. 
Alternatively, the buttons on the bottom of the panel can be used to collapse/expand all items. Right-click-
ing on the nodes provides additional options to collapse/expand items, view related nodes, or to copy 
information to the clipboard. The Sizing Summary panel can be printed from the printer button at the bot-
tom of the panel.
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Figure 12: Sizing Summary panel layout with the Size/Cost Assignments expanded. The number of children 
nodes for each item can be seen in parentheses.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 5. Examine the Output

The Cost Report is shown in the General Section of the Output window (see Figure 13). The ANS mod-
ule shows all costs in the Cost Report, including those that were not used in the automated sizing. The 
total cost for this system is $198,056. This includes all costs over five years. The initial cost, which was 
the basis for the automated sizing, was the total of the material and installation ($69,555). This total is lis-
ted as the total for the Items in Sizing line, since it was specified to only include the Initial Cost for material 
and installation on the Sizing Objective section. Individual items that were included in the automated siz-
ing have their costs highlighted in green.

Other costs that are displayed in the Cost Report are Items Not in Sizing. These are items that have costs 
associated with them, but were not included in the automated sizing. 
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Note that the Items Not in Sizing total to $128,501. Looking across at the subtotal one can see that all of 
this cost is in energy (i.e., compressor power costs). The total cost is the sum of the two. For the next 
scenario this cost will be included in the automated sizing as a comparison.

Figure 13: The Cost Report in the Output window shows the total and individual costs (in thousands of U.S. 
Dollars) for the sized system

In the Pipes section of the Output window the final pipe sizes from the automated sizing can be seen, 
along with the Design Requirements status. For this model, the final system used pipe sizes varying from 
2-1/2 to 6 inches, as seen in Figure 14. The information for the compressors can be seen in the Com-
pressor/Fan Summary tab in the General Section, which is also shown in Figure 14.

When a monetary cost objective is selected, additional tabs are available that display the Library Sources 
used for the Cost Report for each of the pipes/junctions. In this case both the Pipe Material and Pipe 
Installation costs for all of the pipes came from the Steel - ANSI Pipe Costs library which was connected 
earlier. Information for the compressor came from the Air Distribution Costs library. If multiple cost lib-
raries are used for a category they will all be listed separated by commas. The Library Sources for the 
Pipes can be seen in Figure 15.
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Figure 14: Compressor and Pipe Sizes after automated sizing is performed
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Figure 15: Library Sources for the pipes and compressor in the Cost Report

On the General tab of the Output window at the bottom of the report, the initial cost of the items included 
in the sizing can be seen, which was $110,156 for this design, showing that the initial costs were reduced 
by about 37% from the initial design. We can also see that the initial design was feasible, meaning all of 
the design requirements were met (Figure 16).

Though not shown here, if the model is run using the objective to Calculate Costs, Do Not Size, it can be 
seen that the total cost for the system before sizing was $184,952, which is actually less than the system 
that has been sized for initial costs. This is due to the fact that the larger pipe sizes in the initial system 
allowed for lower energy costs over the 5 year system life. This system is weighted towards energy costs, 
so any change in the energy costs will have a larger impact on the overall life cycle cost than the material 
and installation costs.
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Figure 16: General section of Output window showing initial status of Items in Sizing

 Step 6. Size the System for Life Cycle Cost over Five Years

From the Scenario Manager in the Quick Access Panel, we will create two children scenarios. With the 
base scenario selected, right click and choose Create Child. Name the new scenario Initial Cost. This 
scenario will store the initial cost sizing results we just obtained. Repeat this process to create a second 
child scenario, and name it Life Cycle Cost. For this scenario the only change that will need to be made is 
to update the Sizing Objective.

Go to the Sizing window, and make sure that the Sizing Objective button is selected. Under Options to 
Minimize Monetary Cost, choose Size for Initial and Recurring Costs. This will move the Energy costs 
selection to Include in Sizing Objective. The scenario is now complete.

ØClick Run from the Analysis menu to run the automated sizing. When the calculations have finished, 
click Output to view the results.

 Step 7. Examine the Output

After viewing the Cost Report, it can be seen that the overall cost is now $173,059. The Items Not in Siz-
ing line now has a value of zero, and the Energy columns are highlighted green, reflecting the changes 
made to include these costs in the objective to minimize monetary cost. The Cost Report is shown in Fig-
ure 17.

Taken on its own, this new cost represents a savings of about $36,000 over the Initial cost scenario 
which was sized based on Initial Cost only. This represents a 17% cost reduction. In the initial cost scen-
ario, the non-recurring cost was $69,555, while the overall cost was $209,738. Now the non-recurring 
cost is $92,464 while the overall cost is $173,059. The initial cost thus increased by about $23,000 in 
order to reduce the operating cost from $140,183 to $80,585 (a reduction of about $60,000). The source 
of the operating cost is the cost of power for the compressors. To reduce compressor power usage, it 
makes sense to increase the pipe size and thus reduce frictional losses. The larger pipe sizes can be 
reviewed by looking at the Sizing tab in the Pipe Output section, as shown in Figure 18.
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Considering this cost breakdown between the scenarios highlights the importance of choosing to include 
the energy costs in the initial cost scenario. If they were not in the Cost Report of the initial cost scenario, 
the total cost would be $69,555. Since the life cycle cost scenario total cost is 2.5 times larger, it would 
appear (at first glance) to be a significant cost increase. However, this would be misleading, since the 
energy costs still exist in both scenarios, though they are only being minimized in one case. To get a 
clear comparison between designing for initial cost and life cycle cost one needs to make an apples-to-
apples comparison, including all relevant costs in each case, as is done for this example.

By performing both analyses the designer has quantitative data on the impact of initial cost design on 
operational costs of the system, and can make an informed design choice.

Figure 17: Cost Report for the network after sizing for life cycle cost
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Figure 18: Compressor and Pipe Sizes after automated sizing is performed for life cycle cost

 Step 8. Size the System for Life Cycle Cost with Initial Cost Limit

While the energy cost savings from life cycle cost sizing are desirable, the budget for the project may not 
support the higher initial cost that is required. In that case, we can apply an initial cost limit to the life cycle 
cost sizing. 

Clone the Life Cycle Cost scenario. Name the scenario Initial Cost Limit.

ØReturn to the Sizing Objective panel and select the option for Initial Cost Limit. We will set the limit 
as $82,500 which is approximately an initial cost reduction of 25% from the original (un-sized) design. 
Run the model and go to the Output tab.

A summary of the results with the initial cost limit compared to each of the initial and life cycle cost sizing 
scenarios for a five year life cycle can be seen in Table 1. Notice that while the material and installation 
costs were similar to the costs from the initial cost scenario, the energy costs were decreased by about 
$10,000. These energy costs were achieved by increasing the compressor pipe sizes, while decreasing 
the header pipe sizes to achieve a better efficiency in the compressor. Table 2 shows a comparison of 
the pipe sizes throughout the system for the original design, and each of the sizing scenarios.
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Table 1: Cost Summary of Sizing Runs for the Air Distribution System

Scenario Material Installation
Non-Recur-
ring Sub 

Total
Energy Total Reduction

Not Sized 67,223 42,933 110,156 74,796 184,952

Initial Cost 42,256 27,298 69,555 140,183 209,738 -25,000

Life Cycle 
Cost 57,248 35,216 92,464 80,595 173,059 12,000

Initial Cost 
Limit 45,186 27,963 73,149 128,656 201,805 -17,000

Table 2: Summary of final pipe sizes for Common Size Groups in the Air Distribution System

Scenario Compressor Header A Header B Discharge Pipe P3

Not Sized 6 inch 6 inch 6 inch 3 inch 6 inch

Initial Cost 6 inch 4 inch 4 inch 2-1/2 inch 4 inch

Life Cycle 
Cost 8 inch 5 inch 5 inch 4 inch 5 inch

Initial Cost 
Limit 8 inch 4 inch 4 inch 4 inch 4 inch

 Step 9. Automated Sizing with Compressor Curve Data

As discussed in the previous section summarizing the compressor selection process, once the com-
pressor is sized then actual compressors can be modeled. The actual compressor should closely match 
the sizing results in the following areas: generated pressure at the design flow, efficiency at the design 
flow, and cost. Let's apply actual compressor data for the case that was sized for life cycle cost with an ini-
tial cost limit to complete phase two of the compressor selection process above.

Reviewing the results for the life cycle cost with initial cost limit scenario one can see that the sized sys-
tem calls for a compressor of about 25 kW that generates about 36.7 kPa of pressure at 2125 sm3/h. The 
nominal efficiency used in the sizing part of the analysis was 80%. The material cost for such a com-
pressor was about $3,000, and the installation cost was about $1,500. Note that if no actual compressor 
can be found that reflects these requirements, then the phase 1 of the compressor selection process 
described above should be repeated with better performance and/or cost data for the compressor. 

In the Scenario Manager clone the Initial Cost Limit child scenario and name it Actual Compressor Curve.

In the new scenario, open the properties window for compressor J2 select PowerFlow Compressor 
JW120 from the Library Jct list to import the compressor data from the library as shown in Figure 19, then 
click OK.
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In the Flow Control Valve Property window for J12, change the Valve Type to Flow Control (FCV), and 
enter a Flow Setpoint of 425 sm3/h. Now that we have changed the control valve model, we will need to 
apply a Design Requirement in order to account for the minimum pressure drop.

Go to the Sizing window, then navigate to the Design Requirements panel. Select the Control Valves but-
ton at the top of the window.

Apply the Min Pressure Drop design requirement to Control Valve J12.

Figure 19: Compressor Properties window with the Rocky Mtn Compressor Co 100XLC library item selected

The necessary changes are now complete to size the system with the updated compressor and flow con-
trol valve data.

ØSelect Run from the Analysis menu to perform the automated sizing. When the solver has finished, 
click Output to review the results, as can be seen in Figure 20.

The Cost Report shows a total sized cost of $208,149. Comparing the final pipe sizes to the Initial Cost 
Limit scenario shows the pipe sizes and compressor operating point are similar.

Now we have sized the system for use with an actual compressor.
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Figure 20: Cost Report for system with actual compressor and FCV data sized for five year life cycle cost 
with initial cost limit
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Air Distribution - Multiple Design Cases - ANS 

Summary 

Some system designs have multiple operating conditions to satisfy. For instance, the air distribution sys-
tem discussed in the previous example may have a requirement that it operate with one of the discharge 
valves closed. This can be modeled in the ANS module by taking advantage of its ability to model mul-
tiple systems concurrently. 

Note: This example can only be run if you have a license for the ANS module. 

Topics Covered

 l Using Dependent Design Cases 
 l Using Duplicate Special to create Dependent Designs
 l Understanding fractional compressor costs with Dependent Design Cases
 l Specifying Multiple Dependent Design Cases

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition, it is assumed that the user has worked through the Beginner - Three Tank Steam System - 
ANS example, and is familiar with the basics of ANS analysis.

This example is an addendum to the Air Distribution - ANS example, but can be worked separately from 
the example. The results from the Air Distribution - ANS example will be used to compare against the res-
ults from this example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Air Distribution - Multiple - ANS - Initial.aro
 l Metric - Air Distribution - Multiple - ANS - Final.aro
 l Air Distribution.dat - engineering library
 l Air Distribution Costs.cst - cost library for Air Distribution.dat
 l Steel - ANSI Pipe Cost.cst - cost library for Steel - ANSI pipes

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Air Distribution - Multiple - ANS - Initial.aro example file listed above, which is loc-
ated in the Examples folder in the AFT Arrow application folder. Save the file to a different folder.

 Step 2. Define the Pipes and Junctions Group

The Workspace should appear as shown in the figure below.

Figure 1: Workspace for Air Distribution model

 Step 3. Enable Dependent Design

When modeling multiple design cases, the different cases need to be broken up into a primary design 
case, of which there is one, and dependent design cases, of which there can be any number.

The primary design case can be any of the design cases that are being addressed in your model. Typ-
ically, it will represent the primary operating condition of the pipe system. The dependent design cases 
represent the same physical operating system but are used to represent differing operating conditions. If 
it is not clear which case should be the primary case, just pick any of the cases and call that the primary 
one. Design cases other than the primary case are referred to as dependent design cases. The reason 
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why we choose a primary case and refer to the other cases as dependent cases will become clearer as 
we progress through this topic.

For this example, the primary design case is the system running with all discharge valves open. We want 
to also consider the case where one discharge is closed. The one discharge closed case will be created 
as a dependent design case.

To start creating the dependent design case, we will first need to enable the Dependent Design Case 
modeling:

ØGo to the Sizing Objective panel and select the Enable Dependent Design Cases option. A new but-
ton will now be available for the Dependent Design Cases panel in the Sizing Navigation Panel, as can 
be seen in Figure 2.

Figure 2: Dependent Design Cases are enabled from the Sizing Objective panel
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 Step 4. Set up the Dependent Design Case

A. Use Duplicate Special

The easiest way to set up a dependent design case is to use Duplicate Special, which will allow us to 
make an exact duplicate of the model in order to set up the additional operating cases. Note that you 
should fully define the model and all of the sizing settings for the primary case before creating the depend-
ent cases, as has been done in this model.

To create the dependent design case:

 1. Make sure that the scenario where the dependent cases will be created is loaded..
 2. Go to the Workspace window. 
 3. Choose Select All from the Edit menu, or use CTRL+A.
 4. Choose Duplicate Special from the Edit menu (see Figure 3).
 5. Choose an increment for the pipe and junction numbers. The number should be large enough to 

avoid conflicts with numbers used for other pipes and junctions in this and all other scenarios. In 
this case use 100.

 6. Select the Make Dependent Design Case check box.
 7. Click OK and move the duplicated version of the primary design case to an open area in the Work-

space. The model should now appear similar to Figure 4.

Note that Duplicate Special also allows you to do the following:

 l Create a group for the dependent design case. This can simplify managing the pipe and junction 
objects in the design case.

 l Hide the pipe and junction in the output. You may want to do this for reasons to be discussed later 
in this topic.

 l Copy Layer Style Settings From Original Settings. If selected, all objected data associated with 
workspace layers will be carried into the new object. When not selected, the duplicated object will 
be placed on the workspace as if it was a brand new junction placed on the layer.

 l Keep Common Size Groups. This feature is useful when using Duplicate Special for reasons other 
than dependent case creation, and can't be used when making a dependent design case.

 l Clear the Design Requirements. For reasons to be discussed, frequently dependent design cases 
will employ different design requirements than the primary design case. This option allows you to 
clear all the current requirements, so new ones can be assigned.
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Figure 3: Duplicate Special simplifies creation of dependent design cases

Figure 4: Workspace with the Dependent Design Case created for the Air Distribution model
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B. Apply the Dependent Design Requirements

The dependent design case capability takes advantage of the ANS module's ability to run multiple mod-
els in the same Workspace. The pipes and junctions in Figure 4 that are numbered greater than 100 (i.e., 
the dependent design case) represent the same pipes and junctions as those numbered less than 100 
(i.e., the primary design case). It is therefore critically important that only certain data in the dependent 
case is changed. 

Frequently the Design Requirements or Special Conditions on the pipes or junctions will be changed. 
However, data such as a pipe's length or compressor's performance should never change. The reason is 
that once this kind of data is changed, the pipe or junction is no longer the same pipe or junction, and 
thus the purpose of the dependent link is invalidated. The ANS module does not prevent changing data 
that should not be changed, but when the model is run it will check to make sure all data that should be 
the same actually is the same.

In this example we are analyzing the case where one Discharge Room in the system is shut off, so we 
will use Special Conditions on the discharge valve to that room.

Select Control Valve J110 in the dependent case, and use the Special Conditions button  on the Edit 
menu to set the junction to Closed. The dependent case should now appear as shown in Figure 5.

Figure 5: Flow off for Discharge Room A1 in the Dependent Design Case

With one valve shutoff we will need to distribute the Fixed Mass Flow Rate of the compressor for the four 
Discharge Rooms remaining. That means the new Mass Flow Rate for every Control Valve will be 531.25 
sm3/h. The flow requirements for the Control Valves J111, J113 and J114 need to be changed from 425 
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sm3/h to 531.25 sm3/h. Note that Control Valve J112 will not need to be changed since it is set to a fixed 
pressure drop for sizing purposes, and still has the same pressure drop requirement.

ØOpen the Control Valve Properties window for control valve J111 and change the flow setpoint to 
531.25 sm3/h, then repeat this for junctions J113 and J114 as discussed above.

Since we have closed control valve J110 it is necessary to remove the minimum pressure drop require-
ment from this valve so that the results will not be skewed.

ØGo to the Design Requirements panel in the Sizing window and select the Control Valves button. 
Un-check the box for the pressure drop requirement next to J110 to remove it from the closed valve as 
shown in Figure 6.

For this scenario we also want to change the Sizing Method, since the Modified Method of Feasible Dir-
ections was determined to be the most efficient for this model.

ØClick the Sizing Method panel button in the Sizing Navigation panel, then select the Modified 
Method of Feasible Directions (MMFD) from the Search Method list.

The Dependent Design case is now complete, since it has inherited the rest of its sizing settings from the 
primary case. Select Run from the Analysis menu and got to the Output window to view the results once 
the run is complete.

Figure 6: Control Valve Design Requirements adjusted for the Dependent Design Case
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Summary

The following summary Table 1 was compiled using data from this example and the Air Distribution - 
ANS example. It can be observed that when the multiple design cases are included in the sizing, the cost 
increases by approximately 3%. In most cases it is not possible for a model that includes a dependent 
design case to yield a better design than the primary case alone. At best, it can usually only yield the 
same design, such as in this scenario. This is due to the fact that the dependent design case imposes 
additional restrictions on the solution by adding additional design requirements. If the design for the 
primary design case is not sufficient for the dependent design case, then the design must be changed, 
which will increase cost in some manner. In this case the pipe sizes needed to be increased to account 
for the additional load when one discharge valve is closed. The pipe sizes for the Dependent Design 
Case scenario can be seen in Figure 7.

Table 1: Summary of Sizing Runs for Air Distribution system

Scenario Single Design Case Multiple Design Case

Meets all Requirements Yes Yes

Material $57,248 $60,988

Installation $35,216 $37,635

Operation $73,879 $80,595

Total $166,343 $179,218
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Figure 7: Pipe size results for the system with the dependent design case included
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Helium Transfer - ANS 

Summary

This example will show how to use the ANS module to size a system based on pipe weight to deliver a 
minimum flow of helium for variable inlet temperature.

Note: This example can only be run if you have a license for the ANS module. 

Topics Covered

 l Sizing using pipe weight
 l Creating Common Size Groups
 l Using dependent design cases to satisfy two different operating modes for a system

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition, it is assumed that the user has worked through the Beginner - Three Tank Steam System - 
ANS example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Helium Transfer - ANS Initial.aro
 l Metric - Helium Transfer - ANS Final.aro

Problem Statement

In this system, Helium flows from one tank to two other delivery tanks. Throughout the year its inlet tem-
perature varies from 0 to 38 deg. C. There is a minimum flow rate required to each tank of 1.1 kg/sec 
which must be provided for all supply tank temperature conditions.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Helium Transfer - ANS Initial.aro example file listed above, which is located in the 
Examples folder in the AFT Arrow application folder. Save the file to a different folder. The Workspace 
should look like Figure 1 below. 

Workspace Layers are used in this model file to show junction names, highlight the pipes being sized, dis-
play supply tank temperatures, and display the mass flow rate through the discharge piping for con-
venient comparison with the system design requirements.

Since the supply temperature can vary throughout the year, we will analyze two different design cases, 
one for the maximum temperature (Hot Case), and one for the minimum temperature (Cold Case). We 
are using the Hot Case as our primary design, so the model inputs currently reflect the Hot Case. We will 
need to first define the sizing settings for the primary case, then set up the secondary case using the cold 
temperatures.
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Figure 1: Model layout for normal system operation

 Step 2. Define the Modules Group

Navigate to the Modules panel in Analysis Setup. Check the box next to Activate ANS. The Network 
option should automatically be selected, making ANS enabled for use.

 Step 3. Define the Automatic Sizing Group

To define the Automatic Sizing group, go to the Sizing window by clicking on the Sizing tab.

A. Sizing Objective
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Go to the Sizing window by selecting the Sizing tab. The Sizing Objective window should be selected by 
default from the Sizing Navigation panel along the bottom. For this analysis, we are interested in sizing 
the system considering the monetary cost for the initial costs only.

 1. Select Perform Sizing for this calculation.
 2. For the Objective, choose Pipe Weight, and select the Minimize option from the drop-down list if it 

is not already selected.

The Sizing Objective window should now appear as shown in Figure 2.

Figure 2: Sizing Objective panel setup to minimize pipe weight

B. Sizing Assignments

On the Sizing Navigation panel select the Sizing Assignments button.

For this system we will be sizing all of the pipes since it is a new system.

ØMove each of the pipes to Always Include in Weight.

The piping to each of the discharge tanks in the system will be identical, so a Common Size Group will 
need to be created to link the sizes in the two pipes.

Above the Pipe Grouping table select New, then give the group the name Discharge Pipes. Select the 
radio buttons to place pipes P2 and P3 in the Common Size Group. These are the pipes highlighted in 
blue on the Workspace.
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The completed pipe Sizing Assignments can be seen in Figure 3.

Figure 3: Sizing Assignments fully defined for the model

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.

For this system it is desired to use STD Steel - ANSI. To create a Candidate Set, do the following:

 1. Under Define Candidate Sets, click New.
 2. Give the set the name STD Pipes and click OK.
 3. From the drop down list choose Steel - ANSI.
 4. In the Available Material Sizes and Types on the left, expand the STD pipe sizes list.
 5. Double-click each of the sizes from 1 to 10 inches to add them to the list on the right.
 6. In the Select Pipe Sizes window, click OK.

We now need to define which pipes will use this Candidate Set during the sizing calculation. Select the 
radio buttons next to pipe P1 and the Common Size Group to assign the Candidate Set to each of the 
pipes, as shown in Figure 4.
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Figure 4: Candidate Sets panel fully defined for the model

D. Design Requirements

Select the Design Requirements button from the Navigation Panel.

For this system there is only one Design Requirement, which is the requirement to maintain a minimum 
flow of 1.1 kg/sec into each of the discharge tanks. To define this requirement:

 1. Click New under Define Pipe Design Requirements.
 2. Enter the name Minimum Flow.
 3. Select Mass Flow Rate as the Parameter.
 4. Choose Minimum for Max/Min, and enter 1.1 kg/sec.

Now we need to apply the defined Design Requirement to the discharge pipes.
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ØCheck the box next to Discharge Pipes in the Assign Design Requirements to Pipes section. The 
Design Requirements panel should now appear as shown in Figure 5.

Figure 5: Design Requirements panel for pipes

E. Assign Cost Libraries

When the Sizing Objective has been defined as monetary cost, it is necessary to create and assign cost 
libraries for the automated sizing, which can be done in the Assign Cost Libraries panel. Since we have 
defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is dis-
abled.

F. Sizing Method

Select the Sizing Method button to go to the Sizing Method panel.

Ø Choose Discrete Sizing, if not already selected since it is desired to select discrete sizes for each of 
the pipes in the model.

This model is relatively simple, so the default, Modified Method of Feasible Directions (MMFD), should 
be sufficient. Ensure that this method is selected from the list of Search Methods.

G. Dependent Design Cases
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We have now set up the system to be sized for the primary design case, but we will also need to account 
for the cold case where the system is operating at the minimum inlet temperature. To do this we will cre-
ate a dependent design case by completing the following steps:

 1. Go to the Sizing Objective panel and select the Enable Dependent Design Cases option. A new 
button will now be available for the Dependent Design Cases panel in the Sizing Navigation panel.

 2. Navigate to the Dependent Design Case panel. You should now see instructions displayed to cre-
ate Dependent Design Cases, along with a summary table of dependent design settings. We will 
now need to use the Duplicate Special feature to create the dependent design cases.

 3. Go to the Workspace and choose Select All from the Edit menu.
 4. Open Duplicate Special (from the Edit menu), enter an increment of 10, select Make Dependent 

Design Case, and select Copy Layer Style Settings From Original Object (Figure 6). Click OK. 
 5. Move the duplicated pipes and junctions to distinguish them from the original ones from the 

Primary Design Case. The Workspace should now appear as shown in Figure 7.
 6. In the Cold Case inlet tank J11, open the Tank Properties window and change the temperature to 

0 deg. C.

Return to the Dependent Design Cases panel.

When Duplicate Special was performed with Dependent Design Case selected, each of the duplicated 
pipes was created with a special type of grouping. For example, pipe P11 is grouped with pipe P1 as a 
DDC pipe (see Figure 8). This type of assignment allows the dependent design pipes to be sized, but to 
not be counted in the cost so that the cost will not be duplicated.

It should also be noted that the dependent design grouping causes each of the dependent pipes to inherit 
their Common Size Groups, Candidate Sets, and Cost Library settings (if applicable) from the pipes in 
the primary case. The dependent design case pipes are therefore hidden on all sizing panels except for 
the Design Requirements and Dependent Design Cases panels.

Figure 6: Duplicate Special settings to create a dependent design case
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Figure 7: Workspace with dependent design case after duplication

Figure 8: Pipes in Dependent Design Cases have a special grouping relationship with pipes in the primary 
case
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 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 5. Examine the Output

After the run finishes, examine the final pipe sizes calculated by the ANS module. The results for pipe 
size and overall cost are shown in Figure 9. It can be seen that the 5 inch and 3 inch pipe sizes were 
chosen for the header and discharge pipes, respectively. The overall weight of the system is 10,062 kg.

Figure 9: Final pipe sizes and Cost Report for the Helium Transfer system considering the hot and cold cases

Conclusion

By creating a dependent design case both the hot and cold temperature operating cases were able to be 
taken into account in the automated sizing for this simple system. In more complex systems additional 
dependent cases could be created to consider various system configurations as well as further operating 
conditions.
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Natural Gas Burner - ANS 

Summary

This example will size the pipes for a natural gas supply system to five burners. It is desired to analyze 
two separate design cases using monetary cost automated sizing. 

Note: This example can only be run if you have a license for the ANS module. 

Topics Covered

 l Sizing using monetary cost
 l Using dependent design cases to satisfy two different operating modes for a system
 l Understanding the effect of monetary vs. non-monetary sizing objectives

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition, it is assumed that the user has worked through the Beginner - Three Tank Steam System - 
ANS example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Natural Gas Burner.aro
 l Metric - Natural Gas Burner - ANS.aro
 l Steel - ANSI Pipe Costs.cst - cost library for Steel - ANSI pipes

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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Open the Metric - Natural Gas Burner.aro example file listed above, which is located in the Examples 
folder in the AFT Arrow application folder. Save the file to a different folder. This is the only scenario 
needed for this example, so right-click the Base Scenario and select Delete All Children. The Workspace 
should look like Figure 1 below.

Figure 1: Natural Gas Burner model layout in Workspace

 Step 2. Define the Modules Group

Navigate to the Modules panel in Analysis Setup. Check the box next to Activate ANS. The Network 
option should automatically be selected, making ANS enabled for use.

 Step 3. Define the Automatic Sizing Group

For this system we will be sizing the natural gas system for two different operating cases, one with all 
burners running and one with the third burner closed. When modeling multiple design cases, the different 
cases need to be broken up into a primary design case, of which there is one, and dependent design 
cases, of which there can be any number.

The primary design case can be any of the design cases that are being addressed in your model. Typ-
ically, it will represent the primary operating condition of the pipe system. If it is not clear which case 
should be the primary case, just pick any of the cases and call that the primary one. Design cases other 
than the primary case are referred to as dependent design cases. This naming convention is used since 
the dependent design cases are built and defined by duplicating the primary design case, as will be dis-
cussed later. The case with all burners on will be used as the primary design case. 
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To start we will set up the sizing settings for the primary design case, after which we will set up the 
dependent design case.

A. Sizing Objective

The Sizing Objective panel should be selected by default. For this analysis, we are interested in sizing 
considering the monetary cost for the initial costs only.

 1. Set the Sizing Option to Perform Sizing.
 2. For the Objective, choose Monetary Cost, and select the Minimize option from the drop-down list.
 3. Under Options to Minimize Monetary Cost, choose Size for Initial Cost. This will update the cost 

table to include both initial costs in the sizing calculation while ignoring the recurring costs.

The Sizing Objective window should now appear as shown in Figure 2.
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Figure 2: Sizing Objective window setup for an Initial Cost analysis

B. Size/Cost Assignments

On the toolbar at the bottom of the window select the Size/Cost Assignments button.

For the supply lines P1 and P2, the pipe size is fixed to 6 inches and will not be sized. However, we will 
still need to purchase these pipes, so we will consider their cost. The rest of the pipes in the system will 
need to be sized for the design.



Natural Gas Burner - ANS

- 244 -

The 4 header pipes (P3, P4, P5, P6) represent a single header in the physical system, so it will be neces-
sary to add them to a Common Size Group. A second Common Size Group should be created to contain 
all of the discharge piping (P7 - P16), as each of the branches to the burners should be identical. To set 
up the Size/Cost Assignments as described, do the following:

 1. Move pipes P1 & P2 to Do Not Size – Include in Cost in the table. This will calculate their cost 
while keeping their size fixed.

 2. Select pipes P3 - P16 in the table by holding SHIFT to select multiple rows, then click the Always 
Include in Cost button to move them to the appropriate column to be sized.

 3. Now that the pipes have been set to be sized, the Common Size Groups need to be created. 
Select New above the Pipe Grouping table to create two new groups and give them the names 
Headers and Distribution. 

 4. Add pipes P3 - P6 to the Headers group using the radio buttons. Alternatively, they can be added 
by selecting the pipes in the Workspace then right-clicking and choosing the appropriate option to 
add them to the group.

 5. Add pipes P7 - P16 to the Distribution group either by using the radio buttons in the table, or from 
the Workspace. 

The Size/Cost Assignments table should now appear as shown in Figure 3.

Figure 3: Size/Cost Assignments window with Common Size Groups defined as outlined above

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets window. In this case we will be con-
sidering schedule 40 steel pipe within the range of 1" - 12".
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 1. Select New, and name the Candidate set Steel Sch 40.
 2. Choose Steel - ANSI from the material list.
 3. Expand the STD type, then double click each of the sizes from 1 inch to 12 inch to add them to the 

Candidate Set.
 4. Click OK to accept the defined set.

In the bottom section of the window make sure that the Common Size Groups are assigned to use the 
new Steel Sch 40 Candidate Set. The window should appear as shown in Figure 4.

Figure 4: Candidate Sets window fully defined for the model

D. Design Requirements

Select the Design Requirements button.

In the primary design case the following requirements need to be met:
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 1. The flow to the burners must remain below the maximum velocity requirement of 60 meters/sec.
 2. All control valves must have a minimum pressure drop of 1.7 bar.

Make sure that the Pipes button is selected, then create a new Design Requirement named Max Velocity 
specifying the Velocity Outlet Maximum of the pipe is 60 meters/sec. In the bottom section of the window, 
make sure that the velocity design requirement is applied to each of the discharge lines to the burners 
(P12 - P16). The Pipe Design Requirements should now appear as shown in Figure 5.

Next select the Control Valves button at the top of the window and create a new control valve Design 
Requirement. Name the Design Requirement Min Pressure Drop, and specify the Pressure Drop Static 
as a Minimum of 1.7 bar. In the bottom section apply the Design Requirement to each of the control 
valves in the model (Figure 6).

Figure 5: Pipe Design Requirements defined for the primary design case
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Figure 6: Control Valve Design Requirements defined for the primary design case

E. Assign Cost Libraries

Select the Assign Cost Libraries button. For this model the pipe cost library has already been created, but 
we will need to connect and apply it.

ØOpen the Library Manager by clicking the Library Manager button to see which libraries are con-
nected.

This example uses a pre-built cost library for the pipes containing the Steel material costs. To connect 
the library do the following:

 1. Click the button Add Existing Cost Library.
 2. Browse to the AFT Arrow 10 Examples folder (located by default in C:\AFT Products\AFT Arrow 

10\Examples\), and select the file titled Steel - ANSI Pipe Costs.cst. 

The new library should now be visible in the Available Libraries list, be automatically connected to the 
model, as shown in Figure 7. The cost library for the pipes should appear with the name Steel - ANSI 
Pipe Costs and be indented under the Steel - ANSI library within the standard pipe material libraries list.

Once you have confirmed that the library is connected, click Close to exit the Library Manager.
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Back in the Assign Cost Libraries panel for the Pipes the Steel - ANSI Pipe Costs library should be the 
only available cost library, and should be selected to show that it is being applied to the candidate sets 
and to each of the  supply lines as shown in Figure 8.

Figure 7: Library Manager with pipe material cost library connected
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Figure 8: Assign Cost Libraries panel with the Steel - ANSI Pipe Costs library connected and applied to the 
pipes in the model

F. Sizing Method

Select the Sizing Method button to go to the Sizing Method panel.

Ensure that Discrete Sizing is chosen with the Modified Method of Feasible Directions (MMFD) for the 
Search Method.

G. Dependent Design Cases

We have now set up the system to be sized for the primary design case, but we will also need to account 
for the case where the third burner is shut off. There are a few changes that will need to be made for this 
additional case:

 1. The flow rate at the control valves increases to 3 kg/sec to maintain the overall system flowrate.
 2. Control Valve J110 is closed and the minimum design requirement is removed because it is shut 

off.

To make the dependent design case where the third burner is shut off complete the following:

 1. Go to the Sizing Objective panel and select the Enable Dependent Design Cases option. A new 
button will now be available for the Dependent Design Cases panel in the Sizing Navigation panel.
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 2. Navigate to the Dependent Design Case panel. You should now see instructions displayed to cre-
ate Dependent Design Cases, along with a summary table of dependent design settings. We will 
now need to use the Duplicate Special feature to create the dependent design case.

 3. Go to the Workspace and choose Select All from the Edit menu.
 4. Open Duplicate Special (from the Edit menu), enter an increment of 100, deselect Copy Layer 

Style Settings From Original Objects, and select Make Dependent Design Case (Figure 9). Click 
OK. 

 5. Move the duplicated pipes and junctions to distinguish them from the original ones in the Primary 
Design Case.

 6. Close Control Valve J110 in the DDC by selecting the junction in the Workspace and clicking the 

Special Conditions button  on the Toolbar and selecting Closed.
 7. Use Global Junction Edit (from the Edit menu) to change all of the control valve setpoints in the 

DDC from 2.25 kg/sec to 3 kg/sec (see Figure 10).
 8. In the Sizing window navigate to the Design Requirements panel. On the Control Valves page 

remove the pressure drop requirement from J110, since this valve is closed for the DDC.

Return to the Dependent Design Cases panel.

When Duplicate Special was performed with Dependent Design Case selected, each of the duplicated 
pipes was created with a special type of grouping. For example, pipe 101 is grouped with pipe 1 as a 
DDC pipe (see Figure 11). This type of assignment allows the dependent design pipes to be sized, but to 
not be counted in the cost so that the cost will not be duplicated.

It should also be noted that the dependent design grouping causes each of the dependent pipes to inherit 
their Common Size Groups, Candidate Sets, and Cost Library settings from the pipes in the primary 
case. The dependent design case pipes are therefore hidden on all sizing panels except for the Design 
Requirements and Dependent Design Cases panels. 

Figure 9: Duplicate Special settings to create a dependent design case
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Figure 10: Global Junction Edit is used to change the flows in the homes for the dependent cases
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Figure 11: Pipes in Dependent Design Cases have a special grouping relationship with pipes in the primary 
case

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

 Step 5. Examine the Output

After the run finishes, examine the final pipe sizes calculated by the ANS module. The results for pipe 
size and overall cost are shown in Figure 12 and Figure 13. One can see that the resultant size is 4-inch 
pipe for the header, with larger 5-inch piping for the distribution lines.

The total cost for the pipes is $5,654. This includes the $3,555 cost for the supply line pipes which were 
not sized, as well as the  $2,099 cost for the pipes in the model which were sized, including the header 
and distribution piping. The pipes that were sized will be distinguished in the Cost Report by having a 
green background color.
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Figure 12: Cost Report for the automated sizing

Figure 13: Sizing Report for the automated pipe sizing

 Step 6. Compare Results With Non-Monetary Sizing

This sizing could be performed by using weight as the objective instead of monetary cost to simplify the 
setup. Using a non-monetary objective can produce less accurate sizing results in cases where the 
energy costs or costs of equipment such as compressors need to be accounted for. However, only the 
pipe sizes are being considered for the sizing calculations in this example. Set up the model to perform a 
non-monetary sizing by doing the following:
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 1. In the Scenario Manager create a child of the Base Scenario by right-clicking the scenario name 
and choosing Create Child.

 2. Give the new child scenario the name Pipe Weight Sizing.
 3. Go to the Sizing Objective panel and change the Objective from Monetary Cost to Pipe Weight.

The model should now be configured to run the model. Click Run Model, then go to the Output window 
once the run is finished. The final pipe sizes should now appear as shown in Figure 14.

It can be seen that changing the objective to pipe weight produces identical sizing results as the run 
using a monetary cost objective. For more complex systems this will not always be the case.

Figure 14: Final pipe sizes for the model using a non-monetary cost objective
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Process Steam System - ANS 

Summary

This example sizes a process steam system by minimizing the pipe weight. Common Size Groups allow 
for the system to be simplified while still effectively sizing the system.

Note: This example can only be run if you have a license for the ANS module. 

Topics Covered

 l Defining Common Size Groups
 l Viewing Common Size Groups using color in the Workspace
 l Choosing a Search Method

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

In addition, it is assumed that the user has worked through the Beginner - Three Tank Steam System - 
ANS example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric - Process Steam System.aro
 l Metric - Process Steam System - ANS.aro

 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Open the Metric - Process Steam System.aro example file and save it to a new location. Open the 
newly saved model file, right-click on the Base Scenario and select Delete All Children. The Workspace 
should look like Figure 1 below.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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Figure 1: Model layout for normal system operation

 Step 2. Define the Pipes and Junctions Group

Before running this model with ANS, change all Tee/Wye junctions to use the Simple (no loss) Loss 
Model rather than the Detailed Loss Model. This is significantly reduce the complexity of the model and 
allow the solver to converge much faster. Use Global Junction Edit to make this change.

 Step 3. Define the Modules Group

Navigate to the Modules panel in Analysis Setup. Check the box next to Activate ANS. The Network 
option should automatically be selected, making ANS enabled for use.

 Step 4. Define the Automatic Sizing Group

The model is already defined for a regular AFT Arrow run, but we need to complete the sizing settings 
before running the analysis. Go to the Sizing window by clicking the Sizing tab.
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A. Sizing Objective

Go to the Sizing window by selecting the Sizing tab. The Sizing Objective window should be selected by 
default from the Sizing Navigation panel along the bottom. For this analysis, we are interested in sizing 
the system considering the monetary cost for the initial costs only.

 1. Select Perform Sizing for this calculation.
 2. For the Objective, choose Pipe Weight, and select the Minimize option from the drop-down list.

The Sizing Objective window is now complete.

B. Sizing Assignments

On the Sizing Navigation panel select the Sizing Assignments button.

For this system, we will be sizing all of the pipes since it is a new system.

ØMove all of the pipes to Always include in Weight.

To more efficiently size the system, it would be beneficial to create common size groups. In this system 
there are several sections of piping which would likely be grouped together. Create Common Size 
Groups as described below and indicated by the colors in Figure 2.

Note: These colors can be shown in the model by loading the preset Size Groups View in Layer Pre-
sets.

 1. The boilers in the model are identical, so it would be logical to use equivalent pipe sizes for pipes 
P1 and P2 connected to the boilers. Create a Boilers Common Size Group and add pipes P1 and 
P2 to the group. This is shown in magenta below.

 2. Using a common pipe size for the headers would be desirable in this system to reduce installation 
costs and reduce losses. However, grouping the headers downstream of users 1 and 4 separately 
could allow us to use a smaller size for those pipes and save costs. Create two groups, Mains and 
Headers as shown in orange and green respectively in Figure 2.

 3. In this system the users have varying flow demands, so it is not desirable to use a common pipe 
size for all of the users. However, several of the users do have identical flows, so the pipes con-
nected to those users should be grouped. Create a Low Flow Users group for pipes P105 and 
P206 (shown in turquoise) and a High Flow Users group for pipes P107 and P207 (shown in blue).

The completed pipe Sizing Assignments can be seen in Figure 3.

Workspace-Layers.html#Layer-Presets
Workspace-Layers.html#Layer-Presets
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Figure 2: Process Steam model Workspace with the Common Size Groups indicated by color via Workspace 
Layers

Figure 3: Sizing Assignments fully defined for the model



Process Steam System - ANS

- 259 -

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.

For this system it is desired to use STD Steel - ANSI. To create a Candidate Set, do the following:

 1. Under Define Candidate Sets, click New.
 2. Give the set the name Schedule 40 Pipes and click OK.
 3. From the drop down list choose Steel - ANSI.
 4. In the Available Material Sizes and Types on the left, expand the schedule 40 pipe sizes list.
 5. Double-click each of the sizes from 1 to 12 inches to add them to the list on the right.
 6. In the Select Pipe Sizes window, click OK.

We now need to define which pipes will use this Candidate Set during the sizing calculation. Check the 
boxes next to each of the pipes and Common Size Groups to assign the Candidate Set to each of the 
pipes, as shown in Figure 4.
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Figure 4: Candidate Sets panel fully defined for the model

D. Design Requirements

Select the Design Requirements button from the Navigation Panel.

For this system there is a requirement to maintain a minimum discharge pressure of 10 barG to each of 
the customers. Design Requirements can not be applied on the assigned flow junctions directly, so we 
will define this requirement at the outlet of each of the pipes connected to the Assigned Flow junctions.
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 1. Click the New button under Define Pipe Design Requirements.
 2. Enter the name Min Discharge Press.
 3. Select Pressure Stagnation as the Parameter.
 4. Set the Location as Outlet.
 5. Choose Minimum for Max/Min, and enter 10 barG.

Now we need to apply the defined Design Requirement to the discharge pipes.

ØCheck the box next to each of the discharge pipes in the Assign Design Requirements to Pipes 
section. This can be done quickly by checking the boxes next to the two Common Size Groups and the 
Not in Group header to select all of the  pipes under those classifications. The Design Requirements 
panel should now appear as shown in Figure 5.

Figure 5: Design Requirements panel for pipes

E. Assign Cost Library

When the Sizing Objective has been defined as monetary cost, it is necessary to create and assign cost 
libraries for the automated sizing, which can be done in the Assign Cost Library panel. Since we have 
defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is dis-
abled.
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F. Sizing Method

Select the Sizing Method button to go to the Sizing Method panel.

ØChoose Discrete Sizing, since it is desired to select discrete sizes for each of the pipes in the model.

For the search method, the ANS module suggests using the Modified Method of Feasible Directions, so 
select that option from the Search Methods list. Note that the suggested method will be displayed if the 
Suggest Best Method button is selected under the Search methods list.

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has 
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Note: A message will appear stating that P10 has a different initial size (12 inch) than the other pipes 
in the Mains group, which are 8 inch. Changing the size of P10 to 8 inch before running the 
model would prevent this message, but would have no impact on sized results.

 Step 6. Examine the Output

After the run finishes, examine the final pipe sizes calculated by the ANS module. The results for pipe 
size and overall cost are shown in Figure 6. The resultant pipe sizes range from 3-1/2 to 10 inches 
throughout the system.

With the Modified Method of Feasible Directions the total pipe weight in the system is minimized to 
66,687 kg. 

For this system it is possible to further minimize the weight in the system by using the Genetic Algorithm 
(GA) method. With Genetic Algorithm a further reduction can be obtained, though the run time is much 
longer. Note that it is possible to pause the solver and accept the current sizing solution before the Gen-
etic Algorithm has fully completed by clicking Pause, then selecting Accept Sizing from the Other Actions 
menu and clicking Continue to finish the current iteration. This will provide a valid system design, though 
it may not be the best solution that could possibly be found.

For more complex models this additional run time may be much longer, but could potentially provide a lar-
ger amount of savings. The main product Help file provides more information on setting up the model to 
use the Genetic Algorithm Search Method.
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Figure 6: Cost Report and pipe sizes for the sized process steam model

Extended Time Simulation (XTS) Examples
The examples below utilize the Extended Time Simulation module.

Example Complexity Fluid Pipes Compressors Description

Air Receiver 
Tank Beginner Air 4 1

Learn the basics of the XTS 
module such as defining a tran-
sient junction and specifying 
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Example Complexity Fluid Pipes Compressors Description

the Transient Control group in 
Analysis Setup. See how to 
generate a Quick Graph from 
the Output window to see how 
a tank fills up over time.
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Air Receiver Tank - XTS

Summary

The objective of this example is to introduce the user to the Extended Time Simulation (XTS) module by 
modeling the pressurizing of an air receiver tank. A positive displacement compressor is used to charge 
the tank and is shut off once the required pressure is reached for a compressed air process. 

Note: This example can only be run if you have a license for the XTS module.

Topics Covered

 l Specifying the Transient Control group
 l Understanding Transient Output

Required Knowledge

This example assumes the user has already worked through the Beginner - Air Heating System example, 
or has a level of knowledge consistent with that topic.  You can also watch the AFT Arrow Quick Start 
Video on the AFT website, as it covers the majority of the topics discussed in the Beginner: Air Heating 
System example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow 
installation:

 l Metric – Air Receiver Tank - XTS.aro

Problem Statement

An initially unpressurized tank is being charged with compressed air for use in a compressed air system. 
The compressed air tank needs to be charged to a pressure of 8.5 barG.

An actively cooled positive displacement compressor rated for 170 sm3/h is used in the system with an 
aftercooler which is sized to cool the air to 30 deg. C. The cooler has a pressure drop of 20 kPa at 170 
sm3/h. There is an isolation valve at the air receiver tank inlet to control flow out of the tank during normal 
operations with a Cv of 50 and Xt of 0.7.

Atmospheric air is assumed to be dry, with an ambient temperature of 21 deg. C. Determine the time it 
will take to charge the air receiver tank for this process.

https://www.aft.com/products/arrow/video-tutorial-series
https://www.aft.com/products/arrow/video-tutorial-series
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 Step 1. Start AFT Arrow

From the Start Menu choose the AFT Arrow 10 folder and select AFT Arrow 10.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate XTS and select Transient to enable the XTS module for use. 
Note that XTS can also be enabled from the Analysis menu by going to the Time Simulation option and 
selecting Transient, as shown in Figure 1. When XTS is activated a new group will appear in Analysis 
Setup titled Transient Control.

Figure 1: Activating the XTS module and setting it to be enabled in the Modules panel

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Air

 i. After selecting, click Add to Model
 c. Equation of State = Redlich-Kwong
 d. Enthalpy Model = Generalized
 e. Specific Heat Ratio Source = Library
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 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 2: Workspace for XTS Air Receiver Tank example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties.

Pipe Properties

 1. Pipe P1
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 3 inch
 d. Type = STD (schedule 40)
 e. Friction Model = Standard
 f. Length = 6 meters

 2. Pipes P2 - P4
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 3 inch
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 d. Type = STD (schedule 40)
 e. Friction Model = Standard
 f. Length = 3 meters

Junction Properties

 1. J1 Assigned Pressure
 a. Elevation = 0 meters
 b. Fluid = Air
 c. Stagnation Pressure = 0 barG
 d. Stagnation Temperature = 21 deg. C

 2. J2 Compressor
 a. Elevation = 0 meters
 b. Compressor Model = Positive Displacement Compressor
 c. Compression Process Thermodynamics = Polytropic
 d. Polytropic Constant = 1.2
 e. Compressor Sizing Parameter = Mass Flow Rate
 f. Fixed Flow Rate = 170 sm3/h

Note: The polytropic constant entered for the compressor is intended to represent an active cooling 
element in the compressor.

 3. J3 Heat Exchanger
 a. Elevation = 0 meters
 b. On the Loss Model Data tab

 i. Select the Loss Model as Resistance Curve, and then click the Enter Curve Data but-
ton

 ii. Select the Flow Parameter as Mass with units of sm3/h
 iii. Enter 170 sm3/h and 20 kPa in the Raw Data table
 iv. Click Fill as Quadratic to create data for a square loss curve
 v. Click Generate Curve Fit Now to create a quadratic curve fit

 c. On the Thermal Data tab:
 i. Thermal Model = Controlled Downstream Temperature
 ii. Controlled Outlet Temperature = 30 deg. C

 4. J4 Valve
 a. Elevation = 0 meters
 b. Loss Model = User Specified
 c. Loss Model = Cv
 d. Loss Parameters

 i. Cv = 50
 ii. Xt = 0.7

 5. J5 Tank
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 a. Elevation = 0 meters
 b. Tank Model = Finite
 c. Initial Conditions

 i. Pressure = 0 barG
 ii. Temperature = 21 deg. C

 d. Finite Tank Conditions
 i. Fixed Volume = 1900 liters
 ii. Thermodynamic Process = Isothermal

Figure 3: Tank Properties window defined with Finite Tank option

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 5. Define the Transient Control Group

XTS module transient simulations are controlled through the Simulation Duration panel. You can access 
the Simulation Duration panel by selecting Transient Control from the Analysis Menu, navigating to the 
Simulation Duration item in Analysis Setup, or by clicking the Simulation Duration shortcut on the 
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Common Toolbar. When the time simulation mode is set to Steady-Only AFT Arrow will ignore the input 
in the Simulation Duration panel. When AFT Arrow is set to perform a transient analysis, the Transient 
Control group becomes a required item before the model can run. Use the Simulation Duration panel to 
specify transient start and stop times, set time steps, specify the number of output points that are saved 
to the transient output file (allows XTS to do transient calculations with a small time step while limiting the 
size of the transient data output file), and adjust solution parameters for finite tank liquid level cal-
culations. Specify start times, stop times, and time steps in any units from seconds to years.

Set the Start Time to 0 seconds and the Stop Time as 375 seconds, with a time step of 1 second. The out-
put will be saved to the output file for every time step. The Simulation Duration panel should appear as 
shown in Figure 4.

Figure 4: The Simulation Duration panel is used to control transient simulations

 Step 6. Set Up the Compressor Transient

In the XTS module, you can define transients for junctions. These transients include events such as 
valves opening and closing and compressors starting and shutting down. Transients for junctions are 
defined as either time-based or event-based transients. A time-based transient starts at a specified abso-
lute time. Event based transients initiate when a defined criteria, such as a specified pressure in a par-
ticular pipe is reached. There are three types of event transients for junctions: single event, dual event 
cyclic, and dual event sequential. Single event transients are events that occur only once in a simulation. 
Dual cyclic events are two transient events that repeat one after the other as many times as the event trig-
ger occur during a simulation (such as a valve closing then reopening). Dual sequential transient events 
are two transient events which occur one after the other, without repeating.

For this example, set a single event-based transient on the compressor so the compressor will shut off 
over 30 seconds when the pressure at the tank inlet reaches 8.5 barG.

Open the Compressor Properties window for compressor J2 and navigate to the Transient tab. Under Ini-
tiation of Transient, select Single Event and enter the Transient data as shown below in Figure 5.
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Figure 5: Compressor junction transient tab with flow transient defined

 

 Step 7. Run the Model

After defining all of the pipes and junctions transient data and transient control items, the transient model 
can run. Click Run Model from the Common Toolbar or Analysis menu.

When using the XTS module, the Solution Progress window displays the progress through the transient 
analysis. This information is displayed below the solution tolerance data, as shown in Figure 6.

After the run finishes, view the results by clicking the Output button.
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Figure 6: Solution Progress Window shows the convergence progress, as well as the transient solution pro-
gress when running transient cases

 Step 8. Examine the Transient Results

AFT Arrow displays transient output for all Pipes and Junctions in the Output Window, as shown in Figure 
7.
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Figure 7: Transient output is displayed in the Output Window

Each of the summary tables in the General Output section has a companion transient summary tab 
which displays the summary data at each time step in the transient run. Each junction included in the 
summary is included in the transient summary. The transient summary data for each junction may be 
expanded or collapsed by clicking the + or – sign in beside the junction data list. The entire list may be 
expanded or collapsed by clicking the button in the top left-hand corner of the transient summary window. 
Figure 8 shows the Tank Transient summary tab, with all of the data sets collapsed. Figure 9 shows the 
Tank Transient summary tab, with the data for the J5 Tank expanded.

Figure 8: Transient Summaries are displayed in the General Output section
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Figure 9: Transient Summary data can be expanded to show the junction data for every Time Step

The Event Messages tabs in the General Section (Figure 10) can be used to see when events are 
triggered during the transient. For this example the Event Messages By Jct tab shows that the flow tran-
sient at the compressor was triggered at 333 seconds into the transient, meaning it took 333 seconds to 
pressurize the tank to the required pressure.

Figure 10: Event Messages tab in the General section of the Output window

The Quick Graph feature can be used to plot transient data for rapid examination. To use the Quick 
Graph feature, place the mouse cursor over the column of data you wish to examine. Then, right click 
with the mouse, and select Quick Graph from the list. Figure 11 illustrates how to generate a Quick Graph 
for J5 Tank Pressure vs. Time. The graph illustrates how the pressure in the tank rises over time and 
steadies out at about 9.9 bar once the compressor fully shuts off (Figure 12). The Graph Results window 
may also be used to create a full range of graphs related to the XTS module transient output.
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Figure 11: Use Quick Graph to easily plot J5 Tank pressure

Figure 12: Quick Graph Plot of J5 Tank pressure

Similar to the summary transient data, the transient tabs in the Pipe and Junctions sections of the Output 
Window (shown in Figure 7) are used to display the transient data for each pipe and junction at every 
time step. This transient data can be expanded or collapsed in the same manner as in the General Out-
put transient summaries.

Figure 13 shows the output data for the pipes and junctions, found on the Pipes and All Junctions tabs, at 
the initial time step, Time = 0 seconds. The output for all of the pipes and junctions can be displayed at 
any time step by using the slider bar located at the bottom of the Output window. Figure 14 shows the 
pipe and junction data at Time = 60 seconds.
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Figure 13: Pipe and Junction transient data at Time = 0 minutes

Figure 14: Pipe and Junction transient data at Time = 60 seconds
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